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Regulatory Information (U.S.A.)

The Federal Communications Commission (FCC)
established rules to allow the direct connection of the
PathFinder to a telephone network. Certain actions
must be undertaken or understood before the
connection of customer provided equipment is
completed.

Incidence of Harm
If the telephone company determines that the
customer provided equipment is faulty and possibly
causing harm or interruption to the telephone
network, it should be disconnected until repairs can
be made. If this is not done, the telephone company
may temporarily disconnect service.

Changes in Service
The local telephone company may make changes in
its communications facilities or procedures. If these
changes affect the use of the PathFinder or
compatibility with the network, the telephone
company must give written notice to the user to allow
uninterrupted service.

Maintenance Limitations
Maintenance on the PathFinder System must be
performed only by the manufacturer or its authorized
agent. The user may not make any changes and/or
repairs except as specifically noted in this manual. If
unauthorized alterations or repairs are made, any
remaining warranty and the software license for the
system will be voided.

Notice of Compliance
The PathFinder System complies with rules regarding
radiation and radio frequency emissions by Class A
computing devices. In accordance with FCC Standard
15 (Subpart J), the following information is supplied
to the end user:

“This equipment generates and uses RF
energy and if not installed and used in
accordance with the Instruction Manual, may
cause interference to Radio Communications.

It has been tested and found to comply with the limits
for a Class A computing device, pursuant to Subpart J
of Part 15 of the FCC Rules, which are designed to
provide reasonable protection against such
interference, when operated in a commercial
environment. Operation of this equipment in a
residential area is likely to cause interference, in
which case the user, at his own expense, will be
required to take whatever measures may be required
to correct the interference.”

Toll Fraud and DISA Disclaimer

“While this device is designed to be reasonably secure
against intrusions from fraudulent callers, it is by no
means invulnerable to fraud. Therefore, no express or
implied warranty is made against such fraud including
interconnection to the long distance network.”
“While this device is designed to be reasonably secure
against invasion of privacy, it is by no means
invulnerable to such invasions. Therefore, no express
or implied warranty is made against unlawful or
unauthorized utilization which results in the invasion
of one’s right of privacy.”
Vodavi has made every reasonable effort to ensure
that this product works in most business
environments. However, there may be some
environments (RFI and EFI) in which this product
may not work properly. In such cases, it is the
responsibility of the installer to take the necessary
actions to correct the situation.
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1 Introduction

This manual is an instructional tool for System Administrators and others who work 
with PathFinder. It describes how to install, set up, design, monitor, and maintain 
various PathFinder applications.

How This Manual is Organized

Chapters 1-6 explain how to configure the PathFinder Voice Processing System to 
properly interface with your telephone system. They will also assist the System 
Administrator with operating and maintaining an efficient working system.

The Appendices contain more specialized information that addresses specific situations. 
They also provide useful material that may be referenced on an as-needed basis.

Chapters

Introduction to PathFinder … Chapter 1

Setting Up Your Phone System … Chapter 2

Using the MAINT Application … Chapter 3

Running Reports … Chapter 4

Operating Utility Programs … Chapter 5

Trouble-Shooting Questions & Answers … Chapter 6

Appendices

Scripts - Modifying Systems Commands… Appendix A

Call Analysis Program - PBXpert … Appendix B

Building a PathFinder … Appendix C

PathFinder Part Numbers … Appendix D

Installation Forms (leading questions) … Appendix D

Frequently Asked Questions … Appendix E
PathFinder - System Administration December, 2003 - Issue 4.5





Overview 1-3

Chapter 1 - Introduction
Overview

Product Description

PathFinder is an Internet-ready voice processing solution for voice mail and auto 
attendant applications. Running on Microsoft Windows 2000 operating system and 
using Dialogic voice boards, this platform offers exceptional capabilities, growth, and 
reliability. The PathFinder is enhanced with the integration capabilities that allows Client 
and Server-based applications.

Voice Processing

PathFinder is a voice processing system that combines sophisticated application software 
with the power of the PC to handle a wide variety of telecommunications tasks.

PathFinder helps people communicate more effectively. It provides a bridge between a 
telephone and a computer. PathFinder uses pre-recorded, digitized human speech, called 
voice prompts, to talk to a caller. Unlike a tape recorder, which stores recordings 
sequentially, PathFinder stores recordings on a computer hard drive. This storage system 
allows PathFinder to access any voice prompt or recording in any order. PathFinder can 
communicate information by stringing together multiple voice prompts to form 
sentences.

Auto Attendant

PathFinder is a modular system that allows it to be customized to suit the user’s needs. 
The Auto-Attendant module comes standard and controls how calls are transferred from 
the PathFinder to other stations on the telephone system

Menu Routing

Menus are a list of predefined choices, generally designed to route callers to the 
appropriate location. A menu prompt is played for a caller indicating the options and 
what actions to take to complete the task, such as: for Sales, press 1 … for Support 
press 2 …

Mailbox / Extensions

PathFinder sees each user or Subscriber as having two parts; a mailbox and an 
extension. The mailbox section plays greetings and takes messages or forwards to 
another module. Whereas the extension section handles the type of transfer and what 
actions to take when interacting with the telephone system.
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Optional Modules

The PathFinder system has been designed to interface with a variety of Optional Modules 
to meet different customer demands.

ChalkTalk - This application automates several common School Administrator functions 
such as: Absentee Calling, Substitute Teacher Locations or Question & Answer mailbox 
options for automated surveys.

Client Programs - These Client applications run on the Client PC and are accessible from 
their desktop. Any PC connected to PathFinder via TCP/IP can use these functions.

� Desktop Call Control allows the Subscriber to interface with calls, customize their 
mailboxes and send and receive voice mail messages using a visual interface.

� Desktop Mail Editor allows the Subscriber to modify a variety of mailbox features 
from their desktop: name/password, signatures/greetings, notification settings, 
and locator numbers.

Fax Support - codes have the ability to use dedicated fax resources, or for more 
efficiency, you can “pool” this resource using fax resource sharing.

Language Prompt Files - PathFinder is multi-lingual, which allows modules such as 
“ChalkTalk” to delivery or prompt in either Spanish or English … or both.

Networking PathFinder Systems - Using Voice Protocol Internet Mail (VPIM) standards, 
this application allows PathFinder to interface with an existing e-mail program to transfer 
voice and fax messages from one PathFinder system to another.

TTS E-mail Reading - Working in conjunction with Unified Messaging, the PathFinder can 
download standard e-mail messages and read them to the Subscriber. The file will be 
encryted once the download is complete.

Unified Messaging - PathFinder can be configured to deliver fax mail, voice mail, and 
messages to one location such as Outlook. Vodavi’s OneLook Unified Messaging 
integrates standard “POP3” and “IMAP4” servers. Voicemail Messaging can be enabled 
or you can use a compressed file type known as VVM.

PathFinder Features

Auto Attendant Menu Routing - unlimited menus

Audiotext Message Cascading

Broadcast Messages to all mailboxes Message Forwarding

Call Screening Message Options (urgent, future, confirmation

Caller ID Support Message Wait Light

Class of Service Multiple Greetings per mailbox

Company Directory Notification (Pager - unlimited digits)

Confirmation on message delivery Password Protection

Date/Time stamp on each message Personal Operator

Deleted message recovery Port Upgrades

Dial by Name Program Interface - Microsoft Windows

Disk Storage Reply to Messages (with and without preamble)

Distribution Lists Reports

First Time Help (user tutorial) Storage (70 + hours)

Log Files Timed Based Answering (chainable time controls up to 10)

Mailboxes - unlimited
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Before You Begin

System Options

FIRST STEP … You must determine which type of PathFinder Voice Processing system will 
best suit the needs of your company. Vodavi offers a pre-built system or a kit that will 
allow you to build your own system.

1 - A Turn Key is a pre-built system that includes all the hardware/software needed, 
and can be configured as a stand-alone unit or for a Local Area Network (LAN). 
Refer to Chapter 1, Getting Started.

2 - A Custom-built system requires that you: build a computer using PathFinder 
specifications, configure the voice cards, and install the related software programs. 
Refer to Appendix C, Building a PathFinder.

FYI … The PathFinder System Administrator manual mainly addresses the “Turn Key” 
system unless “Appendix C” is referenced.

System Components

PathFinder is made up of five components:

1)  Personal Computer (PC)

2)  Operating System -- Microsoft Windows 2000 Professional

3)  PathFinder Software -- The platform from which application modules operate

(e.g., Auto-Attendant, Voice Messaging, etc.)

4)  Hardware -- PBX integration hardware and Dialogic Voice Processing boards

5)  Optional Software Modules -- Purchased separately

(e.g., Desktop Call Control, Unified Messaging etc.)

PathFinder Configuration

In order to prepare, set up, and use PathFinder, the following three steps are required:

1. To start up and run PathFinder. Refer to Chapter 1, ViewPort Application for more 
information on running PathFinder.

2. To integrate your phone system to interface with PathFinder. Refer to Chapter 2, 
Phone System Integration and Setup.

3. To configure PathFinder. Refer to Chapter 3, MAINT Application for instructions on 
how to carry out the initial configuration of PathFinder. You must work through this 
entire configuration procedure before moving on.

Even though you may want to jump right in and begin using PathFinder immediately, it is 
strongly recommended that you carefully review this manual before proceeding. This 
will help orient you with the many features and options available as you work through 
the setup and operation of PathFinder.
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Getting Started

» Make sure that your hardware is in proper working order. This may require that you 
open the computer that will run the PathFinder program to ensure that all boards and 
drivers are locked securely in place. For more information, refer to “PC 
Requirements” on page C-3.

» Plug in the PathFinder computer to an adequate power source. When you turn on the 
PC, the PathFinder will automatically boot-up and start running.

» The boot-up action will open the following application windows: ViewPort and 
PathFinder. (If Not ... Refer to “Troubleshooting” on page 6-10)

ViewPort Application

The ViewPort PathFinder application is a graphical interface that allows the System 
Administrator to view the status and settings of the PathFinder program. It also allows 
you to operate PathFinder locally as well as remote via TCP/IP connections (when set up 
on the same machine).

» After installing PathFinder, the ViewPort window will open and start the voice 
processing program automatically. By default, ViewPort will connect to whatever 
local voice processing parameters that have been set up.

» To start manually … click Start > Programs > PathFinder Voice Processing > 
PathFinder. Once selected, a window similar to the following will display:

Server Options

To properly Start or Stop PathFinder, select Server / Start Server or Stop Server as 
shown in the following window:
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� Add or Remove Server

� Edit Server (You must disconnect before editing server information.)

� Connect / Disconnect

� Start Server

� Stop Server

» Immediately

» Stop Each Line When Idle

» When All Lines Are Idle

» Cancel Shutdown

» Don’t Wait for Terminations

ViewPort Window

The ViewPort window has three sections: Blockage Groups, Counters, and Line View.

BLOCKAGE (Groups) -- Displays the number and total time a blockage occurred 
on the system. Refer to “Setting Up Phone Lines” on page 3-85 for more 
information.

This window displays duration and counts for system blocks to monitor the voice mail 
traffic. Each line can be placed in a “Blockage” group so that when all of those line are 
busy, no new calls will be received. The information may be used to verify that 
voicemail has enough ports to support your company’s call traffic.

» When the Blockage view is selected, a “View” menu will become available so that 
Blockage Counts may be reset when needed.

COUNTERS (Event) -- The Event Counters window allows you to view PathFinder 
event counters. Refer to “Event Counters” on page 3-56 for more information.

» When the Counters view is selected, a “View” menu will become available so that 
Counters may be reset as needed.
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LINE VIEW (Status) -- This window allows you to view the “real-time” status of 
your voicemail ports. Each line is represented by a “telephone icon” that will 
change colors as their current call status changes. This “color-coding” allows call 
identification to be viewed at a glance.

» When the Line view is selected, a “View” menu will become available so that Line 
counts may be reset as needed. 

Line refers to the voicemail port.

Status refers to how or if the line (port) is answered.

Call data displays the number of calls and the duration times for the 
types of calls specified. You can view today’s totals as well 
as totals for the entire application.

Pale Blue = Idle
Bright Blue = Busy

Green = Ringing
Red = Shutdown (mode)
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PathFinder Application

The PathFinder screen is a window that displays the real-time data of the PathFinder 
system as it works with your phone system. All PathFinder activity can be viewed 
through this interface. The type of information that displays is directly related to the 
“Logging” output selected. By default, this screen shows the basic call processing 
information, however, you can customize this data using the MAINT application. (Refer 
to “Logging” on page 3-20.)

» This application must remain up and running for PathFinder to answer incoming 
telephone calls.

PathFinder Optional Programs

This section briefly describes ALL software applications that are currently available, to 
include any programs that were added to your PC during the Installation Routine. 

You will only have access to certain programs:

» Depending on the optional modules purchased.

- and-

» If the program(s) have been activated on the software key you installed.

Startup Groups

The Startup Group will show the programs needed by PathFinder to integrate with your 
phone system.

The PathFinder Voice Processing Group will display the same programs as the Startup 
group, PLUS … additional utility applications and any optional modules that have been 
purchased.

Refer to "Program Descriptions" to see how each application can be used.
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Program Descriptions

ActiveVex Help This application allows you to create “interactive voice 
response” programs to be used by the Voice Server.

Boom Box A utility used to record, edit, and play back PathFinder 
voice prompts.

Call List Admin For administrative use relating to the ChalkTalk Optional 
Module.

CodeKey Manager Shows what options are enabled on the software key. 
Allows you to upgrade PathFinder with an unlock code.

Data Server This application provides secured cross-platform access 
to program and data files owned by the PathFinder.

DCC Switchboard Help This program is used to access the following options:

� DCC Switchboard shows all registered DCC Clients 
that are currently connected.

� DCC Switchboard Configuration is used to define 
system parameters.

� DCC Console displays logged system data in real-
time.

DCC Switchboard This application controls the integration of DCC Clients to 
the PathFinder Server.

Maint The module used to configure the voice processing 
engine.
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What applications should be running?

When you start PathFinder … OR … one of the optional modules you may have 
purchased, certain server applications will automatically appear in your computer task 
bar.

The following chart indicates which application(s) need to be running for the 
programs listed to operate properly:

PathFinder The window that displays what function the PathFinder is 
performing.

When PathFinder is selected from the Voice Processing 
Group, the Windows “Viewport” screen opens showing 
the status of the CO lines, calls received, and call 
durations.

Q&A Admin This portion of the ChalkTalk Optional Module allows you 
to set the parameters that will query callers for multiple 
responses and to retrieve those answers from one 
mailbox location.

Release Notes This “text file” shows the changes and system 
enhancements for the current software release.

Server Applications
PathFinder DCC/DME

& VVM
Networking 

Systems - VPIM
Text-to-
Speech

Unified 
Messaging

DataServer � �

DCC Switchboard �

E-Mail Sync Server �

Networking - VPIM �

PathFinder and ViewPort � � � � �

Unified Messaging Server � �
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2 Phone System Integration
and Setup

This chapter describes the STARPLUS® and infinite® Telephone Systems and the 
Simplified Message Desk Interface (SMDI) integration process.
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Configuration Preparation

To begin with, you must answer some first-time questions and set up basic voice 
functions in order to prepare PathFinder for configuration.

Defining Parameters

1. From the Start menu, select Programs > PathFinder Voice Processing > Maint.

The Loading Key window displays to tell you that your software key is being loaded.

2. When the MAINT application 
opens and the First Time 
Questions window displays:

a. Click on the “Don’t run 
wizard at startup” to 
prevent this window from 
displaying each time you 
access MAINT.

b. Click Next to continue.

3. In the next First Time 
Questions window, enter the 
required parameters in the 
Mailbox Length, Extension 
Length, and Password Length 
fields.

Important … The number of 
digits for mailboxes and 
extensions must match.

4. After completing this 
information, click Accept.

If the “Software Key Not Found” error message displays, make sure that your 
software key is installed properly. Refer to Appendix C , " Software Security 
Key" for more information.

X

Settings must match …
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5. When the PBX Integration 
window displays, select 
(highlight) the Vodavi phone 
system you want to integrate 
and click Select New.

6. Click Yes to accept the PBX 
shown in the Change PBX 
Integration window to confirm 
the system selected.

7. When the next PBX 
Integration window displays, 
click Install to load the new 
parameters.

8. Click OK when the PBX 
Installed window displays to 
confirm that the phone 
system selected has been 
installed.

9. When the MAINT window 
returns, click File > Exit to 
close the application.

You are now ready to set up the voice functions for the system you selected.

107 - VODAVI STARPLUS TRIAD 1
108 - VODAVI STARPLUS TRIAD 2
109 - VODAVI STARPLUS TRIAD 3
111 - VODAVI STARPLUS TRIAD-S
125 - VODAVI INFINITE DVX PLUS II
126 - VODAVI INFINITE DVX PLUS III
127 - VODAVI INFINITE DVX PLUS IV
128 - VODAVI INFINITE DVX PLUS Mach I

000 - DEFAULT PBX (3 DIGIT BLIND XFER)

135 - VODAVI INFINITE DVX PLUS II (4 DIGIT EXT)

135 - VODAVI INFINITE DVX PLUS II (4 DIGIT EXT)
has  been  installed.
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Phone System Setup

Follow the integration instructions provided that pertain to your telephone system in 
order for it to work with PathFinder. The PathFinder connects to any digital port within the 
system. The ports could have flexible numbers.

Starplus Digital Systems

Supported Features

� Station forward to a personal greeting

� Message waiting on/off LEDs

� Stations transfer callers directly to mailbox

� Outdial (to pager or specific number)

� Multiple Returns to Operator

Triad Systems

Supported Features

� Station forward to a personal greeting

� Message waiting On/Off LEDs

� Stations transfer callers directly to mailbox

� Outdial (to a pager or specific number)

� Multiple Returns to Operator

infinite Systems

Supported Features

�  Station forward to a personal greeting

�  Message waiting On/Off LEDs

�  Stations transfer caller directly to mailbox

�  Outdial (to pager or specific number)

�  Multiple Return to Operator

You can adjust the volume level on each port by plugging in a digital telephone 
an making an internal call, then adjust the volume. Make a CO call and repeat 
the process.
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3 MAINT Application

The MAINT application allows you to configure and control the performance of the 
PathFinder Voice Processing system.

This chapter gives a detailed description of the PathFinder settings that can be modified 
using the MAINT application. The MAINT main menu was used as an organizational 
guide for presenting these system functions.

MAINT Menu Options

1) FILE - to control and access the system files for: Logins, Passwords, and Voice 
Prompts.

2) CONFIGURATION - to set up the operational functions for: Module, System, 
Telephony, PBX Integration, KSU Clock Control, VPIM (Networking) FAX, Locator, 
and Registry.

3) EDIT - to modify the settings for: Users, Class of Service, Menus, Time Control, 
Lines, and System Lists.

4) REPORTS - to collect and analyze statistical data for: tracking and 
troubleshooting.

5) HELP - to assist the System Administrator with setting up and maintaining the 
PathFinder system.
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Overview

Prerequisites

Before configuring PathFinder, make sure the following tasks have been completed:

�  Installed the Dialogic voice card(s)

�  Installed the PathFinder software

�  Tested all voice channels

�  Installed Software Key

Call Process Flow

By default, the PathFinder system has a predetermined “call flow” which is helpful to 
know when programming and trouble-shooting.

When an incoming is received, PathFinder will verify the call parameters in the order as 
illustrated before presenting the call:

Time
Control

100 - Day

COS

Subscriber 

Mailbox (MB) Extension

Take message

Notify of call

Transfer
(Blind or Supervised)

℡ Incoming Call

120 - Night

by caller

Menu

8 - 5

# dialed

answering MB
referenced by
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Navigating in MAINT

MAINT Menu Options & Toolbar

The MAINT application is comprised of a series of menus to operate and maintain the 
PathFinder system:

FILE Menu The File menu allows access to the MAINT Logins, Record Prompts, and 
Exit program functions.

MAINT Logins The MAINT Logins option allows you to create a list of users that are 
authorized to perform PathFinder maintenance functions, and assign an 
access level to each of those users.

Record Prompts The Record Prompts option allows voice messages to be recorded and 
modified for system and subscriber use.

Scan Databases Selecting the Scan Databases option will automatically scan the 
PathFinder database files.

Clean Databases Selecting the Clean Databases option will automatically clean the 
PathFinder database files.

Exit Choosing Exit from the File menu, or clicking the Exit button 
will close the MAINT application.

9.0
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CONFIGURATION 
Menu

The Configuration menu provides access to functions that set 
parameters concerned with the general operation of PathFinder, such as 
“call transfer sequences” and “hang-up detection”. Before putting 
PathFinder into service, you must configure Module, System, and 
Telephony Settings, along with any other modules you may have 
purchased.

Module Settings Digit Lengths, Record/Playback, Auto-Attendant, Logging, Operators, 
Voice Mail, Language, and Retries/TimeOuts; controls how the voice 
processing system behaves, including languages on PathFinder.

System Settings Directories, Auxiliary Tasks, LPT/COM Ports, and Time Periods; controls 
the auxiliary tasks on PathFinder.

Telephony Settings Voice Lines, MWI/Notification, Rings, Transfer Settings, Hang Up 
Detection, and Perfect Call; controls transfer settings and hang-up 
detection parameters.

PBX Integrations PBX Settings, Subscriber Information, Class Of Service; parameters 
identify the digit length within the telephone system to which the 
PathFinder will be connected.

VPIM (Networking) Enable VPIM Messaging, Area Code Length, Remote Locations (local 
mailbox parameter and return address domain); controls PathFinder’s 
ability to send and receive messages to other systems via TCP/IP 
connections through the Internet.

Locator Settings Locator Feature Enabled, Use Vodavi Park Settings, Screen Callers, 
Default to Voice Mail, Transfer Settings; controls the Locator function for 
the DCC Optional Module.

Registry Database of system parameters; stores and shows current PathFinder 
settings made through the Configuration menu.

EDIT Menu You can further configure the PathFinder system by using the MAINT 
application’s Edit menu. This is a summary of the cofiguration options 
described in the sections that follow:

User 
(Subscriber) 
Settings

Subscribers are defined as PathFinder users who have both a mailbox 
and an extension. A User can be set up or modified by accessing the 
Edit menu … OR … by clicking the Subscriber Settings button.

Class of 
Service 
Settings

A Class of Service (COS) defines the settings that apply to a group of 
user mailboxes. These items can be set up or modified by accessing the 
Edit menu … OR … by clicking the COS button.

Menu 
(Voice) 
Settings

A Menu is made up of pre-defined actions that are executed through 
touch-tone keys. These actions can be set up or modified by accessing 
the Edit menu … OR … by clicking the Voice Menu button.

Time Control 
Settings

This option will allow you to create or modify time controls that will 
activate or disable PathFinder features depending on time of day or day 
of week. These settings can be set up or modified by accessing the Edit 
menu … OR … by clicking the Time Control button.

Line Settings This option will allow you to assign modules or applications to different 
phone lines. Items can be set up or modified by accessing the Edit 
menu … OR … by clicking the Line Settings button.

System Lists This option is used for creating automatic distribution of voice messages 
to lists of specific users.
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Special Characters & Strings

The special characters and strings supported throughout MAINT are:

REPORTS Menu The Reports menu provides access to a complete range of administrative 
and management reports on PathFinder operation. Reports are grouped 
according to the immediate selections shown in the menu.

� Highlighting a menu item with an arrow to the right of it shows the 
types of reports which you can configure.

� Refer to Chapter 4, PathFinder Reports for more information on these 
report options.

Activity lists call traffic information obtained from the PathFinder system logs.

Settings display the configuration of each user (subscriber) and system-wide 
settings.

Directory can display all or a specified portion of the Directory.

Logs display general system activity, current changes to the MAINT 
application, and system error messages, 

Messages display mailbox conditions and statistical information.

Greetings & Signatures show the total number of greeting messages being stored on the system 
and their file sizes.

Customized Report can show specific conditions and to monitor system resource distribution.

Setup Reporting determines the speed at which reports are generated and the viewer 
used to display reports.

HELP Menu The Help menu provides access to standard help functions.

Search for Help on

Context-sensitive

� If you are unsure of a screen selection or any aspect of the PathFinder 
operation, select the Contents option for general orientation or choose 
Search for Help on for help related to a specific word, term, or search 
key.

� To display “context-sensitive” help, click on the Help button in the 
MAINT toolbar or press the F1 key in most windows.

Table 3-1: Special Characters & Strings

Character/String Character Name Definition

& ampersand Flash-hook

, comma Pause

✳ asterisk DTMF star

# number sign DTMF pound

@Ext -- At an extension

0 through 9 numbers 0 through 9 DTMF keys
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File Menu Options

MAINT Logins and Passwords

The MAINT application allows you to configure the PathFinder for different levels of 
administrative programming using login passwords and access codes.

Setting MAINT User Passwords

To set user passwords:

1. Select MAINT Logins from the File menu. The Edit MAINT Users window displays.

Figure 3-2: Edit MAINT Users Window

2. To add a new MAINT user, click on Add. To edit an existing MAINT user’s password, 
click on Edit.

3. If you are adding a new MAINT user, enter the user’s User Name, Password, and 
access Level, and click on Accept. If you are editing an existing MAINT user, change 
those items as needed and click on Accept.

4. Click on Done when you are finished with this function.

PASSWORDS Tips … Once a password has been defined, you must enter it correctly 
every time you wish to access PathFinder. PathFinder passwords are case-sensitive.
For example, PassWord is not the same as PASSWORD. 

User Name:

Password:

Level:

Enables
MAINT
Login
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Access Levels

When “Require MAINT users to log in” is enabled, the System Administrator can create 
up to 9 different access levels. The higher the level (1-9), the more abilities are 
granted.

Access Level Privileges

LEVEL 9 - Unlimited

Supervisor Access

Level 9 users have access to all MAINT menus and 
options.

Level 9 users also can view and change mailbox and/or 
extension passwords.

LEVEL 8 - Limited

Supervisor Access

Level 8 users have access to all MAINT menus and 
options, with the following restrictions:

� Cannot edit MAINT logins

� Cannot write or confirm INI files

� Cannot re-index databases

� Cannot select phone system (PBX Integrations)

� Cannot configure Point-to-Point (an optional module)

� Cannot configure Engine detection

� Cannot edit INI settings

� Cannot edit the Registry

LEVELS 6 and 7 - 
Administrator Access

Users with Administrator Access have the same access 
privileges as level 8, with the following restrictions:

� Cannot modify any Module, System, or Telephony 
settings

� Cannot view mailbox and/or extension passwords, but 
can change them

� Cannot edit fax settings

LEVELS 1 to 5 - Limited

Administrator Access

Users with Limited Administrator Access have the same 
access privileges as levels 6 and 7, with an additional 
restriction: users with Limited Administrator Access 
cannot view or change mailbox and/or extension 
passwords.
PathFinder - System Administration December, 2003 - Issue 4.5



File Menu Options 3-9

Chapter 3 - MAINT Application
Record Prompts

The Recorder application is used by the Administrator to setup basic voice and system 
prompts. The Recorder wizard will walk you through this function.

Recording a Voice Prompt

1. With the PathFinder running, select the 
Subscriber from the MAINT application 
and select: Mailbox > Record Prompts. 
The Recorder: Welcome window will 
open. Click Next.

2. When the Select File to Edit window 
displays, enter the directory path and 
filename, or press the Browse button if 
unknown.

NOTE: Mailbox Signature & Greeting 
filenames are stored by their mailbox 
number, but “in reverse number order”.

For example … the greeting for mailbox 
109 would appear as:
c:\PathFinder\Menus\9\0 mb109.grt

3. Once you have selected the file to be 
modified, type the number in the 
“Extension to Dial” field where you can 
be reached by the PathFinder system.

Click Next to start the recording 
process.

PathFinder will check for active ports, 
and verify the information you entered.

4. When the Connect to System window 
displays, click Next.

A Recording Session window will open to 
allow you to play and record the necessary 
voice prompts.

Remember … the Server PC must have a sound card, microphone and speakers to use 
this recording feature.
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Backup / Restore System

When you select either Backup or Restore from the MAINT/File Menu, an external 
application called BackRest.exe will start (BackRest=BACKup + RESTore).

BackRest is a wizard-based application that will guide you through the process of 
backing up and restoring your system data. These backup files are simply copies of the 
current system files that are stored for future use as needed. This feature will also allow 
you to restore individual files manually.

Using the MAINT Menu

When running System Backup from the Maint-NT application, make sure to shut down 
the voice processing system before you begin.

Backing Up the System

1. From the MAINT / File menu, select 
System Backup.

2. Click Next to allow the program to 
determine the size of the backup files.

3. Based on the disk space required, 
select one of the Data File backup 
options: “with or without messages” 
then click Next.

4. Click Browse to choose another 
destination folder where the backup 
files should be stored, or Next to select the PathFinder/Backups directory provided.

5. Enter a unique name for the Backup File, (ex: BackupSet_Full_2003_May_23) then 
click Next.

6. When the Start Backup window displays, verify the data you entered and click Next 
to start the backup process.

7. If no errors were found, the Backup Complete window will display. Click Finish to 
exit the program.

Restoring the System

The System Restore process will 
function in a similar fashion. Select one 
of the following restore options:

» Restore from a Backup Set -- a 
backup file must be present for this 
feature to operate as shown in the 
Select Backup Set window.

» Restore from Default Settings -- 
the system will return to the same 
default state as when it was first 
installed.

You will have the opportunity to confirm 
or cancel your selection.
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Backup File Location

You can also start the Backup & 
Restore program from the Server 
machine’s PathFinder directory by 
double-clicking the “BackRest.exe” file.

When using this method, select the 
type of operation you wish to perform 
(Backup or Restore) and click Next. 
The program wizard will guide you 
through the Backup/Restore process.

Scan / Clean Databases

To help with routine PathFinder 
maintenance, use the Scan Database 
and Clean Database options in the 
MAINT / File menu.

Both operations will run automatically when selected. Once completed, PathFinder will 
create a system log that shows the results, or display a “No Errors” system message.
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PathFinder Configuration Options

The MAINT Configuration menu contains the parameters that will allow you to 
customize PathFinder to operate with your telephone system.

Module Settings

The Configuration menu provides access to module settings configuration, a group of 
functions used to control how PathFinder modules interact with the user. 

To access the module configuration options, select Module Settings from the 
Configuration menu. The following buttons display near the top of the window:

Figure 3-3: Module Settings Toolbar

Click on any of the buttons on this Module Settings toolbar to access the corresponding 
configuration options.
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Digit Lengths

The “Digit Lengths” settings determine the number of digits used in mailboxes, 
extensions, and passwords. PathFinder uses this information to determine how many 
digits to expect when asking a caller for a mailbox, extension number, or password.

This is usually loaded when you choose a PBX integration.

Figure 3-4: Module Settings: Digit Lengths Window

Mailbox Length Mailbox Numbers (maximum 7 digits).

This is usually set the same as the extension length.

Extension Length Telephone Extension Numbers (maximum 7 digits).

Minimum Password Length Password Digits (maximum 9 characters).

EXAMPLES -- Digit length for mailboxes, extensions, and passwords:
2 digits -- from 10 to 99
3 digits -- from 100 to 999
4 digits -- from 1000 to 9999
6 digits -- from 100000 to 999999

The PathFinder may act erratically if you intermix mailboxes or extensions with different 
digit lengths. For example … you should not set up 100 and 3000.

CONDITIONS -- IF the external number is the “same number of digits” as the internal 
extension numbers (i.e., 4-digits), PathFinder will have a conflict and not be able to perform 
external notification.
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Operators

The Operators settings are used to specify the dialing sequence needed to transfer a 
call to the operator. 

Figure 3-5: Module Settings: Operator Settings Window

There are 4 different operators used in the PathFinder. The operators are called when a 
caller dials 0 at different times during PathFinder operation. All operator settings are 
defined in the Registry, and described as follows:

General 
Operator

The General Operator is the global default operator for all operator 
functions. This is the dial sequence sent to the phone system to 
reach the operator (0). In most situations, this is the sequence 
dialed when the caller dials 0.

You need to specify the entire blind transfer string, including flash-
hook. Change the General Operator parameter only if necessary for 
your phone system. Although your implementation may differ, the 
normal string would be: “&, 0” (Hookflash, Pause, 0)

NOTE -- Refer to “Special Characters & Strings” on page 3-6 for 
information other special characters supported in MAINT.

Voice Mail 
Operator

The settings in the voice mail operator pane determine what 
happens when a caller presses 0 while using voice mail. If an 
operator is designated, a time-out or 0 key pad entry transfers the 
caller to the designated operator. The operator can then provide 
caller assistance.

� The 0 as First Digit is Operator parameter is allowed here 
because some phone systems use 0 as the first digit for 
extensions.

� If None is indicated in the Voice Mail Operator field, PathFinder 
uses the General Operator setting for any 0 dialed

NOTE -- Most phone systems do not allow extension numbers to start with 
0. Typically, the digit 0 should only be used for operator assistance.
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Record/Playback

The Record/Playback settings are used to access PathFinder’s recording and playback 
parameters.

Figure 3-6: Module Settings: Record/Playback Settings Window

Auto-Attendant 
Operator

The Auto-Attendant Operator determines what actions are taken 
when a caller presses 0 while in the auto-attendant module. If an 
operator is designated, a time-out or 0 keypad entry transfers the 
caller to the designated operator.

� If None is indicated in the Voice Mail Operator field, PathFinder 
uses the General Operator setting for any 0 dialed.

� As with the Voice Mail Operator, the 0 as First Digit is Operator 
parameter is allowed here because some phone systems use 0 as 
the first digit for extensions.

Personal 
Mailbox 
Operator

The Personal Mailbox Operator functions are defined in the Mailbox 
Settings options for each user/subscriber.

To configure Personal Mailbox Operator options:

� Click on Mailbox Settings, then edit the Operator field.

Refer to “Mailbox Settings” on page 3-48 for more information.

Minimum 
Record Length

This field determines the shortest allowable length of a recorded 
message.

A value of 2 seconds is recommended as the minimum message 
length. The range for this field is 1 to 999. If minimum message 
length is set too short, you may receive a disconnect tone.

Truncate 
Recording

This parameter determines how much time PathFinder trims from the 
end of a mailbox message whose recording was terminated by a 
silence or tone detection. PathFinder automatically removes trailing 
tone and silence at the end of a message, so it is recommended to 
leave this value at 0 seconds. Increase this value if the end of your 
messages contain dial-tone noise or excessive silence.

NOTE -- This setting is only used if PathFinder relies on silence or non-
silence for hang-up detection, and is not used for phone systems that 
employ loop current hang-up.
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Voice Mail

Voice Mail settings are used to configure the voice mail module.

Figure 3-7: Module Settings: Voice Mail Settings Window

Record Tone 
Length

This setting determines the duration of the beep tone that PathFinder 
gives callers before recording a message.

FF and REW 
Speed

The information in the FF and REW Speed field sets the time intervals 
that are skipped in a message when the designated REW (6+7) or FF 
(6+8) keys on the telephone key pad are pressed. The recommended 
interval is 50 to 100 tenths of a second. The range for this field is 0 to 
999 tenths of a second.

Message 
Clean Up

Specify when PathFinder is to delete messages that have exceeded 
the retention period. (Refer to “Message Retention” on page 3-59).

PathFinder performs this housekeeping function at the time specified 
in this window for each day of the week selected. Message cleanup 
can be set for a specific day of the week or for every day, and 
should occur when the phone system is inactive, such as between 
midnight and 3:00 a.m.

MWI 
Refresh

The MWI Refresh setting should be set for a time to ensure all 
message waiting indicator lights are correct.

Quick

Jump Key

Specify the touch-tone key a caller can press to bypass leaving a 
message once a mailbox greeting has begun.

When a caller presses the defined key, PathFinder jumps to a menu 
of alternate options (e.g., “Press 1 to try another mailbox”).

Pager 
Mailbox 
Delay

Specify the amount of time PathFinder delays when dialing a pager 
number for notification. This value defines the delay after dialing 
the pager number and before dialing the mailbox number. If using a 
command file for notification, this value is not used.

� Refer to Appendix A, Command Files for more information.

� Refer to “Notification Settings” on page 3-64 for more 
information on pager notification.
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Password 
Attempts

Enter the number of times a caller is allowed to try entering a valid 
password. After this number is exceeded, the PathFinder can be 
programmed to take a programmable option.

PathFinder keeps track of such attempts in its logs, which can help 
determine if an unauthorized user is attempting to gain access to 
PathFinder.

Notification PathFinder can accidentally become connected to itself and create a 
repeating loop. For example, assume that PathFinder is attempting 
to notify an extension owner of new messages:

When it dials the extension, that extension is busy; therefore,

� PathFinder is forwarded to the extension’s mailbox (in other 
words, PathFinder calls itself).

� PathFinder leaves a message in the extension’s mailbox.

� As a result, PathFinder attempts to once again notify the mailbox 
owner of the new notification message in his or her mailbox, 
creating a repeating loop. 

An example of how this could happen …

The Notify Send Keys are a series of DTMF key signals that 
PathFinder sends with the message notification that cancel the 
incoming channel and end the loop. Since the keys are sent for all 
voice notifications, some users may find this a nuisance, and the 
recommended setting is blank.
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Auto-Attendant

The Auto-Attendant settings provide access to caller-related Call Queue Interval and 
Directory configurations.

Figure 3-8: Module Settings: Auto-Attendant Window

Call Queue Interval The Call Queue Interval specifies the amount of time before 
PathFinder retries an extension when a caller is in queue. A 
10 to 20 second interval is recommended. The range for this 
field is 1-999.

� Call Queue Interval is dependent on the extension’s class 
of service.

� Call Queue Interval is disabled unless it is manually 
enabled in the Class of Service configuration.

� To activate the Call Queue Interval:

Change the setting to “Enable” in the COS.
Enable “System Visible Transfer” (default = disabled).
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Directory The Directory (also called the System Directory) is a list of 
users in PathFinder. Directory functions describe how the 
company directory should be played back to a caller that 
requests the directory.

PAGED Mode -- Gives the caller several matching entries, 
then a caller must press a key to go to the next page, or 
set, of entries.

� This is a hybrid between List and Single mode.

� PathFinder presents only eight matches at a time, and the 
caller presses a number one through eight to choose a 
match.

� The caller can press 9 to go to the next page, or set, of 
eight matches.

LIST Mode -- This default mode provides a caller with all 
matching entries in a complete list.

� Each matching name and extension (or mailbox) is 
played in order.

� At the end of the list, PathFinder prompts the caller to 
enter the selected extension number.

� If there are 100 matches, all 100 names and extensions 
are played.

� The caller can enter the desired extension or mailbox 
number at any time during the list playback.

NOTE -- List mode can reveal the entire list of extensions 
and/or mailboxes.

SINGLE Mode -- Provides the caller with a list of all 
matching entries, one at a time.

� Callers must press a key to indicate whether they want 
to select the most recently read name or hear the next 
matching entry.

� Single mode presents only two options to the caller for 
each match.

NOTE -- To prevent Extension/Mailbox numbers from being 
presented to callers, change the “DirPlayExtension” registry 
setting to “0”.

Maximum Keys This is the maximum number of digits that the caller can 
enter before PathFinder begins to look up directory entries.

� The range for this field is 1 to 999.

� If fewer digits are entered, PathFinder will attempt to 
search for those entries.

For example: if you enter “86” and wait, you will receive 
a list of names that begin with “VO”.

Maximum Wait This is the maximum amount of time that PathFinder waits 
for the Maximum Keys while a caller is entering numbers (to 
spell the user/subscriber’s name on the keypad).

� By default, the maximum time is set to 8 seconds.

� The range is variable from 1 to 999.
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Language

PathFinder provides optional language support modules for both English and Spanish. 

Figure 3-9: Module Settings: Language Window

Logging

PathFinder continuously generates detailed information on its operation. 

Figure 3-10: Module Settings: Logging Window

What To Log

The raw data is a chronological history of all events that occur in PathFinder and can be 
used to evaluate real-time performance. Raw data include time, date, line, module, and 
a description of each event. These raw data can be formatted into a variety of reports 
that help measure performance. Changing these selections may alter certain reports. 
Refer to “Logs Reports” on page 4-23 for more information on these reports.

Default Language Use this menu to select the language that PathFinder uses as 
the default language.

Languages Allowed To use this feature, the optional multilingual module and 
language prompts must be purchased separately.

X

Kanji

Korean

Russian

Custom

Malay

Tamil

Mandarin

German

French

Dutch
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Log Files -- The Logging settings allow you to select which modules send information 
to the log files.

� The fewer modules selected, the less disk storage space needed and the faster 
PathFinder operates.

� The more modules selected, the greater the amount of information available to help 
diagnose problems and to generate reports.

Each day's activity log output to the disk is stored in a unique file in the log sub 
directory (\PATHFINDER\LOGS). The file name of each daily activity log has the 
following format: DL<YY><MM><DD>.LOG

EXAMPLE -- The log file for February 23, 2003 would be called DL032302.LOG

Call Begin/End* The start and end of calls.

Voice Mail* All voice mail activities, except owner activities.

Auto-Attendant* All call transfer activities.

Menus* All menu selections.

Voice Mail Owner* Mailbox owner activities.

Directory Accesses of the company directory.

Track Messages Complete logging of message file names and when 
messages are deleted, created, saved, etc.

Used to track complaints of lost messages, etc.

Message Manager Turns on logging of message manager activities.

Notification* PathFinder notification actions.

Time Controls* Actions controlled by time control files.

Fax Support* All fax support activities, if enabled.

Integration* Tracks information received from the phone system
(In Band Signal).

Desktop Call Control All Desktop Call Control activities.

E-mail Reader All E-mail Reader activities.

Default The Default button activates the Log Option settings 
indicated with an asterisk (*).
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What To Debug

The Logging settings also include debugging options. Module debugging is a 
sophisticated diagnostic tool used to resolve problems with PathFinder. DO NOT run 
PathFinder with Module Debugging on, as it can slow performance. Use debugging only 
as needed.

Module debugging parameters include the following:

Once debugging has been activated, it generates large amounts of data that can 
potentially fill up the disk drive. Select specific module debugging options only at the 
request of Vodavi Technical Support.

Basic Foundation Tracks basic information from the system, including which 
modules are loaded into memory.

Voice Mail Tracks all voice mail activities, including length of message 
and hang-up type.

Auto-Attendant Logs information regarding transfers, including call results.

Menus Detects what menu prompt is played and what keys each 
caller presses.

Voice Mail Owner Tracks mailbox owner activities, including what messages 
are played, saved and deleted.

Directory Oversees directory activities, including what keys are 
pressed when a caller accesses the directory.

Events Tracks events, including pager and message waiting 
indicator notification.

Message Manager Tracks events as the message manager processes them.

Notification Tracks notification of messages, including notification strings 
and retries.

Time Controls Provides detailed information regarding time control 
processing.

Fax Support Monitors the fax support module.

Integration Tracks information packets received from the telephone 
system regarding transfers.

Desktop Call Control Monitors the Desktop Call Control module.

E-mail Reader Monitors the E-mail Reader module.

All Off Clicking this button deactivates all debugging options.
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Retries/Timeouts

The Retries/Timeouts settings determine how PathFinder handles erroneous input from 
callers. 

Figure 3-11: Module Settings: Retries / TimeOuts Window

Some modules use these settings, but basic PathFinder does not. Menus have their own 
retries and time-out settings that take precedence when they are active.

Caller Retries Number of times a caller can retry entering an option. The range 
for this field is 1 to 999. If numbers are exceeded, the caller will be 
prompted to enter a new mailbox number.

Owner Retries Number of times a mailbox owner is permitted to retry entering an 
option. The range for this field is 1 to 999. If numbers are 
exceeded, the caller will be prompted to enter a new mailbox 
number.

Inter-Digit Time Length of time between digits. Used in cases where the length of 
the entry is unknown. PathFinder assumes the caller is finished 
entering digits if this length of time passes after the most recent 
digit is entered. The range for this field is 1 to 999.

Digit Time Digit Time is the length of time that a caller can press a digit 
before PathFinder assumes that the digit is being repeated. The 
range for this field is 1 to 999. 

Example … By default, Digit Time is set to 2 seconds.

� If a caller presses and holds the 7 key for less than 2 seconds, 
PathFinder will assume that the caller has entered 7.

� If a caller presses and holds the 7 key for more than 2 seconds, 
PathFinder will assume that the caller has entered 77.

� If a caller presses and hold the 7 key for more than 6 seconds, 
PathFinder assumes that the caller has entered 777.
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System Settings

The PathFinder Configuration menu provides access to System Settings configuration, a 
group of functions used to maintain the PathFinder directory structure, identify 
communications and printer ports, and define the use of non-voice channels. To access 
the module configuration options:

� Select System Settings from the Configuration menu.

� Click on any of the buttons on this System Settings toolbar to access the 
corresponding configuration options.

Figure 3-12: System Settings Toolbar

Directories

The Directories function defines paths so that PathFinder can locate system files if they 
are placed in directories other than the defaults.

Figure 3-13: System Settings: Directories Window

DO NOT alter these subdirectories unless instructed to do so by Vodavi Technical Support.
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Auxiliary Tasks

The Auxiliary Tasks function provides for definition of auxiliary channels. Auxiliary 
channels are used to pass non-voice data as in a telephone integration setting 
(Message Manager or SMDI integration controller).

Figure 3-14: Auxiliary Task Settings Window

Making Changes

You can alter the Auxiliary Task settings by highlighting the task and selecting the 
appropriate action: Edit / Add / Delete. 

When editing or adding a task (with a maximum of fifteen tasks), complete fields at the 
bottom of the window as follows:

Task The system assigns the next available task number.

Name Select or type the appropriate name.

Description Enter a description for this auxiliary task, to identify it in the 
application and in reports.

Event Group Select the group for which this line is to handle the action. Note 
that any event group you specify must have at least one line 
assigned to it in the Line Settings configuration (refer to “Line 
Settings” on page 3-84). 

� If Task is Message Manager, Event Group must be 1. 

� If Task is other than Message Manager, define Event Group as 
6 or higher.

Edit Task

Name

Description

Event Group
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LPT / COM Ports

The LPT/COM Ports window is used to identify which printer port and which COM port 
are used by the system.

Figure 3-15: Module Settings: LPT/COM Port Settings Window

Time Periods

The Time Period settings provide definitions of the time periods for PathFinder.

Voice Mail, Auto-Attendant, & Menu Time Periods

Time Periods are not used in the voice mail, Auto-Attendant or menu modules. To 
control how the voice mail, Auto-Attendant, and menus process a call, use the “Time 
Control Settings” on page 3-79 to override these parameters.

Figure 3-16: Module Settings: Time Period Settings Window

Printer Port Select the proper printer port - LPT1, LPT2, or None.

Use LPT1 if a printer is connected to your system, the Software 
Key can be on the same port.

Serial Port Select the proper COM port - COM1, COM2, COM3, or None.

Work Hours Defines the start and end of a business day. Enter hour and minutes 
using a 24-hour clock. Example … 1:30 p.m. is entered as 13:30.

Holidays Define start and end dates for holidays. You can add and remove 
dates from this list. You can define a maximum of 20 holidays.
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Telephony Settings

The PathFinder Configuration menu offers access to Telephony Settings configuration, a 
group of functions used to control general telephony operation of PathFinder. Telephony 
Configuration options are displayed in the buttons near the top of the screen when you 
select Telephony Settings from the Configuration menu.

Figure 3-17: Telephony Settings Toolbar

Click on any of the buttons on this Telephony Settings toolbar to access the 
corresponding configuration options.

Voice Lines

The Voice Lines function displays the number of voice lines for which your PathFinder 
installation is configured.

Figure 3-18: Telephony Settings: Voice Channels Window

The number of voice lines that are displayed is the number of active voice lines on your 
PathFinder. The text below the Number of Voice Lines field (“The key is licensed for X 
ports”) indicates how many ports the software key allows.

Refer to “Special Characters & Strings” on page 3-6 for a listing of special characters 
that are supported by PathFinder.
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MWI/Notification

The MWI / Notification function provides for control over message waiting indicator and 
message notification functions.

Figure 3-19: Telephony Settings: MWI/Notification Window

Number Length 
to Edit

Use the dropdown menu to select the length of digits the PathFinder 
will dial for notification.

Message Waiting The Message Waiting Set and Clear settings define how PathFinder 
notifies a station of a waiting message. These numbers are defined 
by the PBX or Key System.

NOTES -- MWI sequences can be controlled by COS. Refer to “MWI 
Strings” on page 3-65 for more information.

If your phone system does not support message waiting indicators, 
leave these fields blank.

Set Enter the dialing sequence necessary to activate a message waiting 
indication.

� Message waiting indication must be accessible by dialing a 
sequence of numbers from a single line telephone for PathFinder to 
make use of this capability.

� Use the command @Ext to specify where the extension should be 
located. For example … with the Vodavi telephone system you 
would use 422 or 422 to set the lamp on extension 345. Note that 
@Ext is case-sensitive. 

� If the phone system supports message count (as opposed to just 
a message waiting light), use the command @NewMsgCnt to 
send the number of messages followed by the length of the digits 
dialed (.03 or .04).

Clear Enter the sequence that turns off the message waiting light.

� Use the command @Ext to specify where the extension should be 
located. For example … use [,420 @Ext] to clear the lamp on 
extension 345. Note that @Ext is case-sensitive. 

� If the phone system supports message count (as opposed to just 
a message waiting light), use command,422@Ext@000 to clear 
the MWI.
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Hang Up Detection

Hang-up Detection allows PathFinder to detect when callers hang-up during a call. Unless 
properly set, PathFinder is unable to detect a hang-up condition.

Figure 3-20: Telephony Settings: Hang-Up Detection Window

Types of Disconnect Tones

Notification 
Prefix

Type the command string required by the telephone system prior to 
dialing a notification number.

� Refer to “Mailbox Settings” on page 3-48 for more information on 
configuring notification in the Users Settings.

� Refer to Appendix A, Command Files for more information.
This setting is used in a command file when using the 
DialPrefixforWhereField; otherwise, it is not called when a command 
file is being used for notification. Refer to “Notification Settings” on 
page 3-64 for more information.

It is recommended that the access code is placed here, but do not 
put the long distance “1” because the PathFinder could inadvertently 
dial “911”.

Loop Current 
Supervision

Loop Current disconnects are always activated by default. If 
available on your telephone system, activate Loop Current 
Supervision. When a drop in loop current is detected on a line, 
PathFinder will disconnect. This is the preferred method for detecting 
hang-ups and is the most reliable.

Tone or Silence 
Disconnect

Some telephone systems provide a continuous tone or silence to tell 
the voice processing system the call should be disconnected. These 
are not as reliable as Loop Current disconnects and may cause a line 
to remain connected longer than necessary or result in false hang-
ups and callers being disconnected.
PathFinder - System Administration December, 2003 - Issue 4.5



3-30 PathFinder Configuration Options

Chapter 3 - MAINT Application
Determining Tone Type

To determine what type of disconnect your telephone system provides, consult your 
telephone system manual. If the manual does not provide this information, follow these 
steps to determine your hang-up type:

1. Have someone call an extension.

2. Answer the extension.

3. Have the caller hang-up.

4. Listen to the system.

Re-Order Tone Still other telephone systems send Re-Order tone to the voice 
processing system for disconnect. This is a reliable method but 
require some configuration in the PathFinder voice processing 
system.

General Tone 
Detection

Some telephone systems send a tone that is not continuous and is 
not a Re-Order Tone. In this instance, you would use General Tone 
Hang-ups. This General Tone can be learned via PBXpert and will 
generate disconnects as reliably as Re-Order disconnect.

If you hear … Then your telephone system …

silence provides Silence Hang-Ups.

a continuous tone provides Tone Hang-Ups.

re-order tone may provide Loop Current supervision
-or-
Re-Order Tone detection.

You must know the type of hang-up detection your phone system supports before you 
alter any hang-up detection parameters.
Refer to your phone system documentation if necessary.
PathFinder - System Administration December, 2003 - Issue 4.5



PathFinder Configuration Options 3-31

Chapter 3 - MAINT Application
Hang-Up Detection Settings

Loop Current 
Drop

Adding or editing the Registry parameter “minlcoff” will enable 
this option if your telephone system provides “Loop Current” 
Supervision. PathFinder will automatically recognize a drop in loop 
current as disconnect with no configuration. The “minlcoff” 
parameter can be adjusted for PathFinder to reliably detect loop 
current disconnects.

Tone Interval Specify a number between zero and ninety-nine that represents the 
detection interval. This interval defines the length of time, in 
seconds, for the tone that sounds before PathFinder disconnects or 
hangs up a call.

For example … Entering 5 for the Non-silence interval instructs 
PathFinder to listen for a steady tone that is five seconds long and, 
upon detection, to treat the call as a disconnect.

� If the interval is set too short, any pause could be interpreted as 
a tone, signaling a false hang-up.

� If the interval is too long, PathFinder can be tied up longer than 
necessary.

The recommended interval for both silence and non-silence 
intervals is five to seven seconds. 

Silence Interval Specify a number between 0-99 that represents the detection 
interval. The silence interval defines the length of time, in seconds, 
for the silence that elapses before PathFinder disconnects or hangs 
up a call. For example … entering 5 for the Silence interval instructs 
PathFinder to listen for a silence that is five seconds long and upon 
detection to treat the call as a disconnect. 

� If the interval is set too short, any long noise (such as cellular 
phone static) could be interpreted as a tone, signaling a false 
hang-up. 

� If the interval is too long, PathFinder can be tied up longer than 
necessary.

NOTE -- The recommended interval for both silence and non-silence 
intervals is five to seven seconds.

Re-Order Tone Use this option if there is a cadence of silence and non-silence after 
a disconnect. Your telephone system documentation should provide 
the exact cadence of silence and non-silence (tone). If not, use 
PBXpert (refer to Appendix C, Building a PathFinder) to learn the 
Re-Order tone.

NOTE -- To use this function, you must refer to your phone system 
documentation regarding tone frequency for hang-up.
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Add or Edit Tone Template

If you select to edit or add a template, the following window is displayed:

Figure 3-21: Telephony Settings: Voice Channels Window

To determine the Tone Template settings, use PBXpert to learn the disconnect tone.

For each tone template you edit or add, complete the fields in this window as follows:

General Tone 
Detection

Some telephone systems send a tone that is not continuous and is 
not a Re-Order Tone. In this instance, you would use General Tone 
Hang-ups which can be learned via PBXpert, and will generate 
disconnects as reliably as Re-Order disconnect.

» » » “General Tone Detection” is not usually needed for Vodavi 
phones systems.

Click on Set Tone Templates to perform any the following tasks:

� Delete a tone template: Highlight the template and click on 
Delete. No further action is necessary.

� Modify a tone template: Highlight the desired tone template, 
then click on Edit.

� Add a new tone template: Click on Add. 

Description Type a description that can help you remember this tone template’s 
purpose.

Tone ID Enter a number from 101 to 120, following the previous tone template 
in numeric sequence.

Repeat Count Should be set to 0 for continuous tones. For cadences, it should be the 
number of times that the pattern should cycle on/off.

Edge Select Rise if this is a leading-edge tone; select Fall if this is a trailing 
edge tone. Typically, this value will be set to Rise.

Frequency 1

Hz+/-

Specify the first frequency of the tone (always included) in Hz.

Specify the maximum deviation from the first frequency, in Hz.
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Frequency 2

Hz+/-

Specify (in Hz) the second frequency if the tone is a dual tone; if the 
tone is a single tone, set this field to 0.

Specify the maximum deviation from the second frequency, in Hz.

NOTE -- Single tones have zero values for Frequency 2; dual tones 
have non-zero values.

On Time For cadences, enter the length of time (in 10ms units) tone is on. For 
continuous tones, enter 1/2 of debounce time (in 10ms units).

x 10 ms + / -
for On Time

For cadences, enter the plus-or-minus deviation (in 10ms units) for on 
time. For continuous tones, enter 1/2 of debounce time (in 10ms 
units).

Off Time For cadences, enter the length of time (in 10ms units) tone is off. For 
continuous tones, enter 0.

x 10 ms + / -

for Off Time

For cadences, enter the plus-or-minus deviation (in 10ms units) for off 
time. For continuous tones, enter 0.

NOTES:

� Continuous Tones have zero values for On Time and Off Time 
deviations.

� To debounce leading edge continuous tones to prevent talk-off -- 
Set the On Time to 1/2 of the desired debounce time (in 10ms 
units) and the On Time deviation to -1/2 of the desired debounce 
time (in 10ms units).

� Cadence Tones have non-zero values for On Time and Off Time 
deviations.

Tone Events Check On to activate this tone template. Check Off if you need to 
disable this tone.

Options Unless otherwise instructed by Vodavi Technical Support, ensure that 
the Set Wait check box is cleared and that the Set Hang-Up check 
box is selected. 

� Set Wait determines whether a tone occurrence should generate 
events to wait function.

� Set Hang-up determines whether a tone occurrence should set 
hang-up (H7) and terminate Dialogic® operations.
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Transfer Settings

Transfer Settings function provides control over call transfer activities.

Figure 3-22: Telephony Settings: Transfer Settings Window

When addressing the following fields, refer to your phone system manual as needed for the 
appropriate codes.

Number Length to Edit This setting shows the defined extension length you are 
editing. Use the drop-down menu to select the length of the 
extension setting that will be transferred. For example … if you 
want to transfer to a 7-digit telephone number, you must 
choose “7”.

Transfer … Transfer Prefix and Postfix settings can be controlled by the 
Class of Service. Refer to “Transfer Strings” on page 3-69 for 
more information. A typical transfer prefix is [&]. 

The transfer prefix for:

� 3 and 4 digits = &, 6, or #

� 7, 8, 10, and 11 digits = 9,

Prefix Enter the flash-hook and/or tone dialing sequence that starts 
a call transfer. On most phone systems this feature is 
completed with a flash-hook and pause. If this is the case, 
enter &, (the comma provides the pause) in this field. 
PathFinder will automatically dial the extension number after 
dialing the prefix.

Postfix Enter the flash-hook and/or tone dialing sequence needed to 
end a call transfer (usually, this entry is not required).

Connect Enter anything required to connect a transferred call. Most 
phone systems do not require anything for this feature.

Use Perfect Call Selecting “Use Perfect Call” indicates that PathFinder should 
use the Perfect Call settings. Refer to “Perfect Call” on 
page 3-37.
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Recall Caller On … These settings are only used in Supervised Transfers. A typical 
transfer prefix is [&].
If you are not using Supervised Transfers, leave these settings 
as they are. Complete the Recall Caller On fields as follows:

Busy Enter the value needed to abort a transfer to a busy number 
and reconnect the caller to PathFinder. The typical value for this 
field is [&] which is a flash hook. Sometimes a tone dialing 
sequence is needed in addition; for example: [&,*1].

No Answer Enter the value needed to abort a transfer to an unanswered 
number and reconnect the called party. On most phone 
systems, this value is the same as for Recall a Caller on Busy.

Reject This feature allows PathFinder to retrieve a call if the extension 
to which the call was transferred rejects it. This feature is 
used during Auto-Attendant call screening. It can be viewed as 
“Abort a Connected Transfer.” Typically, the dialing sequence is 
the same as for “Recall Caller on Busy” field.

Blind Transfer Delay Enter the number of seconds the system should pause after 
dialing the transfer sequence and extension number, but 
before going on hook. The maximum value for this field is 
999. By default, Blind Transfer Delay is set to zero (0) and 
should not be changed.

Flash Hook The default length of 1/2 second is appropriate for most phone 
systems. 

Flash-Hook Length If DTMF tones are audible when attempting a transfer, this 
setting needs to be increased. If the phone system hangs up 
when attempting a transfer, this setting needs to be shorter.
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Rings

The Rings function determines how PathFinder processes ring detection on incoming 
calls.

Figure 3-23: Telephony Settings: Rings Window

Ring Settings

Number of Rings Before 
System Answers

This parameter determines the number of times PathFinder 
rings before answering an incoming call. One ring is a 
typical setting.

Number of Rings Before 
No Answer Detected

This parameter is used during supervised transfers to 
determine how many rings must elapse before PathFinder 
terminates the activity. If the line is not connected after 
the number of rings specified, the action is aborted. Three 
rings is usually adequate.

Ring Detection

Ring Count Reset Delay This setting is used in particular telephone system 
integrations and typically should not be modified.

Minimum Ring ON This setting describes the ring cadence from the phone 
system when an incoming call is received.

Minimum Ring OFF This setting describes the ring cadence from the phone 
system when the system is idle and there is no ring from 
the phone system.

Ring Edge to Detect If parameter is set to Rise, PathFinder detects inbound 
rings more quickly. Set this to Fall to slow it down if you 
occasionally get false rings.
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Perfect Call

Perfect Call specifies the exact tones that make up the different telephony signals (dial 
tone, busy signal, ringing, do not disturb, etc.). Typically, these values are pre-
programmed when you select your telephone system. If these values are not defined, 
you can use PBXpert to learn the tones. Refer to Appendix C , " Building a PathFinder".

Figure 3-24: Telephony Settings: Perfect Call Window

PBX Integrations

When you start PathFinder for the first time and have gone through the First Time 
Questions window, you will be prompted to configure your PBX integration.

PBX Integration Select List

The PBX Integration selection window (located in the Configuration menu), allows you 
to select what phone system the voice mail system will be connected to. Select the 
phone system from the list that best matches your phone system. If you currently have 
settings loaded for a particular PBX, that phone system is displayed at the top.

Figure 3-25: PBX Integration Window

This window
displays the current
PBX selection …

124 - VODAVI INFINITE DVX PLUS MACH I

109 - VODAVI STARPLUS TRIAD 3
111 - VODAVI STARPLUS TRIAD-S
120 - VODAVI INFINITE 4096
121 - VODAVI INFINITE DVX I
122 - VODAVI INFINITE DVX II
123 - VODAVI INFINITE DVX III
124 - VODAVI INFINITE DVX PLUS MACH I
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PBX Install / Remove

After you have selected a PBX from the list, the following window, which allows you to 
select what options to install, is displayed.

Figure 3-26: PBX Integration (next) Window

VPIM (Networking) Settings

The VPIM Settings dialog controls the voice mail systems ability to send and receive 
messages to other systems via TCP/IP connections. Systems enabled for VPIM 
messaging can exchange voice and fax messages without incurring voice line charges. 
This is possible because the systems use the Internet to send and receive messages.

Remote Locations List

Once a remote system is added to the Remote Location's list, voice mail users can send 
messages to those systems by entering the "area code" followed by the mailbox 
number on the remote system.

Since the mailbox doesn't actually exist on the local system, the Class Of Service 
"VPIM_xxx" (xxx = area code) is used to determine the type and settings used to 
record the message.

When changing your PBX Selection …
» It is strongly recommended that you perform the install & remove process at the same 
time, as shown in the “PBX Integration” window (instead of separately).
» Some mailboxes may not get deleted. If desired, you will need to remove them manually.

130 - VODAVI XTS (4 DIGIT EXT)
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Make sure you have created a COS named "VPIM_xxx" and that it's settings are correct 
for your needs.

Enable VPIM 
Messaging

This check box turns on VPIM messaging. Since the system will now 
accept longer mailboxes numbers, callers may notice a delay from 
the time entering the actual box number to the time the greeting is 
played. Only enable VPIM messaging if you are going to use it.

Area Code 
Length

This numeric value sets the length for the "area codes" for this 
system. Each system in a VPIM network can use different lengths 
for area codes. A typical value is 3. Settings from 1 to 9 are valid. 
(This is not your local “area code” number.)

Remote 
Locations

This list box holds all remote locations configured for this system. A 
remote location must be configured before message may be sent. 
The list does NOT control systems that can send messages to this 
local system. Use the Add, Edit, and Delete buttons to manage the 
locations. You may "Copy" a location by selecting the location and 
pressing Edit. Then change the area code and press OK. See VPIM 
Location Settings for more information.

Local Mailbox 
Parameter

When a VPIM message is sent from this system to a remote 
system, the remote system needs to know the address of this 
system so that replies can be sent.

Return Address 
Domain

Enter the IP name of this machine so that remote systems can 
connect to this system. Typically the name will be 
"pathfinder.ourdomain.com"

Area Code Length

Remote Locations

Return Address Domain

Local Mailbox Parameter

When “Enable” is �… 
buttons and Settings window
will become available.
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FAX Settings

Sets various configuration options for the Fax option. Displayed by selecting Fax 
Settings from the Configuration menu.

Figure 3-27: FAX Settings Window

Setup and Administration

Administration Password Specify the password to be used for administrative access to the 
fax system (used when adding fax documents to the fax 
database).

Event Group to use when 
sending

Enter the event group that handles outbound faxes. Event group 
6 (six) is commonly used for fax purposes. Note that any event 
group you specify must have at least one line assigned to it. See 
Setting Up Lines.

FAX ID for this system Enter an identifier for your company's fax system. Maximum 
documents a caller can select - enter any limit you want to set 
for the number of documents a caller can access during one 
phone call.

Allow Voice Attachments Checkmark this option to enable voice files to be sent with faxes.
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Locator Settings

The Locator module is a feature of the optional Desktop Call Control program. This 
function allows the Subscriber to set up the parameters to have specified callers be able 
to locate them when they are not at their designated extension. Refer to Optional 
Modules manual for more detailed information.

Fax-On-Demand

Maximum documents a 
caller can select

Click this if you want to disable outbound faxing capabilities for 
fax-on-demand. 

Callers must call from FAX 
machine

Callers must call from a fax machine and will be prompted to 
turn control over to the fax machine to receive the fax, making 
the caller responsible for any long-distance charges.

Fax Send Parameters

File to send as cover sheet Enter the name of the .tif file to be sent as a cover page with 
each fax document.

Retry attempts for failed 
sends

Enter the number of times The system should try to re-send a 
fax if the call results in a busy signal or no answer, or 
disconnects in the middle of a send. A typical value is 3.

Retry interval for failed 
sends

Enter the number of minutes the system should wait between 
retry attempts.
PathFinder - System Administration December, 2003 - Issue 4.5



3-42 PathFinder Configuration Options

Chapter 3 - MAINT Application
Registry

The PathFinder Registry is a database of parameters. All changes, settings, and 
parameters set through the Configuration menu are stored in the Registry.

To display the Registry, select Configuration > Registry. PathFinder will display a window 
with all the current Registry parameter entries. This provides a helpful overview of all 
PathFinder settings should troubleshooting be required.

Registry Maintenance

Buttons in the Registry window provide you with the ability to modify various Registry 
parameters, both for hardware and software.

Delete Registry Item -- The Delete function allows you to select a specific item from the 
Registry list and delete it. After you select the item, click on Delete. PathFinder prompts 
you to confirm that you want to delete the item.

Add or Edit Registry Item -- The Edit function of the Registry window provides you with 
the ability to select a specific item from the Registry list and edit it.

Occasionally, it becomes necessary to add an item to the Registry. This may occur if 
new applications are added through new software modules, or if existing modules are 
changed or upgraded. 

You should not make changes to these options. Incorrect entries made to the Registry can 
cause serious system problems.
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ADD -- To add a Registry item, click on Add in the Registry window. PathFinder displays 
the Add Registry Item window, where the changes can be made.

Caller ID - Owner Call Back Feature

To allow users access this “calll back” 
function, two variables must be added to 
the Registry. These parameters control 
how the system will dial Caller ID digits 
when the user wants to return a call. 
The variables are:

LocalAreaCodes

LocalDialing10Digits

» The LocalAreaCodes variable should 
contain 1 or more area codes 
separated by spaces that are the local dialing area codes for your area.

For example … in the Phoenix area, "480 602 623". In cases where only one area 
code is used, then it should be entered.

» In areas where multiple area codes are considered "local", most areas use 10-digit 
dialing. If the location of the PathFinder system uses 10-digit dialing, set the 
variable "LocalDialing10Digits=Yes".

When the user presses [6]+[0] during message call back, the system will modify the 
stored Caller ID number and transfer the user to the calling party. The user will hear 
the prompt, "Please hold while I transfer you."

Add Registry items only under the direction of Vodavi technical support staff or 
your PathFinder dealer.
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EDIT -- After you select the item, click on Edit. PathFinder displays the Edit Registry 
Item window, where the changes can be made.

Registry Item Fields

The following fields are used to add or edit Registry items:

Name The Registry item to add or modify. This entry is case sensitive.

Value The current value for the setting.

Default Specifies a default value for this setting.

Description A general description of the setting.

Type Select the options that apply to this Registry item.

� Defaults -- if you assigned a value in the Default field

� Reloadable -- to indicate that PathFinder should be reloaded when this 
parameter changes

�  INI Parameter -- if the value is to be written to an INI file

� Write Empty -- if the value is to be written to even if empty

INI File 
Settings

Select the options that apply:

� INI File -- If INI Parameter was checked above, use this field to enter 
the name of the INI file to write to.

� Section -- If writing to an INI file, specify the section in which to write.
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Edit Options

User Settings

Overview

This section describes the Users (also known as Subscribers) functions available 
through the Edit menu.

The System Administrator will be able to create, modify, and delete user settings, both 
general and specific.

These functions can also be accessed by clicking the User icon on the toolbar.

A Subscriber has a primary area called
“User Settings”. This module is password 
dependent and contains the following 
Subscriber information:

The Mailbox number allows the Subscriber to 
play personalized greetings, store recorded 
messages, and choose how to be notified of a 
new message.

The Extension number allows the Subscriber to interface with the PBX system.

The COS will verify all call transactions prior to taking any action.

User

COSExtensionMailbox

Settings
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Creating Users

Subscribers may be set up individually or in groups, referred to as ranges. Any time you 
define a subscriber, you will create a mailbox and a corresponding extension. Generally, 
the mailbox number will match their extension number.

Before creating a new Subscriber, or a 
group of Subscribers, you should create a 
“template” Subscriber. A template 
Subscriber should be set up for each group 
that you want to create.

This will allow you to customize group 
parameters such as passwords, class of 
service, or types of transfers.

For your convenience, Mailbox 100 is set 
up as the default template mailbox. 
However, each group, e.g. Sales and 
Accounting) should have its own template.

To create a template … click the Users 
icon on the toolbar. When the “Select User 
to Edit” window displays … click Create Users or Create Range to set up a mailbox 
template from the “Create Users” window.

Single Mailbox

To set up a single subscriber, perform the 
following steps.

1. Click on the Users icon in the toolbar. 
or select from the menu bar Edit > 
Users > Show List from the menu bar.

2. When the “Select User to Edit” 
window displays, click the Create 
Users button.

3. Enter the following information about 
this subscriber:

Mailbox -- subscriber’s mailbox 
number.

Extension -- extension to which this 
mailbox is linked.

First Name -- subscriber’s first name.

Last Name -- last name of the 
subscriber. The data in this field will be 
use to create the company directory.

(To use first names for the company 
directory, reverse the order of the 
Subscriber’s name: last name in first 
name field, first name in last name field.)

Mailbox Template -- If you have already created a subscriber whose mailbox 
definition can serve as a template for this subscriber, select that mailbox number in 
the Mailbox Template drop-down list.

Jones, Mary

Wright, Kim
Blair, Zachary
Black, Janet

Smith, Bob
123

224
225
333

223
123
223
224
225
333
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4. Once all the information is entered, click on Add User to List.

5. Repeat this process for any additional subscribers you need to establish.

6. When you have identified the last subscriber you need to create, click on Create 
Users to return to the Select User to Edit window.

7. To further define mailbox parameters for a subscriber, refer to “Editing User Setups” 
on page 3-47.

Multiple Mailboxes

The Create Range option provides you with the ability to set up multiple subscribers 
without the need to set them up individually. To create a range of subscribers, perform 
the following steps.

1. In the Select User to Edit window, 
click on Create Range to display that 
window.

2. In the Start Mailbox field, enter the 
first mailbox number in the mailbox 
range.

3. In the Start Extension field, enter the 
a corresponding extension number to 
be used for the first extension in the 
mailbox range (for example … 110). 

4. Select a template for default settings from the drop-down list.

5. For Number to create, enter the number of mailboxes you want to create. (For 
example … if you want to create mailboxes 110-120, you would enter 11.)

6. Click on Create Range.

Editing User Setups

The Edit Mailbox function is used to make changes to the settings and parameters of 
existing mailboxes. To edit general user/subscriber settings, perform the following: 

1. From the “Select User to Edit” 
window, highlight the subscriber to 
edit and click on Select. The “Edit 
User’s Settings” window will display.

The Edit User’s Settings window 
shows the Subscriber’s mailbox and 
extension number.

2. Complete the fields for this Subscriber 
as follows:

First Name and Last Name -- The 
names can be changed as needed.

Password -- The default password is 
four zeros (0000). This password is 
changed by the Subscriber when they 
first log in.

Department -- Enter the department or area in which the employee works (this field 
is used to provide additional information in reports).
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Class of Service (COS) -- To change the Class of Service, click on the drop-down list 
and select the COS to associate with this mailbox.

Tutorial -- Determines if the tutorial is played when the mailbox owner accesses 
PathFinder.

� If option is disabled, the subscriber’s COS does not allow for a first-time tutorial.

� If option is enabled and not checked, the subscriber has probably already heard 
the tutorial.

� If option is enabled and is checked, on the next call into PathFinder, the mailbox 
owner will access the tutorial.

3. Click on Save to add this definition to PathFinder.

Mailbox Settings

To adjust Mailbox Settings, click on Mailbox Settings from the Edit User’s Settings 
window. The following window will display:

Name, Mailbox, and Extension are “read only” fields that allow you to verify the mailbox 
you are editing. Complete the fields in this window using the following guidelines.

Time Control

Unless there is a special circumstance, leave this value as None. Time controls provide 
time-oriented call routing instructions (for example, route unanswered calls to an 
extension during the day and a mailbox at night). Refer to “Time Control Settings” on 
page 3-79 in this chapter for additional information. 

Operator

Enter a personal operator for the mailbox. If a caller presses 0 while in the mailbox, the 
call is transferred to the extension entered in this field. This setting overrides the 
system-wide operator setting.
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Cascade To

Message cascading is a feature that copies or moves messages left for the originating 
mailbox to another mailbox. To use message cascading, the originating mailbox’s COS 
must be configured to allow this feature (refer to “Message Cascading” on page 3-65).

Forwarding … Mailbox Restrictions

From the Forward Restrict List window, 
the Administrator can select which 
mailboxes ARE NOT allowed to forward 
voice messages to the mailbox indicated.

» After the Mailbox Settings option is 
selected for the desired subscriber, 
clicking the [Forwarding …] button will 
display a mailbox/extension list of 
100 entries.

» When the “Activate Forwarding 
Restrictions” box is checked, click the 
“Mark Selected” button, and then 
place a check next to each mailbox/
extension you want to limit forwarding privileges.

» Sort Option-- Depending on the column tab selected, you can sort the entries 
displayed by mailbox, extension, or name.

Mailbox Action

Play Greeting - This is the greeting that will be played when a call enters this mailbox. 
The drop-down list shows the various actions that the mailbox can perform after the 
greeting is played. These actions function as follows:

Take a Message Records the messages in the mailbox for later retrieval.

Forward to another Mailbox Sends the caller to an alternate mailbox where a message 
will be left.

The mailbox to which the caller was forwarded dictates 
which Notification and MWI settings apply.

Forward to Extension Sends the caller to an extension.

The mailbox to which the caller was forwarded dictates 
which Extension settings apply.

Forward to Menu Sends the call to a menu where further options may be 
provided to the caller. (Refer to “Menu Settings” on 
page 3-70.)

Forward to Time Control Causes PathFinder to execute the assigned time control and 
take the appropriate action. (Refer to “Time Control 
Settings” on page 3-79.)

Forward to Module Automatically runs another module when the mailbox is 
accessed. (For special applications only.)
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Notification

Notification refers to external numbers such as: cell phones.

Select the type of notification PathFinder is to use when a message has been left in the 
mailbox.

Notification options include the following: 

� No notification -- Disables external message notification. However, this option will 
light the desktop PBX phone.

� Immediate notification -- Sends notification immediately upon receiving messages.

� Timed notification -- Notifies the mailbox owner of new messages at a specific time.

� Urgent notification -- Notifies only when new messages are marked Urgent.

� Phone number -- Enter the phone number to dial for notification. (For example … 
480-443-6000 or 1-480-443-6000.) Do not enter dialing prefixes for outside line 
access such as “9”.

� Pager notification -- Select this checkbox if the notification number you have 
indicated is a pager.

� Record Greeting & Record Signature buttons -- Refer to Record Prompts, page 3-9.

Mailbox is Off Disables the mailbox’s ability to take messages.

This option plays the “Mailbox is off” prompt to the caller.

Mailbox is Full Plays a message to the mailbox owner stating: “the 
mailbox cannot record any new messages until old ones 
are deleted.”

This option plays the “Mailbox is full” prompt to the caller.

If you have an integrated system, do not set notification to call an internal extension, 
because the notification message could end up being left in the extension owner’s 
mailbox. This would cause PathFinder to send another notification message, creating a 
loop.
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Extension Settings

These Settings allow you to edit the actions taken when an extension number is dialed. 
To edit Extension Settings, click on Extension Settings from the Edit User’s Settings 
window. The Edit User’s Extension Settings window will display.

Name, Extension, and Mailbox are “read only” fields that allow you to verify you are 
editing the correct extension.

Time Control

Unless there is a special circumstance, leave this value as None. Time controls provide 
time-oriented call routing instructions (for example, route unanswered calls to an 
extension during the day and a mailbox at night). Refer to “Time Control Settings” on 
page 3-79 in this chapter for additional information. 

Actions

PathFinder provides three Action fields that determine how PathFinder process incoming 
calls. PathFinder refers to the three options in a cascading order. That is, the first field 
has precedence over the second, and the second field has precedence over the third.

EXAMPLE ACTION SCENARIO

1 - An incoming call is answered by PathFinder 

2 - PathFinder checks the first Action option for instructions on how to process the
call. The supervised transfer has been selected.

3 - PathFinder is instructed to perform a supervised transfer to the extension.

4 - The extension is busy. PathFinder pulls the call back from the extension. 

5 - PathFinder checks the second Action option for instructions on what to do next.
The option Forward to Voice Mail has been selected.

6 - PathFinder sends the call to the appropriate voice mailbox.

Number to dial

Number to dial

Action 1

Action 2

Action 3
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The fields associated with each Action field change to reflect the Action selected.

For example … if Forward to Extension is selected in the Action field, the field to the 
right of it changes to Extension to forward to. If the Action selection is set to 
Forward to Menu, the field changes to Menu to forward to and is used to enter the 
name of the menu to which calls are sent.

ACTION OPTIONS AVAILABLE

Blind Transfer -- An unsupervised transfer to the requested extension. Commonly used 
to free up voicemail ports, or with phones that are forwarded to another destination. 
Only one transfer type (Blind or Supervised) can be selected at a time. 

Supervised Transfer -- Allows PathFinder to monitor call transfers to determine whether 
the called extension is busy or not. If the call is not answered, PathFinder refers to the 
subsequent Action entries for instructions on processing the call.

Screen Caller -- When a person dials an extension through the Auto-Attendant, the 
Call Screening feature prompts the caller to state his name. PathFinder lets the called 
party hear this name before the call is actually transferred. The called party can 
either accept or reject the call. This option works only with Supervised Transfer. 

Holding Allowed -- Gives the caller the opportunity to hold when the called party is 
busy. This option works only with Supervised Transfer. The caller hears the following 
prompt: “I'm sorry, <extension name> is busy. If you would like to hold press 1. To 
try another extension or leave a message for this extension, press 2.”

Forward to Extension -- Forwards calls to the extension entered in the Extension field. 

Forward to Mailbox -- Forwards calls to the mailbox entered in the Mailbox field. This is 
frequently used when the mailbox owner does not have a physical extension. 

Forward to Menu -- Forwards calls to the specific menu entered in the Menu field.

Forward to Module -- Forwards calls to a custom script module (not currently used).

Forward to Time Control -- Runs the designated time control file and takes the actions 
designated for the current time. Refer to “Time Control Settings” on page 3-79.

COMPLETING THE ACTION FIELDS

After selecting the desired Action 1, complete any fields shown for Action 1.

» When Supervised Transfer is selected in the Action 1 field, the Action 2 field 
becomes active and can be edited. 

» When Action 1 is set at Supervised Transfer, and the transfer results in a busy or no 
answer situation, the setting in the Action 2 field specifies what should happen next.

You may conditionally invoke Action 2 when the following conditions exist after the 
Action 1 transfer:

» Do always -- The action always takes place. Only available for Action 2 and Action 3.

» Only on busy -- Instructs PathFinder to use this option if the transfer results in a busy 
signal. This option must be used in conjunction with the Only on no answer or Do 
always options. Only available for Action 2 and Action 3.

» Only on no answer -- Instructs PathFinder to use this option if the transferred call is 
not answered. Only available for Action 2 and Action 3.

You may also conditionally invoke Action 3 when the above conditions exist for the 
Action 2 transfer.
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Deleting Users

Users may be deleted individually or in 
ranges. Before PathFinder processes the 
Delete action, you will be able to “Backup” 
user messages and greetings if desired. 
The Backup User options are:

[Yes] to backup files
[No] to skip backup
[Cancel] to abort delete

If you select YES and the “MaintDeleteVox” 
registry parameter is set to “Yes”, 
PathFinder will copy the files for each user 
to be deleted into a separate directory 
under c:\PathFinder/Backups/nnn.

After a subscriber has been deleted, the 
corresponding mailbox/extension 
parameters and settings are erased. When 
the mailbox is deleted, all associated voice 
files are also deleted.

To Delete a User Mailbox -- When the 
Select User to Edit window displays, scroll 
through the list to highlight the user to 
delete and click SELECT. Once the user’s 
settings display, click DELETE USER. When 
the Backup User message displays, select 
YES, NO, or CANCEL.

To Delete a Range of Mailboxes -- Click 
on DELETE RANGE, and select the Start 
and End Mailbox or Extension from the 
appropriate pull-down menus. Then click 
on DELETE USER, the Backup User window 
will display the Backup options.
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Class of Service Settings

Each subscriber (or mailbox and extension pair) is associated with a COS that defines 
its attributes. Grouping mailboxes and extensions into classes of service lets you 
change options for all the mailboxes and extensions in the same class simultaneously, 
simply by editing the COS record.

This section instructs you how to create, edit, and delete a COS. Instructions are also 
provided for creating a COS template, which can come in handy if you are creating a 
number of COSs that are similar in definition.

Template Guidelines

If you are creating several classes of service, you probably have many parameters that 
are the same for each. Using a template class of service is a convenient way to create 
identical classes of service, each having the same settings. You can then select the COS 
when creating subsequent classes of service that should share these settings.

Creating a Class Of Service Template

1. Click on the COS icon … the Select 
COS to Edit window will display:

2. Then click on Create to access the 
Create Class Of Service window.

3. Enter a name for the COS template, 
using any combination of 
alphanumeric characters. Choose a 
name that describes the group of 
users in this COS.

4. When finished, click on Create to 
return to the Select COS to Edit 
window.

5. Highlight the new COS you created, 
and click on Select.

When the “Edit COS: BASIC” window 
displays, you can define the 
parameters for the COS template 
using the “Category to edit” options 
listed in the window.

For more details, refer to the page 
numbers shown …

Pg #

 3-55

 3-56

 3-58

 3-60

 3-61

 3-64

 3-67
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Navigating in COS Windows

Click on the Page controls at the bottom of the COS windows to move to the other 
class-of-service categories.

General Settings

Click on General in the Edit COS window to begin defining general options for the COS. 
The following window is displayed:

General COS - Field Definitions

Description Enter a brief description of the COS (up to 20 characters) to 
help identify it in other operations.

Time Control Calls are often processed differently in the evening, during the 
weekend, or on holidays than during regular business hours.

The time control function lets you define a set of alternative 
actions that PathFinder performs for a given time setting. Refer 
to “Time Control Settings” on page 3-79 for more information.

User Type There are 2 user types: 01 (Normal) and 99 (Administrator).

� The Normal user will only have access to their own mailbox 
and extension information.

� Administrators will have access to additional features such 
as: adding/deleting Subscribers, and recovering deleted 
messages.

1

advances to advances to
previous menu next menu

moves to moves to
last pagefirst page
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Greeting Settings

Click on the Greeting button in the COS Edit window to begin defining greeting options 
for the COS. The following window is displayed:

COS Voice Mail Greeting - Field Definitions

Event Counters This “Reports” parameter provides an overview of how 
PathFinder is used.

� Select the Callers check box if you want to maintain a count 
of mailbox/extension access by callers (non-owners).

� Select Owners if you want to maintain a count of mailbox/
extension maintenance accesses by the mailbox owner.

Language Mailbox and extension prompts can be played in an alternate 
language. This parameter defines what language prompts will 
be used for each subscriber.

For example … when an owner accesses their mailbox, a prompt 
tells the subscriber how many messages are in the mailbox. 
This parameter defines the language for such prompts.

Languages other than English are optional modules and must be 
purchased separately.

Restrict OutDial to You can use this field to disable long distance dialing from the 
extension or from mailbox notification by entering the number 
of digits required for local calls (typically 7 or 10).

This setting determines how many digits PathFinder can outdial 
for notification or from an extension.

» This will also affect the Locator and E-mail Reading features.

Greeting Type Select from the following types of pre-recorded messages, or 
prompts, to be used when greeting a caller.

Personal The Personal greeting option plays a greeting recorded by the 
mailbox owner.

If the owner does not record a personal greeting, the System 
(default) greeting is used.
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System The System greeting is a generic message used when no personal 
greeting has been recorded.

If both the Personal and System greetings are activated, PathFinder 
plays the personal greeting when one has been recorded.

System Add-on The System Add-on is a smaller version of the System (default) 
greeting that follows a personal greeting.

This greeting plays, “Begin recording at the tone. To stop recording, 
press any key … ” and so on, whereas the regular System greeting 
plays, “The person you have tried to reach is unavailable. Begin 
recording … ” and so on.

Class of Service The Class of Service greeting plays a single greeting for all 
mailboxes that share the same COS.

This is done to conserve disk space by eliminating the need for each 
mailbox to have its own greeting prompt. 

For example … Com-Tel Corporation has a COS called SUPRT for all 
technical support staff.

The COS greeting file SUPRT.GRT might sound like this: “The 
technical support representative you are trying to reach at Com-Tel 
Corporation is not available. Please leave a message at the tone.”

Only one COS greeting can be recorded for each COS. Its file is 
stored in the \PATHFINDER\VOX directory.

By default, the greeting file is called <COS Name>.GRT, where <COS 
Name> is the name given to the COS and .GRT is the COS greeting 
identifier file extension.

Voice Insert A Voice Insert greeting plays a COS prefix prompt followed by a 
name prompt, which in turn is followed by COS postfix prompt. This 
is often done to personalize a COS greeting while limiting the 
amount of disk space used.

For example … Com-Tel Corp. set up a COS for all sales people called 
SALES. The COS prefix file SALES.VI1, name prompt, and postfix file 
SALES.VI2, might sound like this: “Thank you for calling the Com-Tel 
Corp. sales department. (Sam Smith) is not available. Please leave a 
message after the tone.”

Only one COS prefix and postfix prompt can be recorded for any 
specific COS.

These files are stored in the \PATHFINDER\VOX sub directory.

� By default, the prefix file is called <COS Name>.VI1, where 
<COS Name> is the eight-character name given to the COS and
.VI1 is the identifier for the first part of the voice insert greeting.

� The suffix file is called <COS Name>.VI2, where <COS Name> is 
the eight-character name given to the COS and .VI2 is the 
identifier for the second portion of the voice insert greeting.

Greeting Length Enter the maximum length, in seconds, for personal mailbox 
greetings created by users assigned to this COS. Maximum value for 
this field is 999.
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Message Types Settings

Click on Message Types in the Edit COS window to begin defining message type 
options for the COS. The following window is displayed:

COS Voice Mail Message - Definitions

Park and Page This setting must be enabled in each COS to allow Park and Page to 
be used by a caller placed in a mailbox.

Once this feature is turned on, callers listening to a mailbox greeting 
can press the "7" key to start the Park and Page process.

NOTE … To inform the caller of this Park and Page option, each user 
must change their mailbox greeting(s) to include this information.

Message Type PathFinder mailboxes can be used to store a variety of 
messages. Select the types of messages to be allowed in 
mailboxes for this COS.

A single mailbox can store any combination of message types.

If more than one type of message is selected, specify one as 
the default. This setting applies only to inbound messages, not 
to the notification type. The types of messages that are allowed 
are as follows:

Voice Callers can record voice messages, and the mailbox owner can 
listen to recorded voice messages.
PathFinder - System Administration December, 2003 - Issue 4.5



Edit Options 3-59

Chapter 3 - MAINT Application
Page A caller can enter DTMF digits. The mailbox owner can listen to 
the DTMF digits converted to regular speech, or the DTMF digits 
can be displayed on a pager. For example:

For example … a caller leaves a page message of 5557890.

� If the subscriber tries to retrieve this message, PathFinder 
plays: “Five, five, five, seven, eight, nine, zero.”

� If a subscriber has a pager for notification of new messages 
(and is not using a notification command file), PathFinder 
sends the DTMF digits to the paging company and the 
mailbox owner is notified on the pager rather than via the 
voice mailbox.

Fax A caller can leave a fax directly in a subscriber’s mailbox. In 
order to retrieve a fax message, a subscriber must send it to a 
fax machine for printing. PathFinder must have fax ports in 
order to receive fax messages. 

If using OneLook Unified Messaging … messages can be 
delivered to the Subscriber’s Desktop E-mail Client.

E-mail If the Software Key is enabled for Text-To-Speech, this option 
will allow these Subscribers to receive e-mail messages for TTS 
E-Mail Reading. If this function is not enabled, the Subscriber 
will not have access to their e-mail messages.

Message Type Menu Select this option if you want PathFinder to present the caller 
with a menu such as: “To leave a voice message, press 1; To 
send a fax, press 2.” Leave this option off if mailbox owners are 
offering access to different message type options in their 
individual mailbox greetings. 

Message Length This option determines the amount of time allocated to a 
message. After the specified number of seconds has elapsed, 
the caller is presented with the normal Send menu as if the 
caller had pressed a key to stop recording. Max = 9999 secs

Message Count This option determines the maximum number of messages that 
can be stored in a mailbox. When the number of messages in a 
mailbox exceeds this parameter, the mailbox plays a Full 
message. No further messages are accepted until the number 
of messages in the mailbox is reduced. A maximum of fifty 
messages is recommended. Max = 99 msgs

Message Retention PathFinder can automatically delete messages that have been 
stored for a specified amount of time. Thirty days is the 
recommended default retention period. The maximum value for 
this field is 999.

Record Key Leave this off if you want PathFinder to automatically begin 
recording a voice message. When this is turned on, the caller 
must first press a key to start recording.
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Mailbox Caller Settings

Mailbox caller options are choices given to a caller when leaving a message. These 
options are available only after the caller presses a key to terminate recording a 
message.

Click on Mailbox Caller in the Edit COS window to begin defining mailbox caller options 
for the COS. The “Edit COS: Voice Mail Caller” window will display:

COS Voice Mail Caller - Definitions

Record Stop Key Select this option to activate the one-key urgent message send 
feature.

With this option turned on, if an outside caller presses 8 to end 
the voice message recording, the message is marked as 
urgent, sent, and the caller proceeds to Last Options.

Caller Record Options If this option is selected and the caller presses a key after 
leaving a voice message, the caller hears the following options:

Press 1 to send the message

Press 2 to play the message

Press 3 to cancel

Press 4 to append the message

Press 5 to re-record the message

Caller Send Options Select Urgent, Confidential, or both if you want callers to be 
able to specify those options for the messages they leave. 

� Urgent messages are preceded by an Urgent prompt and 
are played as the first of a group of messages. 

� Confidential messages cannot be forwarded.
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Mailbox Owner Settings

Mailbox owner options determine the modifications individual subscribers can make to 
their personal mailboxes. Click on Mailbox Owner in the Edit COS window to begin 
defining mailbox owner options for the COS. The following window is displayed:

COS Voice Mail Owner - Field Definitions

Last Options Select according to what you want PathFinder to do once the 
caller has left a message.

� If set to On, PathFinder’s default menu options are played.

� If set to Off, PathFinder says, Thank you and hangs up.

Setting this to Off limits a caller’s ability to navigate PathFinder.

Last Options Menu This determines what menu PathFinder plays if Last Options is 
set to Menu (see above). For more information on menus, 
refer to “Menu Settings” on page 3-70.

First Time Help Check this option if you want each new subscriber 
prompted to record such essential parameters as a 
greeting, a mailbox name, and a password.
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Message Date Time PathFinder can announce the date and time that a 
message was received at the beginning of a message. 

� Select Auto-play to have the date and time 
announced automatically at the beginning of every 
played message. If you leave this option off, the 
subscriber must press 8 at the end of the message 
to check the date and time.

� Select Play entire date to have the month, date, 
and time included in every date announcement. If 
you leave this set to off, for messages received 
today, only the time is repeated; messages received 
yesterday include the word “yesterday” and the 
time; messages received during the current week 
include the day of the week (e.g., Wednesday) and 
the time. Messages received more than a week 
earlier include the month and date of the message 
as well as the time it was received.

Oldest Message First If this option is selected, messages are played in 
chronological order, starting with the oldest message in 
the mailbox. If this is left off, the newest message in the 
mailbox is played first when a subscriber checks the 
mailbox, with remaining messages played in the reverse 
of order received. Subscribers typically prefer that this 
option be left off.

Owner Play Options Mailbox owners can be given several options for 
processing played messages, making mailbox 
management as simple or as sophisticated as desired. 
Detailed instructions on using these options are 
included in the PathFinder User's Manual and on the 
Quick Reference Card. The following options are 
available.

Save Msgs [2] Allows subscribers to save messages for later retrieval.

Confirm Deletes

[3 + #]

Requires subscribers to press the [#] key after pressing 
[3] to delete a message, as a safeguard against 
accidental deletion.

Forward Msgs [4] Allows subscribers to forward messages to other 
mailboxes or to an outside number.

Reply To Msgs [5] Allows subscribers to press [5] while listening to a 
message and reply to the message.

Dial Source [6 + 0] Allows the subscriber to connect to the person 
responsible for sending the message. This can also 
include outside numbers if the originating phone 
number is known (digital only).

Skip Message [6 + 3] Allows subscribers to skip messages by pressing [6] and 
[3] while listening to a message.

Owner Send Options These parameters determine the functions available to 
subscribers when sending messages. Detailed 
instructions on using these options are included in the 
PathFinder User's Manual and on the Quick Reference 
Card. The following options are available.
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Not Allowed Used for creating simple mailboxes to which none of the 
following options can apply.

Urgent Allows the subscriber to assign urgent status to a 
message. Urgent messages are preceded by an Urgent 
prompt and are played as the first of a group of 
messages.

Confidential Allows the subscriber to specify that a message cannot 
be forwarded.

Future Send Allows delivery of messages at a future time and date.

Outside Numbers Allows the subscriber to send a message to an outside 
number.

System Lists Allows the subscriber to send messages to a system-
wide list (the list is maintained by the administrator).

Confirmation Enables the subscriber to request receipt information 
for a marked massage, so PathFinder notifies the sender 
when a message has been heard.

Owner Edit Options These parameters determine the mailbox customization 
available to subscribers within this COS. Detailed 
instructions on using these options are included in the 
PathFinder User Guide and the Quick Reference Card. 
The following options are available.

Password Enables the mailbox owner to change the mailbox 
password. This is typically turned off when a mailbox is 
for temporary use, as with hotel guests.

Greeting Allows mailbox owners to edit their own greetings; this 
option typically is enabled.

Name Allows the owner to change the mailbox name, which is 
used in prompts associated with the mailbox.

Notification Allows the owner to change such notification settings as 
the extension or phone number to call, and the time of 
notification (such as for a pager).

Mailbox State Allows the owner to turn the mailbox off, set it to 
greeting only, forward calls to an extension, forward 
calls to a mailbox, or forward calls to menu. Typically 
this is not allowed as it may cause system problems.

Personal Lists Allows the subscriber to create up to ten personal 
distribution lists, and maintain them over the telephone.

Guest Mailboxes Allows the owner to communicate with a guest who 
does not have a mailbox on PathFinder.

Auto-Attendant Allows the mailbox owner to edit extension settings.

Note Pad Grants the mailbox owner access to a personal voice 
note pad. The voice note pad is similar to a note pad 
referenced with an index. The index can be any eight-
digit number with an associated voice file. 
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Notification Settings

PathFinder has a variety of notification options that are used to tell mailbox owners when 
they have received a new message. Click on Notification in the Edit COS window to 
display these options. The following window is displayed:

COS Voice Mail Notification - Definitions

Transfer Out Allows the mailbox owner to transfer to other 
extensions or mailboxes. This option should be turned 
off in a service bureau application or when the Auto-
Attendant is not used.

Delete Unheard Allows the mailbox owner to pull back messages that 
were sent to another local mailbox. PathFinder prompts 
the owner for the destination mailbox, and then check 
to determine if any unheard messages from the owner 
are still in the mailbox. PathFinder plays each message 
and allows the owner to selectively delete them. 

Message Waiting PathFinder can send message waiting commands to 
telephone systems that support message waiting 
indicators or similar notification devices. 

Off PathFinder does not send message waiting to an ancillary 
device such as a pager or telephone.

On Urgent Only

Leave As New
Save Message
Delete Message
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On: First Message PathFinder sends message waiting indicators only when the 
first message is received.

On: Every Message PathFinder sends a message waiting indicator for each new 
message received by the subscriber.

MWI Strings Normally, a phone system defines the Message Waiting 
Indicator strings by the length of the extension in MWI/
Notification.

On some phone systems, it is necessary to define MWI 
strings on a per COS basis. The COS message MWI string 
settings take precedence over the system COS. Default 
MWI settings are defined in the Configuration menu.

Refer to “MWI/Notification” on page 3-28.

Event Handler Group The Event Handler facility is used to program PathFinder’s 
notification lines. The default Event Handler Group is 5. 
For notification to work, at least one of the phone lines 
must be assigned an event handler. Refer to “Setting Up 
Phone Lines” on page 3-85 to complete configuration of 
the event handler.

Voice Notify Options These options apply when PathFinder plays messages to 
the caller during notification. Refer to Appendix A for 
more information on how to configure PathFinder to play 
messages to the caller during notification.

Password Required To force the owner to enter a password to retrieve 
messages.

Msg Pickup Allowed To allow message retrieval without password entry.

NOTE … Allowing message pick up without a password 
can undermine the privacy/security of the mailbox.

Message Cascading This powerful option gives PathFinder great flexibility in 
delivering a message. Any incoming message, depending 
on the cascade setting, can be copied or forwarded to 
other mailboxes.

NOTE … Refer to “Cascade To” on page 3-49 for more 
information about configuring cascading options.

When Message Cascading is activated, either the message 
itself or a copy of the message also automatically 
“cascades” to another mailbox. Refer to “Original 
Message” on page 3-66 for selecting options to decide 
what happens to the original message in the primary 
mailbox.

Off To turn off the Message Cascading option.

Immediate To cause cascading to begin immediately, allowing the 
message to be copied or forwarded to another mailbox.

For example … if the Message Cascading option is set to 
Immediate notification, then the following process occurs:

� Mailbox gets a message wait.

� Notification is activated.

� Message immediately cascades to another Mailbox.
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When Notify Fails To allow the message to be copied or forwarded to 
another mailbox or other mailboxes only when the 
notification has failed and a mailbox owner has not 
retrieved the message.

For example … if the Message Cascading option is set to 
When Notify Fails, then the following process occurs:

� A mailbox gets a message wait. 

� Notification is activated: the complete notification 
takes 30 minutes.

� If the owner of the Mailbox does not save or delete the 
message within 30 minutes, the message will cascade 
to another Mailbox. 

On Urgent Only Check box to activate either When Notify Fails or 
Immediate cascading only for messages marked Urgent.

Original Message These options are available when Message Cascading is 
set to Immediate or When Notify Fails. 

Leave as New Leaves the original message as a new message in the 
original mailbox. Remember that all new messages in the 
original mailbox will be cascaded.

For example … 

� Subscriber receives a new message at 9:00 a.m., and 
that message is cascaded.

� Mailbox owner does not save or delete the message.

� Subscriber receives a new message at 4:00 p.m. 

� Both new messages will be cascaded.

Save Message To cause the message to be saved in the original mailbox 
once the forwarding is completed.

Delete Message To cause the original message to be deleted from the 
original mailbox once the forwarding is completed.

Notification This option determines the time interval between each 
notification attempt until the owner retrieves message.

mins (time interval) The time is measured in minutes, with a maximum 
interval of 999 minutes.

attempts (notify retries) This parameter determines how many times PathFinder 
attempts to notify a mailbox owner after receiving a new 
message. The maximum number of attempts is 99.

Retry Pager This option only applies to pager notifications. It allows 
notifications to a pager to be repeated if PathFinder detects 
a busy or no answer when calling a paging company. In 
other words, if PathFinder detects a busy or no answer, 
PathFinder does not consider that an attempt to notify the 
paging company has been made and retries later.

Notify Script Notify script is a command file if notification is active. This 
powerful feature allows complex notification scripts to be 
created on a per COS basis. This option can only be used 
if a notification script has already been written. Refer to 
Appendix A for creating notification scripts.
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Auto-Attendant Settings

These options determine the handling of several automated operations with PathFinder. 

Click on Auto-Attendant in the Edit COS window to display these options. The 
following window is displayed:

COS Automated Attendant - Definitions

Call Options Call options describe what extension settings the subscriber can 
change via their mailbox. Typically, these options should be 
disabled as the subscriber could significantly alter the behavior 
of their mailbox and extension settings.

Blind Transfer To allow unsupervised call transfer where PathFinder forwards the 
call to the requested extension. This option is commonly used 
with hunt groups.
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Supervised Transfer If you want PathFinder to monitor the transfer to determine 
whether the called extension is busy or is not being answered.

If you select Supervised Transfer, you can check either or both of 
the following:

� Screening -- When a caller dials an extension, Call Screening 
prompts for a name. This information is given to the called 
party before the call is actually transferred. The called party 
can either accept or reject the call.

� Holding -- This allows the caller to hold if the called party is 
busy. PathFinder plays: “I'm sorry, <subscriber's name> is 
busy. If you would like to hold, press 1. To try another 
extension or leave a message for this extension, press 2.”

Extended Options This option provides the mailbox owner with more control over 
the forwarding of the mailbox and extension. Without this option 
on, the owner can only modify extension settings. With this 
option on, the owner can specify a destination mailbox or 
extension.

Desktop Call Control This Optional Module setting enables the DCC Subscriber (Client) 
feature to receive and answer calls on their PC desktop.

Hold Type This setting determines what callers hear if an extension is busy 
and they elect to be put on hold. 

Silence Keeps the call connected, but the caller hears nothing while on 
hold.

Dial Hold Sequence Causes PathFinder to execute a flash-hook when the caller is 
placed on hold (if provided by the phone system, the flash-hook 
activates music-on-hold).

Play Hold Files If set to, the caller hears recorded messages prepared for 
PathFinder. Up to nine hold files can be recorded. Hold files are 
saved in the VOX subdirectory, and have the following naming 
convention:

� PATHFINDER\VOX\AAHOLD.0

� PATHFINDER\VOX\AAHOLD.1

� PATHFINDER\VOX\AAHOLD.2

Hold Interval This setting determines how long PathFinder waits before retrying 
a busy extension. For example … if PathFinder attempts to ring a 
busy extension, and if the hold interval is set to ten seconds, it 
retries the extension every ten seconds until a connection is 
made or until the retry limit is reached. The time is measured in 
seconds, with a maximum interval of 999 seconds.

Call Queuing This option allows multiple calls to be placed on hold for a single 
extension. Turning on call queueing causes PathFinder to hold the 
calls in a queue until they are answered. Queued calls are 
answered in the order received. Refer to “Auto-Attendant” on 
page 3-18 for more information on Call Queue Intervals.

CAUTION -- When option is enabled, each queued voicemail port 
is considered busy and will be unable to answer another call.

Call Holding must be enabled in the subscriber’s Extension 
settings for Call Queueing to function properly. Refer to 
“Extension Settings” on page 3-51 for more information.
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Creating a COS

A class of service provides an easy way to modify an entire group of mailboxes or 
extensions. By supporting multiple COSs, PathFinder provides you the ability to provide 
subscribers with options to features on an as-needed basis.

To create a new COS:

1. Click on the COS icon.

2. When the Select COS to Edit window 
displays, click on Create.

3. If you are using a template COS, 
select the template from the drop-
down list.

4. Enter a name for the COS (up to 20 
characters), using any combination of 
alphanumeric characters. The name 
should describe the group of users in 
this COS. 

5. Click on Create to return to the 
Select COS to Edit window.

6. Highlight the COS you created, and click on Select. The Edit COS window is 
displayed, from which you can begin defining the COS.

Screen Length This option determines the amount of time by which a caller 
must respond with a name when prompted to do so through Call 
Screening. The time is measured in seconds, with a maximum 
value of 999 seconds.

Play Call Source Activating this option means that if a message is left in a mailbox 
to which an extension was forwarded, the originally dialed 
extension is identified at the start of the message with a prompt 
(e.g., “Message from John Smith,” if the call was originally 
intended for John Smith’s extension, which was forwarded to the 
extension from which the message is retrieved). 

Transfer Strings Default transfer strings are typically configured in the telephony 
settings. Refer to “Transfer Settings” on page 3-34 for more 
information. Any setting configured here overrides the default 
configuration. Configure the transfer prefix and postfix for any 
subscriber using this class of service.
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7. Edit the parameters for this COS. 
There are seven edit categories, listed 
at the left of this window. Once you 
have selected a category, you can 
reach another by clicking on the page 
controls that display at the bottom of 
the window.

Modifying a COS

If you need to make adjustments to the 
COS you’ve defined, follow these steps:

1. Start up PathFinder MAINT.

2. Click on the COS button on the 
toolbar.

3. Highlight the COS to modify, then 
click on Select.

4. Click on the button that corresponds to the category of function to be changed. If 
you need to move from one category to the next, use the page controls that appear 
at the bottom of the window after you select a category.

Deleting a COS

To delete a COS entirely, perform the following steps:

1. Start up PathFinder MAINT.

2. Click on COS on the toolbar.

3. Highlight the COS to delete, then click on Delete.

Menu Settings

The MAINT application allows you to configure PathFinder. This section describes the 
menu functions available through the Edit menu in MAINT.

PathFinder provides sophisticated multi-level menuing capabilities that can be used to 
direct users and callers to information, assist them in performing tasks, and guide them 
in their use of PathFinder.

Menus combine other modules and features to create sophisticated call processing 
applications. Before going into a detailed description of the menu module, two terms 
must be defined:

� Menu: A list of actions executed through touch-tone keys. For example, “Press 1 for 
sales. 2 for support. 3 for administration....” A menu can invoke up to fourteen 
actions, with each action corresponding to a key on a standard telephone keypad 
(including * and #), plus two actions as defaults.

� Action: An instruction that is selected from the Menu Action List. It tells PathFinder 
how to respond when a specific key is pressed. An action can invoke another module 
(transfer a call to an extension through the Auto-Attendant) or perform a special 
feature (play a prerecorded message).

Before setting up complicated, multi-level menus, read through this section. It is 
important that you understand the mechanics of building a menu before you begin.
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Designing a Menu

A good way to begin creating a menu is to draft it on paper. Initially, ideas may not 
seem sufficiently organized to warrant flow charting; if this is the case, just jot them 
down. Don't worry about the specific order of menu items at this stage; it is more 
important to get all the ideas down so that alternatives won't be forgotten. Once this is 
done, begin the process of building a menu flowchart.

Menu Flowchart

The flowchart below illustrates the design of a typical multi-level menu. As you create 
your own menu, you should include as much detail as possible to avoid menu conflicts.

Once you have generated a flowchart, you are ready to begin creating your menus.

Figure 3-28: Sample Flow Chart for Menu Design

“Thank you for calling the ABC Communications Company.

Please press . . . “

2 3 4

32

“For sales 
information.”

“For tech 
support.”

“If you know the 
extension of the 
party you are 
trying to reach.”

“Thank you for 
contacting the 
sales department. 
Please press . . . “

“for the
Eastern region .”

“ for the
Western region.”

…transfers to the 
Technical Support 

Hunt Group.
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A menu must be created before you can add commands to it or make changes to it. To 
work with menus, click on Menu on the tool bar. The following window displays:

From here, you can create a menu, delete a menu, or select a menu to edit.

Creating a Menu

To create a menu, perform the following steps:

1. In the Select Menu to Edit window, click on Create. The following window will 
display:

2. Enter a name for the menu, up to eight characters such as: Day or Night.

� A Day Menu will usually transfer to a digital station.

� A Night Menu will usually transfer directly into a mailbox.

� By default, Menus 100-119 are pre-defined as “Day”, 120-139 are “Night”.

3. Click the Template field’s drop-down list to select a template menu upon which the 
new menu can be based.

For example … menu 100 already exists and you want to create a new menu called 
200 which is similar to menu 100. You can select 100 as the template menu, or 
leave the Template field blank and no key actions will be defined.

4. Click on Create Menu to return to the Select Menu to Edit window, highlight the 
new menu name, and click on Select to move to the Edit Menu window.
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Deleting a Menu

To delete an old or unneeded menu:

1. In the Select Menu to Edit window, highlight the menu to remove.

2. Click on Delete, then click on OK when the confirmation prompt is displayed.

Editing a Menu

The Edit Menu function is used to edit both new and existing menus. 

To edit a menu, perform the following steps:

1. In the Select Menu to Edit window, highlight the desired menu, then click on Select. 
The “Edit” window for the menu selected will display:

Figure 3-29: Edit Menu (100) Window

2. Configure the edit menu fields and options as described in the following table:

Prompts that are associated with the deleted menu remain on PathFinder so that other 
menus can use them. The PathFinder clean-up procedures will delete unused prompts.
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Edit Menu - Field Definitions

General The General settings describe the basic control functions for 
accessing a mailbox or extension.

Description Enter a brief description of the menu’s function to remind you of its 
purpose. For example … “Sales Main Menu”.

Time Control Calls are often processed differently in the evening, during the 
weekend, or on holidays than they are processed during regular 
business hours.

� The time control function lets you define a set of alternative 
actions that PathFinder performs for calls during defined time 
periods. Refer to “Time Control Settings” on page 3-79.

� If you do not intend to use time controls, set this value to None. 
Use caution when configuring this option, as it may cause 
unexpected behavior.

Password Specify a password to protect online recording actions. It will be 
required when a caller accesses the Record Prompts action.

Time Out Specify the length of time after which, if the caller presses the no key, 
the specified action is to run.

Retries Specify the number of times a caller can initiate an invalid option. If 
the caller initiates more than the maximum number of allowed invalid 
options, the Max Retries key action is taken. The maximum value 
for this field is 999.

Voice Prompts The voice prompts settings describe information played for callers to 
assist them in deciding which keys to press.

� Menu prompts may be recorded as a single message,

-or-
they can be divided into 3 sections that will be played in the 
following order: Introduction, Body, then Instructions.

� If no voice prompt is defined, PathFinder plays the next prompt in 
the sequence.

� To the caller, the sequential voice prompts play as a single prompt.

Introduction Type or select the prompt file to be played first.

Typically, only the first menu accessed for a caller plays an 
Introduction prompt. 

For example … “Thank you for calling ABC Communications.”

Body Type or select the prompt file to be played after the introduction 
prompt. This prompt is not used in most menus.

For example … “ABC Communications is a company that specializes in 
high-tech telephone systems … ”

Instructions Type or select the prompt file to be played after the body prompt (if 
there is one).

The instructions prompt should contain information the caller needs 
to decide which keys to press.

For example … “For sales, press 1; for support, press 2 … ” and so on.
PathFinder - System Administration December, 2003 - Issue 4.5



Edit Options 3-75

Chapter 3 - MAINT Application
Temporary 
Introduction 
Active

This option allows the System Administrator to call into the PathFinder 
system, from a remote location, to activate and record a temporary 
introduction greeting when needed (snow days, emergencies, etc.).

� If the Record Prompts key is part of the menu, you will be able 
to enable or modify a temporary greeting for the menu selected.

� In the MAINT / Edit Menu window for the specified menu, you will 
see the “TEMPORARY.VOX” entry in the Voice Prompts - 
Introduction field until you decide it is no longer needed.

The Temporary Greeting options are:

To edit introduction, press 1.
To edit main greeting, press 2.
To edit instructions, press 3.
To edit temporary greeting, press 4. This option will play the 
following prompts, based on your selection:

To hear greeting, press 1.
To re-record greeting, press 2.
To erase, press 3.
To activate greeting, press 4.
To deactivate to greeting, press 5.
To go back, press #.

( . . . ) The “Ellipses” buttons display a list of all user-recorded prompts. This 
allows you to select a pre-recorded prompt.

Actions Key actions determine the response invoked when a specific key is 
pressed. Each dial-pad key has an accompanying key action field.

Clicking any Key Action button displays the list of options. When you 
select an option, further options display in the right side of the 
window, when appropriate.

* Key

# Key

0 Key

1 Key

2 Key

3 Key

4 Key

5 Key

6 Key

7 Key

8 Key

9 Key

Play Instructions

Mailbox

Operator

Extension START

Extension START

Extension START

Company Directory Aa

Company Directory Vm

Invalid Option

Mailbox

Record Prompt

Hang Up

(Each KEY Action is defined below …)

The Max Retries setting indicates what happens when the caller 
presses an invalid key one time more than the retries setting.

The Time-Out field indicates what happens when the caller does not 
press any keys before the time-out period elapses.
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Key Action Definitions

Define key actions in the Edit Menu window by clicking the corresponding Key Action 
button. Fields in the resulting window can be configured as described in the following 
tables.

Mailbox Action Commands

These key actions will send the caller to a specific mailbox.

Ask for Mailbox PathFinder prompts the caller to enter a mailbox number. For 
example, if the 1 Key is set to Ask for Mailbox, then callers press 
1, they hear, “Enter the mailbox number of the person you are 
trying to reach. Press zero for the operator. Press the star key for 
the directory.”

Start Key The first digit of the mailbox you are trying to access. For example, 
if the 2 Key is set to Start Key, then when the caller presses 2, 
they will not hear a prompt, and the system will wait for more 
digits.

NOTE -- If you assign 2 as the mailbox Start Key, then you must 
have mailbox numbers that start with the digit 2.

Specific Mailbox 
Number

The caller is transferred directly to the mailbox indicated. For 
example, if the 3 Key is set to send to Specific Mailbox Number, 
then when callers press 3, they are transferred directly to that 
mailbox.
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Extension Action Commands

These key actions will send the caller to a specific extension.

Ask for Extension PathFinder prompts the caller to enter an extension number. For 
example, if the 1 Key is set to Ask for Extension, then callers 
press 1, they hear “Enter the extension number of the person 
you are trying to reach. Press zero for the operator. Press the 
star key for the directory.”

Start Key The first digit of the extension you are trying to access. For 
example, if the 2 Key is set to Start Key, then when the caller 
presses 2, they will not hear a prompt and the system will wait 
for more digits.

If you assign 2 as the extension Start Key, then you must have 
extension numbers that start with the digit 2.

Specific Extension 
Number

The caller is transferred directly to the extension indicated. For 
example, if the 3 Key is set to send to Specific Extension 
Number 123, then when callers press 3, they are transferred 
directly to extension 123.

Menu Executes the selected menu.

Owner Access Gives access to mailbox owner menus. This is used with in-band 
integration or to provide access through a hidden key on a 
menu. The caller will enter this key followed by their mailbox 
number.

Run Module Runs other modules that PathFinder supports.

Time Control Enter the time control to run. This option takes actions based 
on time, date, and day of week settings. Refer to “Time Control 
Settings” on page 3-79 for more information on time controls.

Command File Runs the command file script. Refer to Appendix A for additional 
information on command files.

Company Directory Provides a company directory listing, for either mailboxes or 
extensions.

Fax On Demand Refer to the Fax-related sections of the Optional Modules 
manual for more information on this option. Fax modules are 
optional and are sold separately. If enabled, the following 
choices are available:

� May be left blank to have the caller select fax documents

� May contain a document number

� May contain ADMIN to allow the caller to access fax-on-
demand administrative functions

Homework Hotline Homework Hotline is part of the “optional” ChalkTalk application 
that allows teachers to record school assignments. When 
activated, students and parents can call in and listen to the 
assignments. For more details, refer to the “Homework 
Assignments” on page 2-27 in the Optional Modules manual.

Q-A Q-A is part of the “optional” ChalkTalk application that allows an 
administrator to design Questionnaires using the QA Admin 
program. Refer to “Questionnaires” on page 2-31 in the 
Optional Modules manual for more information.
PathFinder - System Administration December, 2003 - Issue 4.5



3-78 Edit Options

Chapter 3 - MAINT Application
Run ActiveVex Runs an ActiveVex module such as: AvDCC.run for Desktop Call 
Control or AVOutDial.main for ChalkTalk.

Operator Transfers caller to the General Operator. Refer to “Operators” 
on page 3-14 for more information on Operator settings.

Invalid Option Plays the message “Invalid option” and repeats the instructions.

Disabled Key Pressing a key with this action has no affect at all. It is as if the 
key were never pressed.

Play Prompt Plays the indicated voice prompt file. Alternatively, you can 
select a prompt based on its directory location (directory 
number listed below) and the specific file name, such as 
4:help.vox. The available directories include:

1: Modules 4: VOX 7: dBase

2: Prompts 5: Mailbox 10: Data

3: Messages 6: Menus 20: Data

For example, to have PathFinder play the mailbox greeting for 
mailbox 345, type 3:345.GRS as the prompt name.

Play Instructions Replays the instructions prompt, such as, “To hear this menu 
again press...”. Only the instruction prompt associated with the 
menu is played.

Record Prompts Allows a caller to re-record prompts for a menu. The caller, after 
pressing the key associated with this action, is prompted for the 
menu password. The Introduction, Body, Instructions, or any 
play prompt file attached to a particular key can then be 
recorded or edited.

Change Language Changes the prompt files for those recorded in the selected 
language. Only languages you have purchased are available.

Hang Up Plays the hang up message “Thank you for calling” prior to 
disconnecting the caller. For example, a menu might include this 
option at the end of a list, “Press 1 for sales, 2 for support, # to 
return to the previous menu, and 9 to hang up”. If the caller 
presses 9, the hang up message plays.

Max Retries This field determines the number of incorrect attempts that 
callers are given when entering key presses.

Time-Out The amount of time the caller has in which to enter a response 
after all menu prompts have been played. PathFinder executes 
the Time-Out action once this time limit has been exceeded. 5 
seconds is usually sufficient. The max value for this field is 999.
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Time Control Settings

The MAINT application allows you to configure PathFinder. This section describes the 
time control functions available through the Edit menu in MAINT. Time controls are 
settings that allow PathFinder to activate or disable extension and mailbox features 
depending on date, day, and/or time settings. 

Time controls can be used to route calls, send callers to voice mail, and play menus, 
among other things based on time and day settings.

� Up to ten distinct time periods can be defined within a time controls setting, 
allowing you to make a time control as simple or as complex as needed. 

� Time Controls are searched sequentially, beginning with the first defined action. 
When an action is proven to be true, it is executed, otherwise the next rule is 
searched and verified.

� Time control searches by date, then by day, then by time. 

� Time controls can be chained together to allow more than ten day/time options. 

� You can use the time control function to create a new control, and edit or delete an 
existing control.

Setting Up Time Control Parameters

To work with time controls, click on the Edit Time Control Records icon on the 
toolbar. The following window displays:

Creating a Template Time Control

If you are creating multiple time controls with similar settings, the use of a template 
time control is helpful. The template time control is a time control with the basic 
settings defined and is copied when creating new time controls. Typically, you would 
use the 8-5 time control as the template time control.

However, if you would like to create a specific template time control, perform the 
following steps:

1. In the Select Time Control to Edit window, click on Create. This displays the Create 
Time Control window.

2. Enter a name of up to eight characters in the Time Control Name field. 

3. Click on Create to return to the Select Time Control to Edit window. 

4. Edit the new template time control; refer to “Editing a Time Control” on page 3-80.
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Creating a Time Control

A time control must be created before it can be edited. Creating a time control is the 
process of assigning the time control a name and entering a description.

To create a new time control, perform the following steps.

1. In the Select Time Control to Edit window, click on Create. The following window 
displays:

2. Enter a name of up to eight characters in the Time Control Name field.

3. If you want to use an existing time control as a template for the one you’re creating, 
select it from the Template Time Control pull-down list. If no template is selected, 
the Time Control will be blank.

4. Click on Create to return to the Select Time Control to Edit window. 

Editing a Time Control

The edit time control function is used to edit both new and existing time controls. If the 
Select Time Control to Edit window is not displayed, click on the Edit Time Control 
Records icon on the toolbar. To edit the time control, perform the following steps.

1. Highlight the time control to edit and click Select. The following window displays:

2. If necessary, type a description for the time control.

The window illustrated above shows a newly created time control, with all fields blank. 
When you edit an existing time control, the fields already have options entered and 
displayed.
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3. To define the time control parameters, click on 1. The following window displays:

4. In the date fields, enter a Start and End date, using MM/DD format (01/01 through 
12/31), to indicate specific starting and ending dates to which this line item in the 
time control applies.

5. In the time fields, enter a Start and End time, using twenty-four hour format
(00:00 through 24:59), to indicate the specific times during the day that this line 
item in the time control is active.

When specifying start and end dates and times, the following guidelines apply:

� Leaving the Start field blank will cause PathFinder to assume the lowest value, i.e. 
01/01 or 00:00. 

� Leaving the End field blank will cause PathFinder to assume the highest value, i.e. 
12/31 or 23:59. 

� Leaving both fields blank will cause PathFinder to assume all dates or times, i.e. 
01/01 to 12/31 or 00:00 to 23:59.

� The Start date/time must always be earlier than the End date/time. A Start Time 
of 17:00 and an End Time of 08:00 (i.e., 5:00 p.m. to 8:00 a.m.) is INVALID and 
may cause PathFinder to behave erratically. 

6. In the day of week fields, select the checkbox for each day to which this line item in 
the time control applies, and clear the checkbox for each day to which this line item 
in the time control does not apply.

7. In the Time Period field, enter a number from 1 to 9 to distinguish different time-
related events within a time control. Time Period is most often used to control what 
mailbox greeting is played when a mailbox is reached. Typically, PathFinder uses 1 
for daytime, 2 for evening, and 3 for weekend. If in doubt, set the Time Period field 
to 1.
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8. Click on Edit Action to select the specific action to be performed during the 
indicated dates, days of the week, and hours during the day. The following displays:

9. Click on the action key that you want to configure. A brief description of each action 
appears to the right of the window as it is selected.

10. Select options from the time control action list as described in the following table:

Edit Time Control - Field Definitions

If you do not select any action, no time control action is performed.

Mailbox Sends the caller to the specific mailbox you select from a 
drop-down list.

Selecting Ask for Mailbox causes PathFinder to prompt the 
caller for a mailbox number.

Extension Sends the caller to the specific extension you select from a 
drop-down list.

Selecting Ask for Extension causes PathFinder to prompt 
the caller for an extension number.

Menu Executes the selected menu.

Owner Access Prompts the caller for a mailbox number and password, or 
a password only if you select the mailbox from the drop-
down list.

Run Module Runs other PathFinder modules.

Time Control Loads a time control and executes the time control action 
for the computed time period.

Command File Runs the indicated command file. Refer to Appendix A for 
more information on command files.
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11. Click on OK until you return to the Edit Time Control window.

Repeat steps 3. through 11. of the above process until all lines of the time control have 
been defined. Clicking Edit 6-10 in the Edit Time Control window provides access to a 
second series of lines.

Once all options have been set and saved, you can begin to use the time control. Time 
controls can be used in mailbox, extension, and menu settings.

Refer to the following sections for details on using time controls.

� “Voice Mail, Auto-Attendant, & Menu Time Periods” on page 3-26

� “Mailbox Settings” on page 3-48

� “Extension Settings” on page 3-51

� “General Settings” on page 3-55

� “Editing a Menu” on page 3-73

� “Setting Up Phone Lines” on page 3-85

Deleting a Time Control

The delete time control function is used to remove any time control that is no longer of 
use. To delete a time control, perform the following steps.

1. Click on the Edit Time Control Records icon on the toolbar.

2. Highlight the time control to delete, then click on Delete.

3. When prompted if you want to proceed with the deletion, click on OK.

Company Directory Provides a company directory listing according to your 
selection for Mailbox mode or Extension mode.

Fax on Demand Provides a choice of entries:

� blank (caller select document to be faxed)

� a document number to be faxed to the caller

� ADMIN (allow caller to access Fax on Demand 
administrative functions)

This option functions only if you have purchased the 
optional Fax-On-Demand module and have enabled it on 
the software key.

Homework Hotline Homework Hotline is part of the “optional” ChalkTalk 
application that allows teachers to record school 
assignments. When activated, students and parents can 
call in and listen to the assignments. For more details, 
refer to the “Homework Assignments” on page 2-27 
in the Optional Modules manual.

Q-A Q-A is part of the “optional” ChalkTalk application that 
allows an administrator to design Questionnaires using the 
QA Admin program. Refer to “Questionnaires” on 
page 2-31 in the Optional Modules manual for more 
information.

Run ActiveVex Runs an ActiveVex module such as: AvDCC.run for 
Desktop Call Control or AVOutDial.main for ChalkTalk.

KSU Clock Control For Digital systems only.
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Line Settings

The modular nature of PathFinder allows you to assign a specific module or application 
function to each telephone line (also referred to as a port or channel). When a caller 
dials a specific line, PathFinder runs the module that has been assigned to that port.

Setting Line Parameters

Set the initial module for each line according to PathFinder’s use and configuration.

The following are suggestions on appropriate uses of various options:

� If all calls to PathFinder are processed the same manner, regardless of time or date, 
use the same menu option for all ports.

� If calls are processed differently based on the time or date the call is received, 
select the Time Control option, along with the appropriate time control file.

� If you want callers to leave a voicemail message, select the Mailbox option. 

� The Extension option is used when PathFinder is running as a simple Auto-Attendant 
setup. However, this setting could cause erratic operations. It may not allow callers 
to enter a mailbox.

� If you are running a custom module, consult with Vodavi Technical Support before 
selecting the Run Module option.

� Choosing Command File allows you to control the call more directly, through the 
use of a script, or through special functions of the PBX. This option requires some 
programming. Refer to Appendix A for more information.

Assigning Port Modules

You should read this section before actually assigning any modules to a line. Then, read 
the sections of the manual that describe the modules you plan to install. When you 
have finished, return to this section to complete setup for your PathFinder phone lines.

System Partitioning

It is important to note that each line is independent from the other lines and can be 
programmed to perform a unique function. This is referred to as system partitioning. It 
allows you to run multiple telephone automation applications with a single PathFinder 
installation. 

To program system partitioning, perform the following procedure for each line:

� Select the line

� Select a module to install on the line

� Define parameters, if any, that regulate how the installed module functions
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Setting Up Phone Lines

Each phone line must be set up to run an initial module when PathFinder starts. This is 
the process of selecting a starting function for each line and assigning any needed 
parameters to that line. You can selectively define separate functions for every phone 
line.

To set up phone lines, perform the following steps:

1. Click on the Line icon in the toolbar. A window similar to the following displays:

2. Highlight the line to configure in the Line field, then click on Next. The following 
window displays:
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3. Click on Next to display the Event Handling Group window:

4. Click on Next to display the Blockage Group window:
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5. Click on Next and the Phone system integration window will display:

6. To accept the current settings, click Finish,

-or-

Enter a new name in the PBX Name field for any lines that do not have a PBX name 
explicitly defined. Then click Change to select the integration file to be used.

In most configurations, you can leave this value blank or set it to ANALOG.
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Refer to “Setting Line Parameters” on page 3-84 for more information on 
configuring these fields:

7. Once you have selected the module and clicked on OK, you are returned to the Edit 
Line Settings window.

Mailbox Prompts the caller to select a voice mailbox or sends 
caller to a specific mailbox, depending on your selection 
from the drop-down list.

Extension Prompts the caller to select an extension or sends caller 
to a specific extension, depending on your selection from 
the drop-down list.

Menu Plays the selected PathFinder menu.

Owner Access Grants access to mailbox owner privileges for a specific 
mailbox, or prompts the caller for a mailbox, with 
password prompting in either case.

Run Module Activates the selected module.

Time Control Loads a time control file and takes the menu action 
specified in the current time period.

Command File Runs the specified command file. Refer to Appendix A for 
information on command files.

Company Sends the caller to the company directory, in your choice 
of mailbox mode or extension mode.

Fax On Demand Provides a choice of entries including blank (caller select 
document to be faxed), a document number to be faxed 
to the caller, or ADMIN (allow caller to access Fax on 
Demand administrative functions). The Fax-On-Demand 
option is available only if you have purchased the optional 
Fax-On-Demand module and have enabled it on your 
software key.
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System Lists

One of the easiest ways to send a single message to many different mailboxes is 
through a system distribution list. PathFinder supports two types of distribution lists:

� System lists: Set up by the System Administrator

� Personal lists: Set up by individual users

For example … a system distribution list could be created for the Sales department. The 
Sales Manager (or any other PathFinder subscriber) could use this system distribution list 
to send one message that would be received simultaneously by each Sales employee in 
the list.

System distribution lists have the following characteristics:

� The number of lists that can be created is limited only by disk space.

� System lists are not associated to a specific mailbox.

� System lists can be maintained over the telephone by the Administrator.

� System lists can contain up to 200 entries. An entry may be a mailbox number or 
another list number, allowing you to chain lists together.

System lists allow users to route messages simultaneously to groups of mailboxes. In 
addition to mailbox numbers, system lists can contain other list numbers, making it 
possible to create unlimited distribution lists.

Creating a System List

To create a system distribution list:

1. Select System Lists from the Edit menu.

The following window displays
:

Figure 3-30: System Lists Window

5500
5501
5502
5503
5504
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2. Click on Create List to display the following window:

Figure 3-31: Create a System List Window

3. Assign a number for the list and type a description to describe the list’s purpose. 
Click on Create to return to the System Lists window.

4. In the System Lists window, highlight the name of the list you are creating, then 
click Edit to display the following window:

Figure 3-32: Edit System List Window

5. You have created a system list. You can edit your new system distribution list to add 
mailbox numbers, list numbers, and other numbers.

Do not enter a number that is also used as a mailbox number. Doing so will cause any 
message intended for the distribution list to be sent instead to the mailbox.

5505

Jones, Mary - 123
Smith, Bob - 223
Wright, Kim - 224
Blair, Zachary - 225

Blake, Janet - 226
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Editing a System List

To edit a system distribution list by adding or deleting mailbox users or system list 
numbers, perform the following steps.

1. From the main MAINT window, select Edit > System Lists from the menu bar.

2. Select the system list that you need to edit, then click Edit.

3. For each mailbox user you want to add, select the mailbox user from the Mailbox 
pull-down menu and click on Add Mailbox. Repeat this process for each mailbox 
user you want to add. 

4. For each previously-created system distribution list you want to add, select the from 
the system distribution list from the Other Lists pull-down menu and click on Add 
List. Repeat this process for each system distribution list you want to add.

5. To delete a user from the list, highlight that user in the list members pane at the top 
of the window, then click on Delete Member.

6. When you are finished editing the distribution list, click on Done.

Deleting a System List

To delete a system list, perform the following steps.

1. From the main MAINT window, select Edit > System Lists from the menu bar. 

2. Highlight the list to be deleted.

3. Click Delete List.

4. When prompted to confirm the deletion, click OK.

You must first create a list before you can edit it. Refer to “Creating a System List” on 
page 3-89 for more information.
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4 PathFinder Reports

PathFinder has the ability to generate a variety of reports for diagnostic and information 
purposes. This chapter discusses the various reports that can be output by PathFinder 
and how best to utilize them.
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Overview

These system reports can help diagnose problems, allocate resources, and improve 
PathFinder’s efficiency. The following sections describe the Reports menu which is 
located in the MAINT application, and includes options related to the following topics:

� PathFinder activity

� Reports settings

� PathFinder directory

� PathFinder logs

� Messages

� Greetings & Signatures

� Customized reports

� Reporting setup
PathFinder - System Administration December, 2003 - Issue 4.5



4-4 Overview

Chapter 4 - PathFinder Reports
Reports Criteria

Reports criteria are used to select specific data when generating a report. To generate 
any of the PathFinder reports:

� Select the report type from the Reports menu.

� A window displays in which you select the criteria appropriate to the particular 
report.

� The active fields available for selection criteria depend upon the report being 
generated.

Dialog Box Options

Title The type of report you selected from the Report menu 
will appear in this field.

Date Enter the complete start and stop dates, which must be 
in MM/DD/YY format (e.g., for November 21, 2001, enter 
11/21/01). If the date fields are left blank, Maint selects 
all records with any date.

Time Enter the complete start and stop times in 24-hour 
format (HH:MM:SS). If left blank, Maint selects all 
records with any time.

Mail Box, Extension, Menu, 
COS, or Time Control

Use the dropdown lists to select the appropriate first and 
last items for selection criteria.

LastName, Fax 
Documents, or Look For

Enter the appropriate selection criteria range for the 
report you want to generate.

Sort by When this option is available, select the order you want 
to see for that report: Mailbox, Extension, or Name.
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Dialog Box Guidelines

� All reports are viewed with WordPad. If you wish to print or save a report, use 
WordPad to do this.

� In the Settings reports, if no data is available for a particular field, that field is not 
shown in the report. For example: If the Department field is blank, no Department 
field appears in the report.

� When entering selection criteria for a report, PathFinder remembers the last criteria 
entered in any report and offers that as a default selection. For example … if you run 
a mailbox settings report, the mailbox range used in that report appears when you 
run a different report with a mailbox range criterion.

Report Setup Options

The Setup Reporting item in the Reports menu is used to select the lines you want 
printed per page, header options, and the speed at which reports are generated. The 
Report viewer field allows you to indicate what application is used to display reports.

Figure 4-1: Setup Report Generation Window

For the Generation speed setting, select one of the following options:

� Select Normal if MAINT is running on the same computer as the PathFinder engine.

� Select Fast if MAINT is running on a separate computer.

� Select Custom and enter a value only if instructed to do so by Vodavi Technical 
Support.

By default, the WordPad application is used to view reports. If you want to use a 
different viewer, specify it in the Report viewer field, along with the complete path.

The windows shown in the Reports chapter are intended to illustrate report 
structures, and may not reflect actual information or data.
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Activity Reports

Activity reports reflect PathFinder use. Data for the reports are obtained from the 
PathFinder system logs.

Call Traffic Usage

This “Usage” report displays call traffic information.

Figure 4-2: Usage Report Example

Report Data Use

The data are sorted by date and time 
(hour) and display the total number of 
calls (inbound and outbound) as well as 
the combined duration of all calls.

This report demonstrates when PathFinder is 
the most and least active. Its uses include:

� Determining staffing requirements

� Determining volume of after-hours calls
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Mailbox Usage

The Mailbox Usage report provides the log lines related to mailbox activity. The report 
(sorted by date): tracks each time the mailbox was accessed, the length of the 
message left, and the number of times that the owner accessed the mailbox.

Figure 4-3: Mailbox Usage Report Example

Report Data Use

� Mailbox number and name of mailbox 
owner

� Message Length (elapsed time of 
recording)

� Line call came in on

� Number of messages recorded (Msg 
Left)

� Time of mailbox entry

� Out-dial/Notification events

� Number of messages retrieved 
(MAINT)

� Total Trunk Access

� Duration between the caller's initial 
connection to PathFinder and 
subsequent hang-up after leaving a 
message or time required for mailbox 
owner to retrieve messages

A review of the Mailbox Usage report 
reveals the amount of activity of each 
mailbox on PathFinder. Owners of mailboxes 
with low activity may not fully understand 
how to use PathFinder and may need more 
instruction. Users with high activity should 
be reminded to remove messages. 

Take note of the average length of a call. 
When the average length approaches the 
maximum message length, the max 
message length may need to be increased.

This report can also be used in client bill-
back situations (like shared tenant 
environments) executive suites, or hotels. 
The report can be output to disk, then 
imported into a billing program.

MICHAEL JAMES

MICHAEL JAMES
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Extension Usage

The Extension Usage report identifies inbound call activity to a specific extension and 
describes the results of a call transfer initiated by PathFinder. The call can either be 
connected or dropped. A dropped call (either a busy or unanswered extension) may 
route to a mailbox, operator, or menu.

MARGARET JONES

Figure 4-4: Extension Usage Report Example

The report, sorted by date, documents inbound calls and their results. The report 
documents the time that the call was made as well as its duration. Duration is defined 
as the elapsed time between the initial connection and the subsequent hang-up from 
PathFinder. In addition, the report documents specific call activity.

Report Data Use

Possible data includes: 

� Answered -- Call was answered

� No Answer -- Extension did not 
answer

� Busy -- Extension was busy

� Connect -- Call was connected

� No Ring Back -- Extension did not 
respond

� Blind Transfer -- Call transfer type

A review of the Extension Usage report can 
help with the following:

� Scheduling agents or operators more 
effectively

� Determining a need for additional phone 
lines

� Identifying subscribers who miss a large 
number of calls
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Menu Activity

The Menu Activity report identifies user traffic within menus, indicating what 
information callers are most interested in by the number of times specific menus are 
accessed. This can help determine a menu’s usefulness and whether the number of 
channels that allow access to it are sufficient to support the traffic.

Figure 4-5: Menu Activity Report Example

Report Data Use

� Date -- The selected reporting period

� Menu -- The selected menu that is the 
subject of the report

� Time -- The time of day that the menu 
was accessed

� Key Pressed -- The caller's key 
selection while in the menu

This information may be useful to others 
besides the system administrator.

For example, with the following menu: 
“Press 1 for information on product X; 
press 2 for information on product Y …”, the 
sales manager may be interested in the 
number of requests for each option.

The Menu Activity report includes the total 
number of requests for each menu key.
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Fax Documents

If your PathFinder implementation has the optional fax support module installed and you 
have created a Fax-On-Demand application, you may have discovered how confusing it 
can be keeping track of the fax documents. The Fax Documents report handles this 
chore for you.

Figure 4-6: Fax Documents Report Example

Report Data Use

File Name -- A list of all fax documents on 
PathFinder

Date -- The date each fax was sent or 
received

Time -- The time each fax was sent or 
received

Size -- The size of the fax file created

This information can be used by the system 
administrator to keep track of all fax 
documents currently on PathFinder.

This can be helpful in maintaining a Fax-
On-Demand application.
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Notification Usage

The Notification Usage report indicates the number of times a mailbox was notified.

Figure 4-7: Notification Usage Report Example

Report Data Use

Date -- The selected reporting period

Mailbox -- The selected mailbox for the 
report

Time -- The time of day that the 
notification was executed

Attempt -- The number of notification 
attempts

Line -- The line number where the 
notification went out

Retries -- The number of times a caller 
can initiate an invalid option

» This information can be used to 
determine if notifications are being 
executed in a timely fashion.

» The Notification Activity report may be 
sorted by username, extension, or 
mailbox.

MARGARET ALEXANDER

MARGARET ALEXANDER
PathFinder - System Administration December, 2003 - Issue 4.5



4-12 Setting Reports

Chapter 4 - PathFinder Reports
Setting Reports

This section describes the Settings reports functions available through the Reports 
menu in the PathFinder MAINT application.

Settings reports identify various PathFinder settings that were entered during 
configuration. Information is available for mailboxes, extensions, and menus. 

Mailbox Settings Summary

The Mailbox Settings Summary report summarizes the configuration of each mailbox in 
PathFinder.

Figure 4-8: Mailbox Settings Summary Report Example

Report Data Use

� Mailbox number

� Associated extension number

� Mailbox owner's name

� Mailbox state

» This information can be used to keep 
track of all mailboxes on PathFinder.

» The data may be helpful in maintaining 
mailboxes in a dynamic work 
environment.

» The Mailbox Settings Summary report 
may be sorted by username, extension, 
or mailbox.
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Mailbox Settings Detail 

The Mailbox Settings Detail report provides an in-depth review of the configuration of 
each mailbox in PathFinder. 

Figure 4-9: Mailbox Settings Detail Report Example

Report Data Use

� Mailbox number

� Associated extension number

� Mailbox owner's name

� Mailbox state

� Class of service for which the mailbox 
is a member

� Group (Department)

� Notification state

� Password

» This information is helpful in resolving 
problems with mailboxes.

» The Mailbox Settings Detail report may 
be sorted by username, extension, or 
mailbox.
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Extension Settings Summary 

The Extension Settings Summary report summarizes the configuration of each 
extension in PathFinder. 

Figure 4-10: Extension Settings Summary Report Example

Report Data Use

� Extension owner

� Associated mailbox number

� User name

� Transfer options

� Action options

» This information is helpful in resolving 
problems with extensions, such as 
transfer and forwarding problems.

» The Extension Settings Summary report 
may be sorted by username, extension, 
or mailbox.
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Extension Settings Detail 

The Extension Settings Detail report provides more detailed information about each 
extension in PathFinder. 

Figure 4-11: Extension Settings Detail Report Example

Report Data Use

In addition to the information contained 
in the Extension Settings Summary 
report, the Extension Settings Detail 
report provides the class of service 
assigned to the extension.

» This information is helpful in resolving 
problems with extensions, such as 
transfer and forwarding problems.

» The Extension Settings Detail report 
may be sorted by username, extension, 
or mailbox.
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Class of Service Settings 

You can run a report for details on each defined class of service.

Figure 4-12: Class of Service Settings Report Example

Report Data Use

� The class of service name and 
description

� General settings

� Voice mail and Auto-Attendant settings, 
including notification settings

Use the COS report to review and maintain 
class of service options.
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Menu Settings 

The Menu Settings report provides a complete description of each menu and the action 
programmed for each key.

Figure 4-13: Menu Settings Report Example

Report Data Use

� Menu name

� Key actions: The action assigned to 
each key on the telephone keypad 
(refer to “Key Action Definitions” on 
page 3-76 for more information)

The purpose of this report is to describe all 
of the menu settings in a simple and easy 
format.

You can easily determine how the key 
actions of your menus are configured.
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Time Control Settings 

The Time Control Settings report lists options for the selected time controls.

Figure 4-14: Time Control Settings Report Example

Report Data Use

� Time Control name

� Description

� Date

� Day

� Time

� Action

Use this report to review the various time 
control settings.

It can be helpful in planning new time 
controls and maintaining those currently on 
PathFinder.
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Registry Settings Summary

The Registry Settings Summary report identifies the various registry settings.

Figure 4-15: Registry Settings (Summary) Report Example

Report Data Use

This report provides a system-wide 
overview of current Registry settings.

This is a comprehensive report that 
includes all system settings.

As such, it is a powerful troubleshooting 
and supervisory tool for maintaining 
PathFinder.
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Registry Settings Detail

If you need more information than what is included on the Registry Settings Summary 
report, you can run a Registry Settings Detail report.

Figure 4-16: Registry Settings (Detail) Report Example

Report Data Use

The Registry Settings Detail report 
provides the same information as the 
Registry Settings Summary report, but 
also includes an explanation of each 
setting, default values, and the type of 
registry variable.

This is a comprehensive report that not 
only includes all system settings, but a 
description of each.

As such, it is a powerful troubleshooting 
and supervisory tool for maintaining 
PathFinder.
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System Distribution Lists

The System Distribution Lists report provides a listing of each system distribution list 
used on PathFinder.

Figure 4-17: System Distribution Lists Report Example

Report Data Use

� List Number

� Members’ extension numbers

� Members’ names

This is a comprehensive report that lists all 
current system lists.

As such, it is a powerful evaluation and 
supervisory tool for maintaining PathFinder.
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Directory Reports

This section describes the Directory reports function available through the Reports 
menu in the PathFinder MAINT application. 

There is only one directory report. It gives a listing of all subscribers with their first 
name, last name, extension number and mailbox number. 

Directory Report

Directory reports can be generated for the entire directory, or specific name ranges can 
be designated. 

Figure 4-18: Directory Report Example

Report Data Use

The Directory report associates 
subscribers with specific mailboxes and 
extensions.

Print this report regularly and reference it 
for maintenance.

The Directory report also can be used to 
create company telephone lists.
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NETWORK MAILBOX

RECORDING
GREETING

OVERFLOW
NITE 1
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Logs Reports

This section describes the Logs report functions available through the Reports menu in 
the PathFinder MAINT application.

Log reports provide information about PathFinder and error messages. Logs are used as 
diagnostic tools to trace PathFinder activity, and are primarily used for debugging and 
technical support functions. 

Daily Log

The Daily Log report provides a detailed listing of general PathFinder activity. 

Figure 4-19: Daily Log Report Example

For more information on Log Files, refer to “What To Log” on page 3-20.

Report Data Use

All entries are listed by time of 
occurrence and by line number.

Review this report to check on daily 
PathFinder activity. This report should not be 
confused with the Error Log.

There are instances, however, when both 
are used together for diagnostic purposes. 
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Maintenance Log

The Maintenance Log report tracks all activity within MAINT. 

Figure 4-20: Maintenance Log Report Example

Report Data Use

Any time a report is run, a mailbox is 
created, or a menu is modified, a line is 
added to the Maintenance log.

Review this report to see what changes 
have been made in MAINT. Each line of the 
report lists a specific action or activity 
initiated during a MAINT session.

� This can be used to track system 
administration functions and to verify 
who is accessing MAINT and what they 
are doing.

� This can be very helpful in 
troubleshooting PathFinder problems.
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Error Log

The Error Log report lists any error messages resulting from the operation of PathFinder.

Figure 4-21: Error/System Log Report Example

Report Data Use

Both hardware and software malfunctions 
are reported.

Review this report to check on errors in 
PathFinder activity.

Each line of the report specifies a specific 
error condition that has occurred.

Each error condition is listed by time of 
occurrence.
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Messages Reports

This section describes the Messages reports functions available through the Reports 
menu in the PathFinder MAINT application.

Message reports provide the system administrator with a means to determine the 
current status of messages in PathFinder mailboxes.

Message Summary

The Message Summary report summarizes various status conditions for PathFinder 
mailboxes.

Figure 4-22: Message Summary Report Example

Report Data Use

� Mailbox -- The name and mailbox 
number of the mailbox owner 

� New -- Total number of new messages

� Saved -- Total number of saved 
messages

� Time -- Total time for all messages

� Disk Space Used -- Total occupied disk 
space per owner

This report shows the total messages 
stored on the hard drive for each mailbox.

It can help determine if messages are 
being stored too long or if PathFinder 
resources are being monopolized by any 
one user.
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Message Detail

The Message Detail report allows the system administrator to select a mailbox and view 
its current status.

Figure 4-23: Message Detail Report Example

Report Data Use

� Mailbox -- The name and mailbox number 
of the mailbox owner

� New -- N for new message

� Saved -- S for saved message

� From Mbx -- Mailbox message was sent 
from 

� Size -- Message size in seconds

� Date/Time -- Date and time message left

� File -- The filename of the message 

This report shows all messages that are 
stored on the hard drive.

It can help determine if messages are 
being stored too long or if PathFinder 
resources are being monopolized by any 
user.
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Greetings & Signatures

The Greetings & Signatures report allows the system administrator to determine the 
total amount of greetings & signatures recorded by mailbox holders. Each mailbox 
holder can have multiple greetings or signatures recorded.

Use

This report is another tool that the system administrator has to analyze and control 
proper distribution of PathFinder resources.
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Customized Reports

Customized reports provide flexibility to isolate certain assurances within the log and 
provide detail information.

Example

Using customized reporting, the system administrator can report on all “track 
messages” log lines and actually display the life of a message as it moves through the 
system. In addition, some IVR systems can use customized reporting to show 
information about the IVR that is not available through standard reports.

Use

This report is another tool that the system administrator has to analyze and control 
proper distribution of PathFinder resources.
PathFinder - System Administration December, 2003 - Issue 4.5



4-30 Customized Reports

Chapter 4 - PathFinder Reports
PathFinder - System Administration December, 2003 - Issue 4.5



5 Boom Box Application

This chapter provides an introduction to this application and details on its installation as 
well as an introduction to the prompts that can be created and used in conjunction with 
the Boom Box application.

The Boom Box application allows you to create and edit voice prompt files used by 
PathFinder.
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Chapter 5 - Boom Box Application
Boom Box Application

Boom Box can be used on any machine that has either Dialogic® voice ports configured 
or a WAV device with speakers and a microphone. This application is normally used on 
the same PC where PathFinder is running. However, Boom Box can be used on another 
PC that has another Dialogic voice port or a WAV device, and then the prompt file(s) 
can be copied to PathFinder.

Boom Box can work on the following:

� Standalone single prompt files (VOX), or 

� Multiple voice prompts combined into one voice prompt file (VOX) with a matching 
index file (VDX). 

The VOX files used by PathFinder are in the Dialogic 8-bit ADPCM format at 24khz. Boom 
Box can produce these same ADPCM files and can also produce WAV files.

Requirements

Boom Box requires the following:

� Windows NT® 4.0 (Service Pack 5) or Windows 2000

� A Dialogic card, or a WAV device with microphone and speakers

Installation

Boom Box is automatically installed when running the install PathFinder software. 

After installing your PathFinder software, you can access the Boom Box application by 
selecting from the Start menu the following path: Programs > PathFinder Voice 
Processing > Boom Box. The Boom Box main window is shown below:

Figure 5-1: Boom Box Main Window

It is recommended that the PathFinder voice engine be shut down to record voice 
prompts using Boom Box. If you would like to record prompt files while the PathFinder 
engine is running, use the Record Prompts option on a menu.
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Menu Bar Options

The Boom Box application has four menus available in the menu bar.

� File

� Voice Port

� Convert

� Help

File Menu

The File menu allows you to create, access, and save Boom Box files as well as exit the 
Boom Box application.

File > New

The File > New option allows you to create either indexed or non-indexed prompt files. 
If you create a new indexed file, you can only create VOX file types.

File > Open

The File > Open option allows you to open prompt files. It does not matter if the files 
are indexed or not-- Boom Box determines that for you.

File > Save

This option saves the current prompt file that you are working on.

File > Save As

This option saves the current file you are working on as another file.

Voice Port Menu

The Voice Port menu allows you to manipulate lines and ports.

Voice Port > Answer

With this option, call into the phone lines and select the extension you want to reach. 
Then select Answer to answer the phone.

Voice Port > Disconnect

This option disconnects the phone line.

You cannot change a non-indexed prompt file into an indexed prompt file.

The File > Save As option cannot save VOX files as WAV files or WAV files as VOX 
files.

The Voice Port menu can only be used when you’re playing VOX files. It is used 
only through the Dialogic voice port device, not through the WAV device.
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Voice Port > Change Port

This allows you to set the port (phone line) that you want Boom Box to answer. 

The Set Port window is shown below:

Figure 5-2: Set Port Window

Convert Menu

The Convert menu allows you to convert WAV files to VOX files. The Convert menu can 
only be accessed when you have a WAV file open.

Help Menu

The Help menu allows you to access the Help files for Boom Box. These files can be 
accessed at any time.

Buttons

The following buttons can be accessed from the main Boom Box window:

Do not set the port to a port being used by PathFinder while PathFinder is running.

Table 5-3: Boom Box Window Buttons

Button Description

Play Plays the current file (non-indexed) or prompt (indexed).

Record Records the current file (non-indexed) or prompt (indexed).

Stop Stops playing or recording.

Edit Clicking the Edit button allows you to edit any type of prompt. Refer 
to “Edit Options” on page 5-6 for more information on these 
options.

Disconnect Disconnects the phone line. This is only available if working with a 
VOX file.

Add Prompt Clicking the Add Prompt button allows you to add a prompt. Refer to 
“Add Prompt” on page 5-7 for more information on this option.
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Edit Options

Clicking the Edit button from the main Boom Box window allows you to edit any type of 
prompt. 

Figure 5-4: Boom Box Edit Window

Edit Functions Buttons

The following buttons are available in the edit functions area in the Edit window. 

Button Definition

Play Plays the current file (non-indexed) or prompt (indexed).

Stop Stops recording or playing.

Record Records the current file (non-indexed) or prompt (indexed).

Undo Undoes most of the changes made to the current file or prompt. 
If you make a change that cannot be undone, a prompt displays 
saying that you cannot undo this change unless you do not 
save.

Play Beginning Plays the first (x) seconds of current file (non-indexed) or 
prompt (indexed), where (x) is the number in the text box.

Play Ending Plays the last (x) seconds of current file (non-indexed) or 
prompt (indexed), where (x) is the number in the text box.

Cut Beginning Cuts the first (x) seconds of current file (non-indexed) or 
prompt (indexed), where (x) is the number in the text box.

Cut End Cuts the last (x) seconds of current file (non-indexed) or 
prompt (indexed), where (x) is the number in the text box.

The Step Size field at the top left of the screen determines the number of seconds 
of the file or prompt to play or cut from the beginning or end. You can set the 
step size to larger or smaller values depending on how much you need to play 
or cut from the prompt.
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File Functions Buttons

The following buttons are available in the file functions area in the Edit window. 

Add Prompt

Clicking the Add Prompt button from the main Boom Box window allows you to add a 
new prompt to the current file.This option is only visible if working on an indexed 
prompt. The Add Prompt window is shown below:

File Information

At the bottom of the main menu is the file information pane. Please note that you do 
not type or otherwise enter this information; instead, it automatically displays based on 
specific information relevant to your file. The five File Information fields are as follows.

Name -- The name of the file you are working on.

Type -- Either indexed or non-indexed.

Format -- Either ADPCM for VOX file type or WAV for WAV file type.

Device Type -- Specifies how the file is played or recorded. There are two options: 

» A sound card if you open a WAV file, or 

» A Dialogic card if you open a VOX file.

Device Status -- Specifies whether you can play or record (or edit). If this is green, 
you can play, record, or edit. If it is red, you cannot play, record, or edit. This is 
green when you answer (VOX) or when you have a sound card. It is red when you 
first open the VOX file or when you disconnect it.

Button Definition

Append This appends a non-indexed prompt file to the current file or prompt.

Write This writes the current prompt to a non-indexed prompt file. This does not 
save the currently opened file.

Read This reads in a non-indexed prompt file on top of the current file or prompt.

Delete This option deletes a prompt from an indexed file.

Save This saves the changes made to the current file or prompt.

Exit Exits the Edit window and returns you to the main Boom Box window.
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Troubleshooting

You can carry out Dialogic-based or WAV-based Boom Box troubleshooting.

Dialogic-based Troubleshooting

� Make sure that the Dialogic voice board is installed correctly.

� Be sure that the Dialogic voice drivers are correctly configured and started.

� Make sure the phone extension (or phone through extension simulator) is connected 
to a voice port. Note that you cannot plug a phone directly into a dialogic port.

� Make sure Boom Box is configured to use the correct voice port phone extension 
connected to.

� Make sure Boom Box is not using a voice port already in use by PathFinder or other 
Dialogic-based application.

WAV-based Troubleshooting

� Be sure that the WAV device is installed correctly.

� Be sure the speakers are connected correctly, turned on, and are loud enough.

� Make sure the microphone is installed correctly.

Make sure the microphone gain (sensitivity) is not set too soft or too loud (often an 
optional setting).

Boom Box System Prompts

The Boom Box application allows you to create and edit voice prompt files used by the 
PathFinder voice processing system. In this section, the system prompts that are used 
with the Boom Box application are discussed in detail.

System Prompts

PathFinder uses a group of pre-recorded messages and phrases called voice prompts to 
communicate with callers. PathFinder constructs understandable messages by selecting 
different prompts and playing them together as a single message. PathFinder uses two 
types of prompts: Indexed and Non-Indexed. Indexed prompts are located in a single 
indexed file that contains many prompts. Non-Indexed prompts only contain one 
prompt per file. All files are stored in the C:\PATHFINDER\VOX directory unless 
otherwise noted.
PathFinder - System Administration December, 2003 - Issue 4.5



Boom Box Application 5-9

Chapter 5 - Boom Box Application
Indexed vs. Non-Indexed Prompts

Non-Indexed prompt files are of type VOX only. Indexed prompts can be either VOX or 
VDX file pairs.

Non-Indexed Prompts

Many prompts used by the standard PathFinder modules are simple non-indexed prompt 
files. This means there is only one prompt recorded in each VOX file, and there is no 
index associated with that VOX file. To play the prompt, PathFinder simply plays the 
entire file. 

Non-indexed prompts are good for applications in which there are just a few prompts, 
or in which these prompts may need to be re-recorded while PathFinder is in use. 

Indexed Prompts

Many prompts used by the standard PathFinder modules are stored in indexed prompt 
files (matching VOX and VDX files). This means there are one or more individual 
prompts recordings in the VOX file, with named segments in the VDX index file that 
indicate where each prompt begins and how long it is. To play an indexed prompt 
segment, PathFinder looks up the segment name in the VDX file to get the start location 
and length, and plays just that portion of the prompt from the VOX file.

Indexed prompt files are good for applications in which there are a large number of 
prompts and it helps organization on the disk to keep them all together in two files 
instead of in many. They are also beneficial when the prompts are not going to need to 
be re-recorded while PathFinder is in use. 

Non-Indexed Prompts

The list below outlines the customizable (non-indexed) prompts that are used in 
PathFinder. All prompts should be located in the VOX directory. You can create a blank 
prompt (with 1 byte of data) to suppress certain prompts. But more commonly, you 
would record new information to replace the default prompt.

Replacement Prompts

All prompts below can be recorded using Boom Box.

Table 5-5: Non-Indexed (Customizable) Prompts

File Name Description
Replaces

Indexed File …
Sample(s)

VOPGPRE.VOX Preamble prompt that 
plays in front of a 
numeric page

H!VO0.VOX: 
VoPagePreamble

“Page message is . . .”

“You have a message to call …”
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FXDMND1.VOX Prompt played before 
FxInstruct1 or 
FXDMND2.VOX that can 
be used to give the caller 
more information

N/A “You have reached the Vodavi 
fax-on-demand line. Please 
note that document 411 is a 
catalog of available fax 
documents.”

FXDMND2.VOX Tells callers how many 
fax prompts they can 
select

H!FAX0.VOX: 
FxInstruct1

and FxInstruct2

“You will be prompted to select 
which documents should be 
faxed. You may select up to X 
fax documents.”

VMINSTR.VOX Voice mail instructions 
prompt

H!XX0.VOX: 
VmInstructions

“Enter the mailbox number of 
the person you are trying to 
reach. Press zero for the 
operator. Press the star key for 
the directory.”

VMSYSGRT.VOX First system greeting. 
Played if selected in COS

H!XX0.VOX: 
VmSysGreeting

“The person you have tried to 
reach is not available. Please 
leave a message after the 
tone.”

VMSYSGR2.VOX Second system greeting. 
Played if selected in COS

H!XX0.VOX: 
VmSysGreeting2

“Begin speaking at the tone. 
When you are finished 
recording you may hang-up or 
press any key for more 
options.”

VMRECKEY.VOX Asks caller to press a key 
to start recording

H!XX0.VOX: VmRec 
Key

“Press one to start recording.”

VMRECOPT.VOX Record option prompt H!XX0.VOX: 
VmRecordOption

“To send message, press one; 
to play, press two; to cancel, 
press three.”

<COS>.PBG Numeric message begin 
prompt. Played when 
mailbox is set to take 
numeric messages

N/A beep-beep-beep

<COS>.PDN “Numeric message 
done” prompt. Prompt 
played after the caller 
enters the numeric page

N/A Busy signal or some type of 
completion tone

<COS>.GRT COS Greeting. Played if 
COS is set to play the 
COS greeting

N/A “You have reached the sales 
department. Please leave a 
message after the tone.”

<COS>.VI1 COS Voice Insert - 
played before mailbox 
name

N/A “You have reached the voice 
mailbox of . . . ”

Table 5-5: Non-Indexed (Customizable) Prompts (Continued)

File Name Description
Replaces

Indexed File …
Sample(s)
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<COS>.VI2 COS Voice Insert - 
played after mailbox 
name

N/A “ . . . Please leave a message 
after the tone.”

<COS>.LOP COS Last options H!XX0.VOX: 
VmLastOptions

 “Press one to reach another 
mailbox. Press nine to 
disconnect.”

DIRGETDI.VOX Prompt asking for lookup 
digits in directory

H!XX0.VOX: 
DirGetDigits

“Enter the first four characters 
of the person's last name. For 
Q press seven. For Z press 
nine.”

AAINSTR.VOX Auto-Attendant 
instructions

H!XX0.VOX: 
AaInstructions

“Enter the extension number 
of the person you are trying to 
reach. For the company 
directory press the star key. To 
reach an operator, press zero.”

AAHVCALL.VOX Prompt announcing that 
an extension has a call

H!XX0.VOX: 
AaHaveCall

“You have a call.”

AAHOLD.0 to 
AAHOLD.999

Hold files played when 
the system needs to put 
a caller on hold and the 
COS says use hold files

N/A AAHOLD.0: “Please hold. We 
appreciate your patience . . . ”

AAHOLD.1: “Please continue 
to hold . . . ”

AACALLFO.VOX Announces that the 
extension has a call for a 
particular extension

H!XX0.VOX: 
AaCallFor

“Call for . . .”

AASCNASK.VOX Prompt asking callers to 
say their names

H!XX0.VOX: 
AaScreenAsk

“Whom may I say is calling?”

AAXFRMSG.VOX Prompt telling callers 
you are going to be 
transferred

H!XX0.VOX: 
AaTransfer1

and AaTransfer2

“Please hold while I transfer 
you to . . . ” 

Table 5-5: Non-Indexed (Customizable) Prompts (Continued)

File Name Description
Replaces

Indexed File …
Sample(s)
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6 Back-Ups / Logs / Errors  and
Troubleshooting

This chapter contains the information needed to help you maintain the PathFinder 
system by providing: a system back-up procedure, samples of statistical logs, and 
answers to the most common system problems.
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Backing Up PathFinder

PathFinder allows you to back up important files in case of a catastrophe. Backups can be 
very important and we recommend backing up often. There are several ways that 
PathFinder can be backed up.

Method Description

Network If the network is backed up periodically and PathFinder is a node on the 
network, then network backups are sufficient.

Consult your network administrator for more information.

Tape If there is a tape drive on the PathFinder PC, Windows NT supports 
periodic automatic backups of PathFinder.

Consult your Windows NT manual on how to perform tape backups.

Manual PathFinder can be backed up when there is a change made to PathFinder 
in order to protect the data. Typically, these backups are performed 
manually as described:

� Level One is to back up all of the vital programming of PathFinder. 
Back up the \PATHFINDER\DBASE directory and all its 
subdirectories.

� Level Two includes the first level, and subscriber greetings, menu 
greetings and other static voice prompts. Back up the following 
directories, and all their sub-directories:

\PATHFINDER\DBASE

\PATHFINDER\VOX

\PATHFINDER\MESSAGES\*.SIG

\PATHFINDER\MESSAGES \*.GR?

� Level Three contains the first and second levels, and all mailbox 
messages. This is a complete backup of PathFinder, and depending 
on the number of messages on PathFinder, it could involve a large 
amount of data. Back up the following directories, and all their sub-
directories:

\PATHFINDER\DBASE

\PATHFINDER\VOX

\PATHFINDER\MESSAGES\*.*
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Log Files & Error Messages

PathFinder outputs three types of logs: 

� System Error

� Maintenance Access

� Daily System Activity

All log files are in ASCII text format, which allows them to be printed or viewed with a 
simple text editor, like Notepad or Write.

System Error Log

The PathFinder Error log is directed to a file named ERROR.LOG. The Error log file is 
stored in the \PATHFINDER\LOGS directory. The Error log file contains general 
PathFinder information. The Error log file is a cumulative file. Once PathFinder is initialized 
the Error log file is written. Each time PathFinder is reset or there is a general problem, 
the new log information is appended to the existing Error log file.

Data Fields

Each line in the Error log file contains four data fields:

Sample System Data

Several lines appearing in the Error log do not indicate any errors as shown:

The first ten lines … indicate the voice-processing engine was started correctly.

The last three lines … indicate the voice-processing engine was terminated correctly.

Field Indicates …

First what type of log line is listed. Column contains an alpha character.

Second the date the Error log line was generated.

Third the time the Error log was generated in a hh:mm:ss.ttt format.

Fourth the error condition (text varies in length).

B 07/30/03 10:51:03.568 --- Pathfinder Startup -
Version 9.0.1
B 07/30/03 10:51:03.658 --- Logging State is 4
B 07/30/03 10:51:03.788 --- Engine Serial Number:
900680
B 07/30/03 10:51:17.969 --- enabling tcp/ip inbound
telnet
B 07/30/03 10:51:17.979 --- tcpip: you are known as
esivmail
B 07/30/03 10:51:18.009 --- Fast function trigger rate
is 50
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System Maintenance Log

The maintenance log is made up of separate files. Each day that the MAINT application 
is accessed, it generates a separate file. The files are stored in the \PATHFINDER\LOGS 
directory. The name of the file is MTyymmdd.LOG, where yy is the year, mm is the 
month, and dd is the day. For example … the log for May 7, 2003 would be named: 
MT030507.LOG

The maintenance log file can keep track of unauthorized user access to MAINT. Each 
time MAINT is accessed, it generates log lines indicating what the maintenance user 
did. MAINT outputs maintenance activity log lines similar to those found in the Error 
log.

In general, each log line has three fields:

System Activity Log

The System Activity log is made up of separate files. Each day PathFinder runs, it 
generates a separate file. The files are stored in the \PATHFINDER\LOGS directory. The 
name of the files is DLyymmdd.log, where yy is the year, mm is the month, and dd is 
the day. For example … the log for May 7, 2003 would be named DL030507.LOG.

The System Activity log is more complicated than the Error log. Every phone call 
PathFinder takes generates log lines indicating what the caller did. PathFinder outputs 
system activity log lines similar to those found in the Error log (refer to “System Error 
Log” on page 6-4).

In general, each log line has four fields:

Field Indicates …

First the time the Error log line that was generated. 

Second the type of log generated: INFO or DEBUG.

� INFO data typically consists of logins, logouts, and actions on the 
database.

� DEBUG data typically consists of specific actions on the databases. 

Third the message describing why the line was generated.

Field Indicates …

First the type of log line generated.

Second the time the line was generated, in hh:mm:ss.ttt format.

Third the channel (line) that output of the line. A line number of three 
hyphens (---) indicates a system message from PathFinder. 

Fourth the log message which can be very simple or very complex.
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Activity Log - Sample #1

Below is an excerpt from a daily log file representing a typical blind transfer call into 
PathFinder. The call was generated with default logging options enabled. 

� Extension 242 is set to forward on busy or no answer to voice mail. 

� The call was placed into PathFinder and the caller was transferred to extension 242. 

� Then, extension 242 either did not answer or was busy.

� Therefore, the call was forwarded to mailbox 242.

Activity Log - Sample #2

Below is an excerpt from a daily log file representing a typical supervised transfer call 
into PathFinder. The call was generated with default logging options enabled.

� The call was started at 08:19:54.687.

� The NITE9608 menu was accessed, and the caller pressed the 2 key (which is 
assigned the Extension/Auto-Attendant Start Key). 

� Then, they entered 60. This is apparent because the caller was transferred to 
extension 260.

� PathFinder detected a no answer condition. 

� Because PathFinder received a No Answer condition, the caller was transferred to 
mailbox 260. 

� The caller recorded a message for 1:41 minutes and then pressed the # key. 

� The last line shows that the call ended.

Ca represents the Supervised Transfer option, and Ho represents the Call Holding 
option when using supervised transfers.

C 11:06:56.833 1 Log: Start Call
C 11:06:59.677 1 Log: Menu MAIN9711 11:06:57 Keys 2:AaSTART
C 11:07:00.729 1 Log: AutoA 242 Access
C 11:07:06.537 1 Log: AutoA 242 Blind Bl Connect 242
C 11:07:06.537 1 Log: Stop Call 11:06:56
C 11:08:35.074 1 Log: Start Call
C 11:08:36.767 1 Log: Menu MAIN9711 11:08:35 Keys 8:Vm
C 11:08:40.252 1 Log: VMail 242 Take message
C 11:08:41.754 1 Log: Stop Call 11:08:35

C 08:19:54.687 1 Log: Start Call
C 08:19:59.985 1 Log: Menu NITE9608 08:19:55 Keys 2:AaSTART
C 08:20:00.796 1 Log: AutoA 260 Access
C 08:20:25.201 1 Log: AutoA 260 Call 260 NoAnswer Ca
C 08:20:25.211 1 Log: AutoA 260 To mailbox 260
C 08:20:36.487 1 Log: VMail 260 Take message
C 08:22:18.604 1 Log: VMail 260 Voice 00:01:41 K#
C 08:22:20.186 1 Log: Stop Call 08:19:54 H7
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Debugging

PathFinder can give more or less information depending on the level of debugging 
enabled on PathFinder. Refer to “Logging” on page 3-20 for more information on logging 
and debugging options. Below is a sample of the <$paratext>, but with all debugging 
options enabled.

Notice the line at 08:20:05.853 … it describes the transfer string sent to the 
telephone system in order to transfer the call to extension 260.

(This data is often used by technical support for troubleshooting.)

C 08:19:54.687 1 Log: Start Call
C 08:19:55.248 1 H!KERNEL Debug: gRunCode <TcESIMAIN>
C 08:19:55.268 1 H!KERNEL Debug: gRunCode <MnNITE9608>
C 08:19:59.985 1 Log: Menu NITE9608 08:19:55 Keys 2:AaSTART
C 08:19:59.985 1 H!KERNEL Debug: gRunCode <Aa>
C 08:20:00.796 1 Log: AutoA 260 Access
C 08:20:00.796 1 H!AUTOA Debug AutoA 260 Action=<Ca> Data=<260>
C 08:20:00.876 1 H!AUTOA Debug: Before prompt H0 Key?0
E 08:20:05.853 1 dialvox:call: <&,6#260> entered
E 08:20:22.347 1 dialvox:call: <&,6#260> result=8(8:1:0) drvrst=Idle
C 08:20:22.347 1 H!AUTOA Debug: Transfer (Call) Result=8
C 08:20:22.357 1 H!AUTOA Debug: Connect=[8]: No Answer
C 08:20:22.357 1 H!AUTOA Debug: HangUp=0
C 08:20:22.367 1 H!AUTOA Debug: HangUp Type=H0
C 08:20:22.367 1 H!AUTOA Debug: Processing (Call) Result [8].
C 08:20:22.377 1 H!AUTOA Debug: Telephony Type [].
C 08:20:22.377 1 H!AUTOA Debug: gFncResult [8].
C 08:20:25.201 1 Log: AutoA 260 Call 260 NoAnswer Ca
C 08:20:25.211 1 Log: AutoA 260 To mailbox 260
C 08:20:25.211 1 H!KERNEL Debug: gRunCode <Vm260>
C 08:20:36.487 1 Log: VMail 260 Take message
E 08:22:18.394 1 dialvox:DialVox/record:
D:\PATHFINDER\MESSAGES\0\6\V260.L01:8302:180 s=300 m=0 result=0 oh=5 sh=5
C 08:22:18.604 1 Log: VMail 260 Voice 00:01:41 K#
C 08:22:19.044 1 H!KERNEL Debug: gRunCode <Aa>
C 08:22:19.655 1 Log: AutoA 999 does not exist.
C 08:22:20.186 1 Log: Stop Call 08:19:54 H7
C 08:22:18.644 6 H!KERNEL Debug: wait(0) = 1.
C 08:22:18.644 6 Log: Start Call
C 08:22:18.654 6 Debug: Event Queue (3) <0 1>
C 08:22:18.664 6 H!KERNEL Debug: get_event(10/06/
1998,08:22:18,MmNmVT260.NJ9,0)
C 08:22:18.674 6 H!KERNEL Debug: gRunCode <MmNmVT260.NJ9>
C 08:22:18.704 6 Log: MsgMan Nm VT260.NJ9
C 08:22:18.744 6 H!DBASE Debug: Mbx:260 Set Online <Ft No00-1>.
C 08:22:18.764 6 Log: Stop Call 08:22:18
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Multiple Line Calls

There may be several telephone calls active on PathFinder with each line behaving 
differently. Below is a log line indicating telephone calls on lines one, two, and three.

This complete log shows a call placed on line three with several calls placed before the 
call on line three was completed.

Menu Logs

The third line of this log shows which menu was picked (Demo), the time the call was 
made (10:25:08), which key the caller pressed for options 2, and where the menu 
forwards (Salesmnu), after menu has finished.

C 09:50:27.474 1 Log: Start Call
C 09:50:34.123 3 Log: Start Call
C 09:50:34.234 2 Log: VMail 230 Take message
C 09:50:34.274 2 Log: VMail 230 To operator mailbox 0
C 09:50:34.324 2 Log: VMail 0 To time control OPERATOR
C 09:50:34.364 2 Log: AutoA 00 Access
C 09:50:38.690 3 Log: Menu MAIN9711 09:50:34 Keys 8:Vm
C 09:50:38.690 3 H!KERNEL Debug: gRunCode <Vm>
C 09:50:39.641 1 Log: Menu MAIN9711 09:50:28 Keys *:Aa
C 09:50:40.252 1 Log: AutoA 160 Access
C 09:50:41.254 2 Log: AutoA 00 Blind Bl Connect 0
C 09:50:41.254 2 Log: Stop Call 09:49:36
C 09:50:47.383 1 Log: AutoA 160 Blind Bl Connect 160
C 09:50:47.383 1 Log: Stop Call 09:50:27
C 09:50:49.796 3 Log: VMail 249 To owner
C 09:50:55.815 3 Log: Owner 249 VN:0 VS:5 PN:0 PS:0 FN:0 FS:0
C 09:51:19.318 1 H!KERNEL Debug: wait(0) = 3.
C 09:51:19.328 1 Log: Start Call
C 09:51:22.723 1 Log: Menu MAIN9711 09:51:19 Keys 2:AaSTART
C 09:51:22.723 1 H!KERNEL Debug: gRunCode <Aa>
C 09:51:22.964 1 Log: AutoA 212 Access
C 09:51:32.838 1 Log: AutoA 212 Blind Bl Connect 212
C 09:51:32.838 1 Log: Stop Call 09:51:19
C 09:52:11.303 1 Log: Start Call
C 09:52:22.319 2 Log: Start Call
C 09:52:28.758 2 Log: Menu MAIN9711 09:52:22 Keys #:Pi #:Pi 9:Hu
C 09:52:28.758 2 Log: Stop Call 09:52:22
C 09:52:28.999 3 Log: VMail 260 To owner
C 09:52:32.894 3 Log: Owner 260 VN:0 VS:21 PN:0 PS:0 FN:0 FS:0
C 09:52:36.950 1 Log: Menu MAIN9711 09:52:11 Keys #:Pi #:Pi 9:Hu
C 09:52:36.950 1 Log: Stop Call 09:52:11
C 09:52:37.942 2 Log: Start Call
C 09:52:44.391 2 Log: Menu MAIN9711 09:52:38 Keys #:Pi #:Pi 9:Hu
C 09:52:44.391 2 Log: Stop Call 09:52:37
E 09:55:38.201 3 dialvox:DialVox/record:
D:\PATHFINDER\MESSAGES\0\6\VI260.M0C:8302:180 s=300 m=0 result=0 oh=5 s
C 09:55:40.534 3 Log: Stop Call 09:50:34

10:25:08 04 Log: Start Call
10:25:08 04 Log: Vmail 304 Access
10:25:27 04 Log: Menu Demo 10:25:08 Keys 2:
MnSALESMNU
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No Answer Log

This log shows that there was no answer at extension 621 when the call came through.

Auto-Attendant Logs

General Call Data

This is an example of someone calling extension 624. The extension is busy as written 
in the first line. The abbreviations CaScHo stand for (Ca) Supervised Transfer, (Sc) 
Screening, and (Ho) Holding.

In other words, the supervised attendant transferred the call; it was then screened, and 
put on hold. The second line shows that it was held only once. The third line shows that 
the phone system tried the line once again. The last shows that the phone system sent 
the caller to mailbox 1624.

Main Menu (No Action) Log

This log shows that the caller reached the MAINMENU and did not do anything. The 
menu took the Maximum Silence action which, was to hang up.

Operator (Blind Transfer) Call Log

This example shows that the caller pressed 0 at the menu and was transferred to the 
operator as a blind transfer.

Voice Mailbox Directory Log

This line shows that the caller pressed V for a directory of voice mailboxes.

08:13:07 11 Log: Notify (1) 621 NoAnswer at 621

09:23:16 05 Log: AutoA 624 Call 624 Busy CaScHo
09:23:25 05 Log: AutoA 624 Hold Holding 1
09:23:46 05 Log: AutoA 624 Call 624 NoAnswer
09:23:46 05 Log: AutoA 624 To mailbox

14:23:37 01 Log: Stop Call 15:00:55 H2: Max Silence

08:55:21 05 Log: Menu DEMO 08:55:20 Keys 0:0p
08:55:24 05 Log: Menu DEMO Transfer to Operator

11:07:23 04 Log: Directory Run:Vm
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Troubleshooting

This section gives technical information on how to diagnose problems that could occur 
on PathFinder. The information in this section is highly technical, and unless the 
procedures are performed as instructed, PathFinder may fail to operate. A good working 
knowledge of Windows 2000 Professional, DOS, NetMeeting, and PC-based systems is 
essential.

Technique

The most important troubleshooting technique is isolating problems. Typically, 
problems fall into four categories: 

� Problems with the telephone system

� Malfunctions in the PC hardware

� Problems with the operating system

� Problems with PathFinder

Problems with the Telephone System

Problems with the telephone system will cause problems in PathFinder during call 
transfers. The best way to determine if the problem is with PathFinder is to eliminate the 
possibility that the telephone system is the problem, as follows:

1. Pull a telephone list from PathFinder and plug it into either an analog telephone or a 
test set.

2. Simulate the action PathFinder should take.

� If the problem remains on the analog telephone, then the problem is within the 
telephone system.

� If the problem is solved by the analog telephone, then the problem may be 
within PathFinder.

Problems with the PC Hardware and/or Operating System

Problems with the PC hardware or operating system manifest themselves in various 
ways. Depending on the type of BIOS in the system, hardware problems may appear at 
the boot-up level or as an error reported by the operating system. The Event Viewer, 
Windows NT Diagnostics, and Control Panel programs are useful troubleshooting tools 
within the Windows NT Operating System.
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Problems with PathFinder

Problems with the voice processing software are typically related to time control 
configuration, message waiting indicators, message cascading and supervised 
transfers. The logs from the voice processing engine are vital to troubleshooting these 
types of problems.

PathFinder Won’t Start

1. Check the error log file (C:\PathFinder\Logs\Error.Log) for the following error:

ViewPort displays the following error:
 

2. Attach the software key (activator) to LPT1 on the PC. Refer to “Software Security 
Key” on page C-7 for more information.

How Can I Be Certain I Configured My Dialogic Boards Correctly?

The best way to determine if your Dialogic boards are configured correctly is to use the 
Universal Dialogic Diagnostic Utility (UDDU). Run the Dialogic Configuration Manager 
(DCM) to edit configurations. 

1. Access the UDDU program by selecting from the Start menu Programs > Dialogic 
System Software > Universal Dialogic Diagnostic Utility.

2. The system warns you that all Dialogic boards will be stopped; select Yes.

3. Select the type of board and type of tests that you would like to run. Consult your 
Dialogic documentation for details on available tests.

4. Investigate any failure.

5. If you get a failure in the PC Interrupt test, double check your IRQ settings on the 
board and in the Dialogic software.

Do not start the UDDU while any PathFinder software is running.

Please make sure the Sentinel key is
attached and the drivers are loaded.

Failed to wait for startup signal event.
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Questions & Answers

Q … Each time I try to start the voice processing engine, I get the following error: “TCP/IP
Connectivity is not set up correctly on this machine. I am unable to determine your host
name and address. Please install TCP/IP and related services before using Monitor.”

A … The TCP/IP protocol has not been correctly installed.

Q … Each time I try to start the voice processing engine, I get the following error: “Could not
start Dialogic service: Please reload drivers.”

A … The Dialogic® Board configuration software has not been run or has not been installed
properly. Consult the Event Viewer in the Administrative Tools program group to give
more information on the error. Please correctly configure your Dialogic board. Refer to
“Install and Configure Hardware” on page C-7.

Q … Message Waiting Indicators are not lighting on my system. What is wrong?

A … There could be several reasons, follow these steps when troubleshooting MWI:

Verify that you can set and clear message waiting indicators from an analog telephone.

Verify the MWI settings are correct. Access the MAINT application. Select from the menu
bar Configuration > Telephony Settings > MWI/Notification. Verify the Message Waiting
Set and Clear settings are accurate for your telephone system. Verify that the correct
Number Length is defined in the Number Length to Edit selection box is chosen.

Verify the E in @Ext is capitalized in the Message Waiting Set and Clear settings.

Verify there is no setting in the Class of Service > Notification > MWI Strings On and Off.

Verify the Message Waiting setting is not Off.

Verify there is at least one line (Line Settings) set to service the Event Group defined in
the Class of Service > Notification > Event Handler Group.

Verify that there is at least one task defined as MSGMAN for services event group one
under: Configuration > System Settings > Auxiliary Tasks.

Q … Calls are not being routed to extensions properly. 

A … First, replace PathFinder with a single line telephone set and verify that transfers work
properly without PathFinder. If you are unable to do hook-flash transfers with the single
line telephone then check all phone system settings and retry the test.

Start with Lines, verify the answer method, then check the Time Control menu that is
programmed to answer.

Verify the entire path by which a call is handled. Typical problems include incorrect Time
Control and Menu settings. Compare your Time Control and Menu settings with the
default Time Control and Menu settings described in this manual. Use the defaults
described in this book as a template to configure your Time Control and Menu settings.
PathFinder - System Administration December, 2003 - Issue 4.5



Troubleshooting 6-13

Chapter 6 - Back-Ups / Logs / Errors and Troubleshooting
Q … Call transfers are not working correctly.

A … Follow the steps below to troubleshoot call transfers. 

Verify the transfer is works properly with either a single line telephone or test set, then
attempt the transfer. If the transfer does not work properly with the single line telephone,
verify the telephone system settings, then retest. If this does not work, the problem is
within the telephone system.

Check to make sure that you have the correct prefix settings to perform a transfer. Select
from the menu bar Configuration > Telephony Settings > Transfer Settings. Make sure
the Transfer Prefix and Transfer Postfix are set correctly. Consult your telephone system
documentation for the correct settings.

Check the flash hook length setting is correct. To check this setting, select from the menu
bar Configuration > Telephony Settings > Transfer Settings. The setting should match
what is configured in your telephone system.

Q … Caller hears DTMF during an attempted transfer.

A … The flash hook setting is probably too short. To check this setting select Configuration -
Telephony Settings - Transfer Settings. The setting should match what is configured in
your telephone system.

Q … PathFinder seems to answer the call, but then hangs up almost immediately. What is
wrong?

A … Check your time control settings. PathFinder may be approaching the end of a time control
setting. If there is no definition for the current date and time, PathFinder doesn't know
what to do and hangs up. Additionally, review the logs for Hx settings to determine the
type of hang-up PathFinder is performing.

Q … Supervised transfers are not working on my system.

A … There could be many causes of the problem. See below for possible solutions:

When you select a telephone system, PathFinder creates a series of subscribers. The
default subscribers are programmed to use blind transfers. We recommend using blind
transfers unless required by the customer.

PathFinder may require the ring and busy tones to be learned by PBXpert. Refer to
Appendix B , " PBXpert for Call Analysis".

If you are using Supervised Transfers, the extensions using supervised transfers should
not be set to Forward on Busy or No Answer. Also, any recall times in the telephone
system are disabled.

Q … Call Queuing does not work. 

A … For call queuing to work, you must use supervised transfers and call holding must be
enabled. Additionally, call queuing must be enabled in the Class of Service.
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Q …  PathFinder does not answer calls.

A … There could be many causes of the problem. See below for possible solutions:

Verify the calls are routed to the voice mail system by substituting an analog telephone or
test set for PathFinder. If the phone does not ring, check your Hunt Group or Phone system
settings.

If the line is ringing, move the phone line to another voice processing port. If PathFinder
does answer, the problem is likely with the voice processing board. First run the Universal
Dialogic Diagnostics program found in the Dialogic System Software program group. If
any errors occur, correct the problem and re-test.

Check the Number of rings before system answers incoming calls field in the
Configuration > Telephony Settings > Rings window. It should be set to a number
between one and three. If the number is too high, it may give the impression that
PathFinder is not answering.

If PathFinder occasionally does not answer calls during heavy traffic periods, it is possible
that the hunt group on the telephone system is not configured correctly. Check all
telephone system programming.

Q … It takes a long time to release the line after a caller has hung up.

A … PathFinder detects a loop current disconnect by default. The telephone system you are
using may not use loop current disconnects. Consult your telephone system manual to
verify the telephone system does not use loop current disconnects. If the telephone
system does not support loop current disconnects, PBXpert needs to be run to learn the
tones. Refer to Appendix B , " PBXpert for Call Analysis".

Q … How do I record prompts for the Menus I created?

A … There are two ways to record Menu prompts:

Boom Box allows you to record menu prompts via the sound card in your computer or via
the Dialogic board on PathFinder.

Record Prompts, when set as a Key Action in a Menu, allows access to prompts in that
Menu level. Refer to “Key Action Definitions” on page 3-76.
PathFinder - System Administration December, 2003 - Issue 4.5



A Command Files &
Notification Scripts

Command Files are used in PathFinder to expand the basic capabilities to meet the needs 
of special notification/paging systems, phone systems, TIE lines, and special 
installations. Command files can be used in many places, such as:

� Mailbox notification (refer to “Notification Settings” on page 3-64)

� Extension / Mailbox forwarding (refer to “Setting Up Phone Lines” on page 3-85)

� Time controls (refer to “Time Control Settings” on page 3-79)

� Directly from a menu (refer to “Editing a Menu” on page 3-73)
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Command Files

A command file is an ASCII text file with one command per line. An ASCII text file is 
also known as a plain text file. You can use any editor, including Microsoft Word, 
Notepad, or Edit to create a Command File. Be certain when using any editor to save 
the file in a “Text Only” format. One command per line means that each command 
should be on a single line. 

For example … to dial a number and Quit, the file must look like this: 

Dial=9,17701234567

Quit

When typed as follows, the file does not work:

Dial=9,17701234567 Quit

Guidelines

Only the commands listed below may be used. Any other lines are discarded. 

� If a line starts with the “;” (semicolon) character then the rest of the line is ignored. 
For example, this command is ignored by PathFinder because of the semicolon in the 
beginning of the line. (;Dial 9,17701234567)

� In the list below, items in brackets (< and >) are variables and represent strings 
that you must supply. In the Command Descriptions below we describe what type of 
variable to use. For example, Call=<DTMFString> means that the command 
string uses a DTMF String to determine what number to call. A DTMF string is a 
series of DTMF tones, like pressing keys on a telephone key pad. 

� Anytime a <Mailbox> or <Extension> appears, leaving it out causes the 
command file to use the global mailbox and extension. Typically, the global mailbox 
or extension is the last mailbox or extension accessed by PathFinder.

Command Descriptions

Command / String Action Description

`<0-6>=<Command...> Executes the 
<Command..>. 
Sunday=0, 
Monday=1, …, 
Saturday=6.

if today's day of week matches

Related Commands: Time

AbortIfNoNewVoMsgs Aborts command 
file…

if no new messages, or new urgent 
messages are in the global mailbox.

AbortIfNoPages Aborts (Quits) the 
command file…

if no paging messages exist.
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Call=<DtmfString> Calls the number. Using the Call feature is like using 
supervised transfers when transferring 
an Auto-Attendant call to an extension. 
The voice mail system remains on the 
line and listen to the Call Result.

This command is not complete until a 
Connect, Busy, or NoAnswer is detected.

NOTE: The “Call” command works in 
conjunction with the CallResult 
command.

Related Commands: CallResult, 
OffHook, Sleep

CallExtension Calls the global 
extension.

Using the Call feature is like using 
supervised transfers when transferring 
an Auto-Attendant call to an extension. 
The voice mail system remains on the 
line and listen to the Call Result.

NOTE: The “Call” command works in 
conjunction with the CallResult 
command.

Related Commands: CallResult, 
OffHook, Sleep

CallMailbox Calls the global 
mailbox.

Using the Call feature is like using 
supervised transfers when transferring 
an Auto-Attendant call to an extension. 
The voice mail system remains on the 
line and listen to the Call Result.

NOTE: The “Call” command works in 
conjunction with the CallResult 
command.

Related Commands: CallResult, 
OffHook, Sleep

CallMailboxWhere Calls the number in 
the Notification 
Number setting of 
the global mailbox. 

Using the Call feature is like using 
supervised transfers when transferring 
an Auto-Attendant call to an extension. 
The voice mail system remains on the 
line and listen to the Call Result.

NOTE: The “Call” command works in 
conjunction with the CallResult 
command.

Related Commands: CallResult, 
OffHook, Sleep

Command / String Action Description
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CallResult<07-12>=<Command...> Branch on result of a 
call; 7=busy, 8=no 
answer, 10=connect.

The command in the <Command…> 
field is executed if the CallResult<07-
12> is true.

You can enter a block of commands to 
run if a specific call result is met.

For example … you can have the 
following commands executed if the 
CallResult is a connect:

- CallResult10=DialMailbox

- CallResult10=OnHook

- CallResult10=Quit

If the call is connected then we dial the 
mailbox number, go on hook, and quit 
the file.

NOTE: CallResult does not work when 
used in conjunction with the Dial 
command. You must use the Call 
command.

Related Commands: Refer to example 
below for additional information.

CancelPendingNotifies Cancels all pending 
notifications for the 
global mailbox.

The command deletes all queued 
notification requests. It does not modify 
paging files.

CommandFile=
<NewCommandFile>, <Path>

Runs another 
command file.

The <NewCommandFile> variable is the 
name of the alternate command file. 
The <Path> variable tells the exact path 
to find the <NewCommandFile>. The 
command is typically called: 
CommandFile=CFILES/000.CF,0

The <Path> is a numeric value and 
matches the path settings in the 
Registry.

The command file listed in 
<NewCommandFile> executes all 
commands and terminates It does not 
return control to the originating 
command file.

Debug=<On|Off> Turns CommFile 
debugging on/off.

This writes debugging information to the 
daily log files.

DebugOff Turns CommFile 
debugging on/off.

This writes debugging information to the 
daily log files.

DeleteAllNewMessages Deletes all new 
messages…

for the global mailbox.

DeleteAllPages Deletes all pager 
messages…

associated to the global mailbox.

Command / String Action Description
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DeliverNewFax=<Dtmf String> Delivers new faxes… to the number specified or to the 
mailbox Notification Number field if 
none specified. Always uses the global 
mailbox.

Dial=<DtmfString> Dials the number in 
the <DtmfString>.

Using the Dial command is like using 
blind transfers in the Auto-Attendant. 
PathFinder only dials the number and 
immediately execute the next 
command. It does not listen on the line 
to check if the call was connected.

NOTE: The Dial command does not work 
with the CallResult command.

Related Commands: Sleep, Dial

DialExtension Dials global mailbox. Using the Dial command is like using 
blind transfers in the Auto-Attendant. 
PathFinder only dials the global mailbox 
number and execute the next 
command. It does not listen on the line 
to check if the call was connected.

Related Commands: Sleep, Dial

DialMailbox Dials global mailbox 
and mailbox 
number.

Using the Dial command is like using 
blind transfers in the Auto-Attendant. 
PathFinder only dials the global mailbox 
number and execute the next 
command. It does not listen on the line 
to check if the call was connected.

Related Commands: Sleep, Dial

DialMailboxBeeperFile

DialPagerFile

Dials the digits 
found in the latest 
page or message.

Dials the digits left as a pager message 
in the mailbox. For example, if you call 
this command in the Command File and 
there was a pager message in the 
mailbox, PathFinder would outdial the 
DTMF tones left as a pager message.

If no page message is sent, then 
PathFinder dials the mailbox number.

Related Commands: 
PreventMboxAsPage

DialMailboxWhere Dials the number in 
the Notification 
Number setting of 
the global mailbox.

Using the Dial command is like using 
blind transfers in the Auto-Attendant. 
PathFinder only dials the number and 
executes the next command. It does not 
listen on the line to check if the call was 
connected.

NOTE: The Dial command does not work 
with the CallResult command.

Command / String Action Description
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DialMsgSource Dials digits in Msg 
Source…

if a message is forwarded to your 
mailbox, the Command file sends the 
originating mailbox number.

DialNewMsgCount

DialSavedMsgCount

DialNewOnlyMsgCount

DailUrgentMsgCount

Dials DTMF digits… representing the New or Saved voice 
message counts for the global mailbox.

DialPrefixForWhereField Dials the dialing 
prefix defined in the 
Registry based on 
the length of the 
number in the 
Notification number 
field of the global 
mailbox.

For example, the registry contains the 
variable “AaDialPrefix07=9,”. The 
notification number from the global 
mailbox has 7 digits. When sending the 
DTMF for the Call or Dial commands, we 
first dial <AaDialPrefix07>, then the 
number defined in the Notification 
number for the global mailbox. More 
specifically, we are sending a 
notification for mailbox 1221 with a 
notification number of “1234567”. The 
command file is written as:

- OffHook

- Sleep=1

- DialPrefixForWhereField

- DialMailboxWhere

PathFinder would go off-hook, sleep for 1 
second, dial “9,” and then “1234567”.

Related Commands -- DialMailbox

DoMessageRetrieval=<Mailbox> Allows message 
retrieval.

Allows the caller to retrieve and 
manipulate messages as if they were 
calling into PathFinder accessing their 
voice mail box as an owner.

Dtmf <String>=<Command...> Reads Branch on 
Dtmf…

if the <String> value matches the value 
received in DtmfRead, then perform the 
<Command>.

Dtmf 34567=Dial=7701234567

If PathFinder receives the string “34567” 
from the “DtmfRead” command, it dials 
the DTMF number “7701234567”.

Related Commands:DtmfRead, 
WriteDtmf

Command / String Action Description
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DtmfRead=
<count>, <terminate>, <time>

Reads DTMFs. PathFinder either waits for these digits or 
if the digits are already in the buffer 
(the caller has already entered the 
digits) PathFinder does not have to wait. 
The command waits for 3 terminating 
conditions: <count> digits are read, one 
of the digits specified in the 
<terminate> parameter is read or 
<time> seconds passes.

An example of a command is:

DtmfRead=5, 7, 10

Where PathFinder waits for 5 digits, 7 is 
the terminating digit and PathFinder 
waits 10 seconds.

Related Commands: Dtmf<String>, 
WriteDtmf

Echo=<On|Off> Turns Status on/off. Echo toggles command line debugging 
on and off.

Extension=<Extension> Transfers to the 
<Extension>.

Takes the action defined in the 
<Extension>'s actions. If no extension 
is defined, it uses the global extension.

GlbMailbox=<mailbox number> Changes the global 
mailbox to a new 
mailbox.

Normally, when command files are used 
to do mailbox notification (or in paging 
systems), GlbMailbox is set to the 
mailbox number doing the notify. This 
command could be used to change the 
global mailbox. This is common for 
cascaded pagers.

HangUp=<Command...|Off> On hangup does 
(DtmfRead only).

If you receive a HangUp command while 
reading DTMF digits with the 
“DtmfRead” command, then perform the 
command in <Command>.

HangUp=DialMailboxWhere

If Hangup=Off, PathFinder does not look 
for a hangup event and continues to 
wait for DTMF digits.

Related Commands: DtmfRead

Line <00-32>=<Command...> Checks current line. It is a command used to branch based 
on if the current channel is “correct”.

For example … to change something on 
line 5, you would use:

Line05=Call=9,7706621503

Command / String Action Description
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LoadMailboxBeeperFile Loads the next page 
message into 
memory…

when DialMailboxBeeperFile is called, 
PathFinder does not have to hit the disk.

Helps speed up the notification process.

Related Commands -- 
DialMailboxBeeperFile

Log=<LogString> Logs the string to 
the daily log file in 
the <LogString>.

The <LogString> variable can be 
anything you would like.

The <Path> is a numeric value and 
matches the path settings in the 
Registry.

LogCallResult Logs call results in 
the daily log file.

The log line looks similar to this:
Related Commands: CallResult

Mailbox=<Mailbox> Opens the mailbox 
defined in 
<Mailbox>.

Takes the action defined in <Mailbox>'s 
actions. If no mailbox is defined, it uses 
the global mailbox.

Menu=<Menu Name> Runs the Menu… Defined in <Menu Name>.

Module=
<ModulesName>, <glb_parameter>

Runs module in 
<ModulesName>. 

If the Module requires any parameters 
use the <glb_parameter> to define the 
parameters.

MsgSourceOk=<Command…> Branch to run 
<Command>…

if a new message has been forwarded to 
your mailbox.

Related Commands: DialMsgSource

NewMessagesXXX-XXX=
<Command..>

Executes the 
command based on 
the new message 
count.

Indicates different commands to be 
executed based on the number of new 
messages.

Notify Does notification for 
the global mailbox.

This is used to restart notification for 
the global mailbox if PathFinder has not 
extinguished the notification retries. 
This is similar to the “Pager Uses 
Retries” field in the COS record. Pager 
Uses Retries is not active for command 
file paging. Use the Notify command to 
force using retries.

OffHook[=Delayed] Takes phone off-
hook.

If “=Delayed” is specified, then the 
phone is not placed off- hook until a dial 
or call is actually executed. This is useful 
when the time between the Off-Hook 
and Dial is too long.

Except for notification, the phone line is 
typically already off-hook. Doing a 
second off-hook does not affect 
anything.

Command / String Action Description
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OnHook Puts phone on-hook. Typically, this command is used to place 
the line On-hook after completing a call.

CAUTION: In a very active system, this 
command could cause PathFinder to 
answer an incoming call before 
PathFinder is ready.

Related Commands: OffHook, Quit

PlayFirstMessage=
[ New | Save | Kill | Delete ]

Plays the first 
message.

Without a parameter, the message is left 
as a new message. You may also specify 
Save, Delete, or Kill to act on the 
message.

New leaves the message as new in the 
mailbox.

Save marks the message as saved in 
the mailbox.

Use Kill or Delete to remove the 
message after playing.

The person receiving the call is not able 
to manipulate the message after 
listening to the message. In other 
words, they are not able to save, delete, 
or forward the message.

Related Commands: Dial, Call

PlayMailboxGreeting Plays the Standard 
mailbox greeting…

for the global mailbox.

PlayVoicePage Plays the next voice 
message file.

Should only be used on voice pagers.

Related Commands: PlayFirstMessage.

PreDialDelay=xx

PostDialDelay=xx

Uses the pre and 
post dial delays to 
pause between 
taking the phone 
off-hook and dialing.

These statements are only useful if 
OffHook=Delayed is also used. 
Normally, these are only used when the 
execution of the command file is 
progressing too slowly to use the 
Sleep=X command.

Related Commands: OffHook, Sleep

PreventMboxAsPage Prevents the 
mailbox number 
from being sent as a 
page message.

If a page message is left in the mailbox 
and the pager notification is initiated, 
you typically would want the page 
message sent. If the caller didn't leave a 
page message, but left a voice 
message, then you can use this 
command to continue the execution of 
the command file.

Related Commands: 
DialMailboxBeeperFile

Command / String Action Description
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ProcessNextEvent Processes the next 
event for this 
channel group.

This is used to speed up the event 
handling because the channel does not 
have to go back to the wait state. If the 
next event is a notification event, then 
PathFinder can process it much more 
quickly than if the command file did a 
“Quit” and returned to the main loop. If 
no events are due for this channel, then 
the next instruction in the command file 
after “ProcessNextEvent” is executed.

Quit Quits this command 
file.

PathFinder then puts the line on-hook 
and prepares for another call.

Typically, this is the last line in the file 
because it ends the command file. If 
PathFinder reaches the end of a 
command file, a “Quit” command is 
implied.

Related Commands: OnHook

RestartIfNewMessage Restarts command 
file (with the same 
global mailbox)…

if new voice messages exist.

Say=<FileName>, <Path> Says a file. Plays the prompt file listed in 
<FileName>. The <Path> variable tells 
the exact location to find the 
<FileName>.

Sleep=<SecondsToSleep> Pauses for the 
specified seconds.

This allows PathFinder to wait for a 
number of seconds before performing 
the next command.

Related Commands: Dial, Call

Status=<StatusString> Shows string in 
status box.

Status allows you to change the run-
time status associated with a line. This 
is what you see in monitor in Windows 
NT voice mail systems.

Time<HH:MM>-<HH:MM>=
<Command...>

Executes the 
command…

if the current time falls between the 
times. First time must be the lowest and 
you cannot wrap around to the next day. 
For example:

- Time10:00-00:30=DialMailboxWhere

- Is not valid. To accomplish the same 
thing use:

- Time10:00-11:59=DialMailboxWhere

- Time00:00-00:30=DialMailboxWhere

Version Sets a local 
variable…

indicates the version of the Command 
File.

Command / String Action Description
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WaitForEvent=<Seconds> Waits the specified 
number of seconds 
for an event.

 An event is defined as an incoming call, 
hangup, interline message, etc.

WaitResultX=<Command..> Uses WaitResultX to 
break out the 
message.

Waits for the result of the event in the 
“WaitForEvent” and execute the 
<Command> based on the result. The 
“WaitResultX” has a similar function to 
“CallResult”

Related Commands: WaitForEvent

WriteDtmf=<FileName>, <path> Appends Dtmf 
contents to file.

Write the DTMF string received in 
<DtmfRead> to the <FileName>. The 
<FileName> is in the <path>.

WriteDtmf=Kelly.txt

Related Commands: DtmfRead, 
Dtmf<String>

Command / String Action Description
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Quick Commands

QuickCommand=<command sequence>

Quick commands allow you to substitute the longer command strings with the shorter 
mnemonic replacements described. Additionally, processing of the command file is 
much faster when using mnemonics.

Quick Command List & Descriptions

The Dw, Tw and Dp commands are preloaded so that certain commands will execute 
quickly (i.e., page file or the mailbox's Where field).

Table A-1: Quick Command Descriptions

Command Description

Ap Abort if no pages

Dp DialMailboxBeeperFile, dials pager file

Dw DialMailboxWhere

Ne ProcessNextEvent

No Notify

Of OffHook

On OnHook

Pm PlayFirstMessage, followed with d=Delete, s=Save n=New

Qu Quit

Rn Restart if new messages.

Rp Restart if pages exist

Sl Sleep, requires one digit seconds, Sl5 = Sleep=5,Sl5Sl5=Sleep=10

Tw Where field is timed. (placed before Dw)

Za Zap (erase) all messages
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Quick Command Example

QuickCommand=OfSl1DwSl3DpSl1OnNeQu is equivalent to:

Even though this is not as quick, it works.

Combining Quick Commands

You may also combine Quick Commands and regular commands as follows:

OffHook

Sleep=2

DialMailboxWhere

Sleep=3

DialMailboxBeeperFile

Sleep=1

OnHook

ProcessNextEvent

Quit

QuickCommand=OfSl1DwSl3

DialMailboxBeeperFile

Sleep=1

QuickCommand=OnNeQu
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Pre-Defined Command Files

File Names & Location

The self-contained voice mail unit has several pre-defined command files located in the 
\PATHFINDER\CFILES subdirectory. They have the following file names:

The numeric portion of the name describes the number of seconds after dialing the 
pager number (but before sending the mailbox digits to the paging company). 

Pager Notification

When creating a command file for pager notification, the timing of the digits to be sent 
from the voice mail system to the pager is critical. The command file must be 
synchronized with the timing of the pager being used.

When determining the timing of the pager:

1. Call the pager company.

2. Calculate the amount of time from when you dialed the last digit to the pager 
company and the time the pager company asks for the digits to be sent to the 
pager.

3. Modify the Sleep time to be the time you calculated for the digits to be sent to the 
pager.

4. Contact Technical Support if more information is needed.

PAGER10.CF

PAGER12.CF

PAGER14.CF

PAGER16.CF

PAGER18.CF

PAGER20.CF

PAGER22.CF

PAGER24.CF

PAGER6.CF

PAGER8.CF

006.CF

008.CF

010.CF

012.CF

014.CF

016.CF

018.CF

020.CF

022.CF

024.CF

106.CF

108.CF

110.CF

112.CF

114.CF

116.CF

118.CF

120.CF

122.CF

124.CF
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Sample Pager Files

The following examples illustrate how these two pager files might be set up: 

Modifying Command Files

Use a text editor such as Notepad.exe to view or modify a command file. 

PAGER10.CF

(similar to PAGERXX.CF and 0XX.CF files)

110.CF

(similar to 1XX.CF files)

OffHook OffHook

Sleep=2 Sleep=2

DialPrefixForWhereField DialPrefixForWhereField

Sleep=3 Sleep=3

DialMailboxWhere DialMailboxWhere

Sleep=10 Sleep=10

DialMsgSource DialMailbox

MsgSourceOk=Dial=* Dial=*

Dial=* DialUrgentMsgCount

DialUrgentMsgCount Dial=*

Dial=* DialNewOnlyMsgCount

DialNewOnlyMsgCount Dial=*

Dial=* DialSavedMsgCount

DialSavedMsgCount Dial=#

Dial=# OnHook

OnHook Notify

Notify Quit

Quit
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Command File Example

A sample command file that mailbox 232 would use for notification is listed below.

The file first takes the phone off-hook and dials a beeper number.

� If a connect is detected (CallResult=10), mailbox number is sent and the file Quits.

� If we do not get a connect, the file calls another phone number and, upon a 
connect, sends the last message received.

� If the last number does not answer, we schedule another notify.

The sleep= commands are used to give the phone line time to settle.

Figure A-2: Command File - Sample

; Mailbox 232's notification file

OffHook

Sleep=1

Call=9,#

Sleep=2

; If connected - then send the mailbox and hang-up

CallResult10=DialMailbox

CallResult10=OnHook

CallResult10=Quit

; If connection fails - try another number.

OnHook

Sleep=1

OffHook

Call=9,011241230909

Sleep=2

; If we got a connect then play the message and hang-up.

CallResult10=PlayFirstMessage

CallResult10=OnHook

CallResult10=Quit

; Still no connect, so re-schedule notification.

OnHook

; The next two lines are simple time of day services.

DayOfWeek0=Console=Today is Sunday

Time10:00-14:00=Console=Time us between 10am and 2pm.

; The next 2 lines demonstrate linking of time of day

; commands.

DayOfWeek3=Time10:00-10:30=Status=Wed 10:00-10:30am

DayOfWeek6=Time08:00-17:00=Menu=SAT_WORK

; Re-issue another notify

Notify

; Quit this command file

Quit
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B PBXpert for Call Analysis

PBXpert allows the voice processing boards to learn the ring back, busy, do not disturb, 
and other tones relevant to voice processing.
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Overview

This section covers the configuration of PBXpert software.

The PBXpert software learns the tones and creates a tone set file for your telephone 
system. PBXpert configuration involves walking through a Wizard program.

Requirements

To configure PBXpert, you need the following:

� Telephone system with 2 analog lines plugged into the Dialogic boards and 
extension numbers for those ports

� Dialogic voice board loaded into the PC with the memory address and IRQ 
configured correctly

� PathFinder software installed

� Dialogic drivers installed

� PBXpert software installed

Start Up Mode

Before running the PBXpert Wizard, the Dialogic drivers need to be started. Either run 
the PathFinder Engine and then stop the PathFinder Engine, or perform the following 
steps:

1. Select from the Start menu Programs > Dialogic System Software > Dialogic 
Configuration Manager - DCM.

2. Click on the Start Service icon in the toolbar (identified by the green dot).

You only need to configure PBXpert if you are using supervised transfers AND you 
are not running on a phone system that appears in the certified list.
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PBXpert Software

Using the Wizard

1. Select from the Start menu Programs > Dialogic System Software > PBXpert.

2. The PBXpert Wizard “Welcome” window will display.
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3. Click Next to display the “PBX Information” window.

4. Type in the PBX Manufacturer and PBX Model number. The Tone Set file name is 
created automatically from the Manufacturer and Model number.

5. Click Next to display the “TAPI Information” window.
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6. Leave the TAPI PBX strings set to None, and click Next to display the “Select a 
Board” window.

7. Choose the Dialogic Board Type to match the board you are going to use for testing, 
then click Next. The “Select the Calling Resource” window will display.

8. Select the first channel to use for testing.

9. Type in the extension number that this channel is using.
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10. Click Next and a second “Resource Selection” window will display.

11. Select the second channel to use for testing.

12. Type in the extension number that this channel is using, and click Next. The 
“Settings Confirmation” window will display.

13. Confirm your settings, then make certain that Run Wizard Auto-Test is selected.

Auto Test will verify that the correct channel is plugged into the correct extension.

If you get an error during the Wizard Auto Test, confirm your settings and re-test.

Channels 1 & 2
are in one port,

Channels 3 & 4
are in the next port.
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14. Click Next to display the “Auto Line Test” window.

15. When the Wizard Auto Test is successful, click OK. The “Learning Tones” window will 
display.
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16. Click Next to start the test, a “tone activity” window will display.

The Wizard will run a series of tests to learn the tones of the phone system. This 
learning process will take several minutes.

» » » To hear the test, check the “Sound at ON” box

17. If the data registers all green lights in the “Tone” column, click Keep Data.

18. When the “Verifying the Learn” window displays, click Next to start the tone 
verification process.

If there are any red lights, re-run the test.
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The “Consolidated Data” window will display during the process.

WARNING -- This portion of the test does not perform as you might expect, 
however, it will not affect the tone frequencies that are reported.

For example … if “Sound” is checkmarked, you will also hear other tests being run 
that do not relate to the tone frequencies being tested for your system.

19. Wait for the “Test process complete” message to appear, then click OK … regardless 
of the results (red or green).

20. When the “Summary of Results” window displays, click Finish to see the raw data 
presented in a useful table.

21. To close the PBXpert program, select File > Exit from the menu bar.
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Frequency Comparison

PBXpert - Summary of Results

This chart shows the final results from the frequency tone tests generated by PBXpert.

PathFinder - Perfect Call

This chart shows the PBXpert test results for the Perfect Call settings to be entered into 
the PathFinder MAINT application.
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Advanced Tone Features & INI File

1. Select from the Start menu, Programs > Dialogic System Software > Tone Features.

2. Make certain Disconnect Tone Supervision and Tone Set File Enabled are 
selected.

3. Choose the correct tone file from the \Dlgcdev\Dialogic\Data directory. The TSF 
(Tone Set File) name is a combination of the PBX Manufacturer and Model number.

4. Click OK.

5. Select from the Start menu, Programs > Windows NT Explorer.

6. Double-click on the PATHFINDERNT directory. 

7. Double-click on PATHFINDERNT.INI. This opens the PATHFINDERNT.INI file in 
Notepad.

8. Find the [VoiceHardware] section. Go to the bottom of the section and type 
use_perfect_call=1. 

9. Save the file and exit.

PBXpert Data Transfer

Entering New Call Settings in MaintNT

1. PBXpert is a Dialogic software tool that learns the different tone frequencies and 
durations that a PBX generates during different parts of a phone call to indicate 
what is happening, and is used with Pathfinder/MaintNT in order to enable Dialogic’s 
“PerfectCall” call analysis, and to enable certain types of hang-up supervision.

2. The following tones are learned by PBXpert, entered with MaintNT, and used by 
Pathfinder:

� Dial Tone

� Busy

� Ring

� Fax [optional]

3. MaintNT is a Vodavi software program used to configure Pathfinder. This 
documentation is intended to help you understand how to use the information you 
learn in PBXpert to configure Pathfinder to correctly understand the tones your PBX 
generates.

4. PBXpert results MUST be installed manually using MaintNT, you cannot install them 
using Dialogic’s PBXpert or DCM programs as .TSF files. It does NOT work correctly 
with Pathfinder that way.

5. Use the Dialogic PBXpert documentation to configure and run PBXpert connected to 
your PBX in order to learn the tones for your PBX. You MUST successfully run 
PBXpert tests on your PBX in order to succeed in configuring PerfectCall on your 
Pathfinder to make any type of supervised transfers or outbound calls.
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6. Look at the tone information on the PBXpert screen:

7. Run Pathfinder MaintNT.

8. Click on Configuration and select Telephony Settings.
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9. Click on Perfect Call.

10. Input the values for Ring in the Ring Back 1 values, Busy in Busy1 and Dial tone in 
Local, in the MaintNT screen. “Freq” stands for frequency, “Dev” stands for 
Deviation (+/- from target frequency).

If you have a single frequency tone, do not enter Freq2 and Dev2.

The Count value for CONTINUOUS tones should be 0 and for cadences, it should be 
the number of times that the pattern should cycle on/off. (rule of thumb, 2-3, more 
if you get false tone detections, especially for disconnect tones).

**Note, the time values in the PBXpert form are shown in units of ms and the 
values in Maintenance are shown in units of x10ms. For example, an on time 
of 450+/- 50 in PBXpert should be input into the MaintNT screen as 45 with a 
deviation of 5.

<on_time>
For cadences, length of time (in 10ms units) tone is "on".
For continuous tones, 1/2 of debounce time (in 10ms units).

<on_time_deviation>
For cadences, +/- deviation (in 10ms units) for on time.
For continuous tones, -1/2 of debounce time (in 10ms units).

<off_time>
For cadences, length of time (in 10ms units) tone is "off".
For continuous tones, 0.

<off_time_deviation>
For cadences, +/- deviation (in 10ms units) for off time.
For continuous tones, 0.
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11. To input Reorder or Disconnect tones:

a. Click on Configuration > Telephony Settings > Hang Up Detection Templates.

b. Next click on Set Tone Templates

c. At the Telephony Settings: Hang-up Detection via Tone Templates dialog window, 
click on Add.

d. At the Add Tone Template dialog window, fill in the values in the TSF file. (Again, 
the time values are different in PBXpert and in Maintenance.

Once finished, click OK and then OK at the next dialog window and finally Done at 
the Telephony Settings dialog window.

12. Finally, to implement the tones that you have now entered, click on Configuration, 
Telephony Settings, and click on the Transfer Settings button. Check the Use Perfect 
Call check box for all appropriate number lengths.

An excerpt about entering disconnect and other non-PerfectCall tones in Pathfinder…

Q: Tell me about tones on NT…

A: Tone Definitions 100

The time values in the PBXpert form are shown in units of ms and the values in 
Maintenance are shown in units of x10ms. For example, an on time of 450+/- 
50 in PBXpert should be input into the MaintNT screen as 45 with a deviation of 5.

Syntax of Tone Definition Parameters:
==================================
toneN=<tone_id> <repeat_count> <edge> <freq1> <freq1_deviation> <freq2> <freq2_deviation> <on_time> <on_time_deviat
<off_time> <off_time_deviation> <event_enable_mask> <wait_association> <hangup_association>
PathFinder - System Administration December, 2003 - Issue 4.5



B-16 PBXpert Data Transfer

Chapter  - PBXpert for Call Analysis
There can be up to 10 tones defined in a line definition file.

Tone Definitions 101
     (pre-requisite: Tone Definitions 100)

Summary of Parameters:
=====================
<tone_id>
<repeat_count>
<edge>
<freq1>
<freq1_deviation>
<freq2>
<freq2_deviation>
<on_time>
<on_time_deviation>
<off_time>
<off_time_deviation>
<event_enable_mask>
<wait_association>
<hangup_association>

Description of Parameters:
=======================
<tone_id>
Unique ID (>0) for each tone.  Avoid MFR2 tone IDs on E1/MFR2 systems!

<repeat_count>
For continuous tones, this should be 0.  For cadences, it should be the number of times that the pattern should cycle on/off.

<edge>
For continuous tones, this can be LEADING(2) or TRAILING(4) edge.  For cadences, this is ignored.

<freq1>
First frequency (in Hz)

<freq1_deviation>
Allowable +/- deviation (in Hz) for the first frequency.

<freq2>
Second frequency (in Hz)

<freq2_deviation>
Allowable +/- deviation (in Hz) for the second frequency.

<on_time>
For cadences, length of time (in 10ms units) tone is "on".
For continuous tones, 1/2 of debounce time (in 10ms units).

<on_time_deviation>
For cadences, +/- deviation (in 10ms units) for on time.
For continuous tones, -1/2 of debounce time (in 10ms units).

<off_time>
For cadences, length of time (in 10ms units) tone is "off".
For continuous tones, 0.

<off_time_deviation>
For cadences, +/- deviation (in 10ms units) for off time.
For continuous tones, 0.

<event_enable_mask>
Specify which tone events should be generated by Dialogic.,
0x01 TONE_ON
0x02 TONE_OFF
NOTE: Current H!NT implementation only supports TONE_ON.

<wait_association>
Flag indicating whether to generate events to wait() function if tone occurs.
0=No
1=Yes

<hangup_association>
Flag indicating whether to set hangup (H7) and terminate Dialogic operations if tone occurs.
0=No
1=Yes
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Tone Definitions 102
     (pre-requisite: Tone Definitions 100 & 101)

Single vs. Dual Frequency Tones
============================
Single tones have zero values for <freq2> and <freq2_deviation>.

Dual tones have non-zero values for <freq2> and <freq2_deviation>.

Continuous vs. Cadence Tones
===========================
Continuous tones have zero values for <off_time> and <off_time_deviation>.  To "debounce" leading edge continuous 
tones to prevent "talk-off", set the <on_time> to 1/2 of the desired debounce time (in 10ms units) and set the 
<on_time_deviation> to -1/2 of the desired debounce time (in 10ms units).

Cadence tones have non-zero values for <off_time> and <offf_time_deviation>.
PathFinder - System Administration December, 2003 - Issue 4.5



B-18 PBXpert Data Transfer

Chapter  - PBXpert for Call Analysis
PathFinder - System Administration December, 2003 - Issue 4.5



C Building a PathFinder

This chapter describes the PathFinder installation procedure, the initial analysis and 
preparation of your system prior to installing hardware and software. If you purchased 
a turnkey system, refer to “PathFinder Configuration” on page 1-5
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Hardware Configuration

Before You Begin

PC Requirements

These guidelines should help reduce the possibility of hardware-related problems with 
PathFinder.

Figure C-1: Minimum Computer Requirements

256 MB RAM Mouse

N.I.C. Card

Internal Modem

Dialogic Card
SVGA Monitor

Pentium III 850 MHz

Keyboard

40 GB Hard Drive

CD-ROM

3.5” Diskette Drive
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Server Requirements

The following table lists the minimum hardware and software requirements for the 
PathFinder Server application.

Installation/Configuration Process

1. Build a PC in accordance with the Windows 2000 Hardware Compatibility List (HCL).

Refer to the HCL hardware database at the following Internet address … 
https://winqual.microsoft.com/download/default.asp. Then click on “Win2000HCL”.

2. Install Microsoft Windows 2000 at a workstation with Service Pack 4 or higher and 
ensure that there are no errors in the error log files.

3. Install Network Interface Card (NIC).

4. Configure TCP/IP.

5. Configure AutoAdminLogon for PathFinder to automatically log in and start taking 
calls in the case of a power outage.

6. Install Dialogic card.

7. Install PathFinder software key.

8. Load PathFinder software CD

9. Configure “first-time” load.

10. Configure PathFinder settings.

Basic Server Application

Hardware

Processor Recommended: Pentium IV - 2.4 Ghz or higher

Minimum: Pentium III - 850 Mhz

Motherboard 4 PCI slots or higher

Memory Recommended: 512 MB or higher

Minimum: 256 MB

Drives 40-Gig Hard Drive 

CD ROM and Floppy Drive

Cards Voice Card(s) - Dialogic (refer to hardware list on page C-6)

Video Card - High Resolution (1024x768)

Network Interface Card (must be listed on the Windows HCL)

Modem 33.6 bps or faster (must be listed on the Windows HCL)

Software

(installed prior to PathFinder installation)

Operating System Windows 2000 Professional (Service Pack 4)

Windows 2000 Server

Browser Internet Explorer 6.0

Remote Diagnostics PC Anywhere ver. 10
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Performing a System Analysis

You must perform an initial analysis and prepare your system prior to installation of 
hardware and software.

Before starting the installation of PathFinder, you need to consider certain hardware 
requirements and recommendations. Having the proper hardware configuration is a key 
factor in PathFinder’s performance and reliability.

Determining System Size

The size of PathFinder can be measured in two ways:

� Amount of disk storage

� Number of ports

Once PathFinder is up and running, it generates a number of reports that allow you to 
accurately monitor use. In the meantime, the following guidelines will help you 
determine the proper hardware configuration.

Hard Disk Storage Size

Voice processing can require a large amount of disk space. Many applications are disk 
intensive, meaning they continually access information on the hard drive. For this 
reason, it is vital that you incorporate quality components in your system, especially in 
the case of the disk drive. The size of the drive depends on two factors: the application 
and the number of users.

GUIDELINES:

» » » 1 hour of message storage can support 30 users.

» » » 1 hour of voice storage requires 10 MB of disk space.

Storage Size Factors

Factors affecting the amount of storage needed include the following:

� Number of extensions and mailboxes required

� Number of messages received and accessed per day

� Average message length

� Message retention period

Number of Ports

The number of ports required depends on several factors, such as:

� Application size

� Time of day

� Average length of a transaction

� Average traffic and peak traffic loads

� Grade of service (the number of acceptable busy calls received)

GUIDELINES:

» Each port supports 25 users.

» If using Text-to-Speech or Desktop Call Control … allow 1 port for every 20 users to 
avoid the port from being used as a primary communication interface.
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PC System Placement

Consider the following when choosing the location for the PathFinder PC:

� The PathFinder is a server, so it should be placed in the same room or close to the 
area where the phone system is located.

� Provide a clean, relatively dust free space with adequate ventilation.

� The room should have a stable temperature and comply with the manufacturer's 
specifications.

� The PathFinder computer needs to be connected to a reliable source of power. 
Fluctuations in line voltage and power surges can impede operation and damage the 
PC or its components. An un-interruptible power supply (UPS) is recommended.

Telephony Hardware Compatibility

The following Dialogic cards are the currently supported interface boards for the 
PathFinder system:

4 Port - D/4PCI (Voice Card)

4 Port - D/41JCTLS (Voice/Fax Card)

4 Port - VFX/41JCTLS (Voice/Fax Card)

12 Port - D/120JCTLS (Voice/Fax Card)

Systems with RS-232 hookup for telephone integration or host connection must be located 
less than 50 feet from the source equipment. A short-haul modem is required if the distance 
spanned by the RS-232 hookup is greater than 50 feet.
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Install and Configure Hardware

Installation Overview

The steps necessary to set up system hardware depend upon the number of telephone 
lines (ports) your telephone system is designed to support, and any additional software 
modules (such as Fax Support) that have been purchased with PathFinder.

Some of the information contained in the rest of this chapter may not be applicable to 
you or your specific system setup. Check the section headings to determine which 
information in this chapter pertains to your specific hardware configuration.

Work Table -- should be located in a well-lit area with adequate space to remove the 
computer chassis. It should also provide adequate space to unpack and inspect the 
voice cards. An anti-static floor mat in the area in front of and under the worktable is 
highly recommended.

The following tasks must be completed to install and configure your system hardware:

1. Open the PC designated as the PathFinder server.

2. Install the Network board.

3. Install the Modem board.

4. Check the power connections of the floppy, harddrive, and memory boards.

5. Install the Dialogic boards.

6. Install the Software Key on an active parallel port.

Software Security Key

Included with PathFinder is a software security key. It is designed to unlock the various 
optional features of PathFinder.

The security key hardware resembles a male/female parallel connector that plugs into 
the parallel port on the back of the PC. If you have a parallel printer or other device 
attached to that port:

1. Remove the printer cable from the PC port, if attached.

2. Install the security key hardware on the printer port.

3. Attach the printer to the software key (in other words, re-attach the printer to the 
PC through the software key).

4. Reassemble the computer and prepare to load the software.

All cards are configured with default settings at the factory. However, you must 
confirm these settings prior to running PathFinder.

PathFinder will not function properly if the security key hardware is not installed.

If attaching a printer to the software key, any errors from the printer (e.g., out of 
paper or off-line) may cause PathFinder to go offline.
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Turnkey Systems

Before powering up the PathFinder system, make sure:

� all cards are properly seated,

-and-

� the disk drives are plugged in.

Dialogic® Products

Refer to “Telephony Hardware Compatibility” on page C-6 for more information on 
compatible voice cards.

Current Drivers

The PathFinder application uses Dialogic System Release 5.1.1 drivers.

Telephony Hardware Configuration

When using a PathFinder Kit, configuration instructions are included with the cards 
provided. It is important to configure these voice cards prior to installation.

Channels

The “D/4PCI” card, for example, supports up to four independent voice I/O channels 
each with a telephone line interface.

Each channel has the following capabilities:

� Record, digitize, and compress audio in real-time

� Play back previously recorded files

� Detect DTMF tones

� Generate DTMF and pulse tones for dialing

� Initiate and receive calls through the loop start telephone interface

Phone Line Assignments -- Boards are assigned phone lines as follows:

� The board with the lowest address is designated as the first board in the system and 
is assigned phone lines one through four. 

� The next lowest address is the second board in the system and contains lines five 
through eight.

PathFinder can have up to six voice cards in a turnkey PC. The number of available slots 
may vary for a customer-provided PC.
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Telephony Hardware Installation

After the cards are configured properly, install the voice card(s) in the PC.

PC Preparation

1. Turn the power off and disconnect the AC power cord.

2. Unplug any other cables from the PC including any peripheral device cables.

3. Remove the cover according to the manufacturer's instructions.

Physical Board Installation

1. Remove the screw that secures the expansion slot cover and remove the cover.

2. Insert the board, modular jacks facing the back of the PC, into an available PCI slot 
on the motherboard, using care not to apply excessive pressure on any of the 
components.

3. Gently press on the edge of the board and the bracket to securely seat it in the slot. 
Rocking the board forward and backward while applying pressure on its top edge 
helps seat it properly.

4. Align the notch in the board's bracket with the hole in the rear panel of the PC. 
Fasten it into place with the screw that was removed in Step 1.

Telephone Connection

Four-line or twelve-line voice cards (D/4PCI and D/120JCTLS models) use standard 
two-line RJ-14 modular jacks to connect to the phone system. The RJ-14 jacks on the 
four-line cards support two telephone lines or extensions per jack. 

On the D/41JCTLS, each RJ-11 jack on the rear bracket of the voice board supports a 
single voice channel. Use RJ-11 connectors and phone cable to connect each voice 
channel jack to a PBX or Central Office (CO).

Telephone connections are located on the right side of the four-line voice card. When 
connecting phone lines to four-line cards, follow these steps:

1. With the board components face up and the jacks on the right side, connect lines 
one and two to the top connector.

2. Connect lines three and four to the bottom connector.

Use an anti-static wrist strap and, if possible, an anti-static floor mat when installing voice 
cards.

Do not put the cover back on the PC without securely fastening the voice card to the 
chassis. Severe damage to the card could result if it is operated without being securely 
fastened to the PC chassis!

Lines one and three are inside pairs, and lines two and four are outside pairs.

PORT 2PORT 1

Ring

Tip

Ring
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Voice Network Attachment

Network connectivity is very important to the PathFinder advanced features. Some systems have a 
network interface built in to the motherboard which only requires software driver installation that is 
normally performed during the o/s installation. If a built-in interface is not available, you will need to 
insert the network card into an available slot. This will reduce the number of slots that can be used 
for Dialogic cards.

Direct Attachment to the Central Office

In this configuration, PathFinder is connected directly to the telephone company’s central 
office. However, with this configuration, PathFinder is unable to transfer callers to other 
extensions. The one exception is a Centrex/Essex connection. PathFinder can be 
connected to the central office using any of the following lines.

Analog Line

Analog lines are standard 48-v DC central office telephone transmission lines that use 
an RJ-14 connector.

Centrex/Essex Line

A Centrex/Essex line is a business telephone service offered by a local telephone 
company from a local central office. Centrex lines, like a PBX, provide such features as 
call transfer, call forwarding, call hold, and others, and they use an RJ-14 connector.

PBX Attachment

In the PBX (Private Branch Exchange) configuration, PathFinder is attached to the phone 
system through single line extension ports. This provides the greatest flexibility for 
running PathFinder modules and must be configured this way to process call transfers.

Analog Line

Your phone system must support analog (single-line) telephone sets with hunt group 
functionality, so that one line is busy, the call will roll over to the next line in the group. 
An analog line uses an RJ-14 connector, and must have the following capabilities:

� Flash-hook transfer
� Dial-out
� Place call on hold
� Re-connect
� Loop current disconnect

Proprietary Connections

Many phone systems have proprietary connection methods that require a special card 
to access their integration features. These include the SL1, NorStar, NEC, and Mitel 
switches. The type of connector used depends on the phone system. 

For PBX integration, refer to Chapter 2, Phone System Integration and Setup.

Dialogic is no longer updating these drivers, which means that Vodavi support may 
be limited.
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Install and Configure Operating System

This section covers installing and configuring your Windows 2000 operating system.

Before you can install the PathFinder software, you must install and configure the 
operating system in order to optimize conditions for running PathFinder.

Configuration

Before installing the PathFinder software, you must optimize your PC operating system 
for running PathFinder. This overall procedure consists of the following tasks:

� Setting up a Windows administrator account

� Configuring the operating system for automatic logon

Log On - Windows 2000

To set up a Windows 2000 administrator account, perform the following steps:

1. From the Start menu, select Settings > Control Panel.

2. Double-click Users and Passwords Control Panel.

3. Click Advanced tab.

4. Click Advanced button.

5. Click Users Folder in left explorer window pane.

6. Click Action > New User...

7. Type Pathfinder in the Username field.

8. In the Password field, type the serial number for your PathFinder software, then re-
enter the serial number a second time in the Confirm P/W field.

9. Clear the User must change password at next logon check box.

10. Select the Password never expires check box.

11. Click Create.

12. Click Close.

13. Click Groups Folder in the left explorer window pane.

14. Double-click Administrators group in the right Explorer window pane.

15. Click Add...

16. Select the local domain in the look-in bar, if not already selected.

17. Double-click the Pathfinder account.

18. Click OK.

19. Click OK.

20. Close the Local Users and Groups window.

21. Click OK on Users and Passwords window.
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Automatic Administration Logon

It is highly recommended that you set up the system to automatically log on to 
Windows. If you do not create an Automatic Administration Logon account, the system 
may not function correctly when shut down unexpectedly.

Auto Log On - Windows 2000

To allow the system to automatically log on to Windows 2000 each time the system 
reboots, do the following:

1. From the Start menu, select Run.

2. In the Open field, type Regedt32, then click OK.

3. Select HKey_Local_Machine/Software/Microsoft/Windows NT/Current Version/
Winlogon/DefaultUserName.

4. Type in the username (Pathfinder) that you created in “Log On - Windows 2000” 
on page C-11, then press Enter when you finish typing.

5. Click Edit.

6. Choose Add Value.

7. In the Value Name field, type DefaultPassword, then press Enter when you finish 
typing.

8. In the String field, type the password for the user name you created in “Log On - 
Windows 2000” on page C-11, then press Enter when you finish typing.

9. Double-click AutoAdminLogon.

10. Change the value to 1, then click OK.

11. Double-click DefaultDomainName and verify that the value is the name of the 
local domain or the desired logon domain. Change it if necessary, then click OK.

12. Click OK.

13. Close Regedt32.

Install Adapter

If you have a network adapter card (NIC) in your system, confirm that it is properly 
configured and operates within normal parameters (If an NIC is installed, you must 
enable TCP/IP protocol). To install a network adapter, follow the instructions provided 
by the network card manufacturer.

Create an Emergency Repair Disk before creating the Automatic Administration 
Logon account.
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Software Installation

This section describes how to install the PathFinder software and the programs needed 
to run this Voice Processing application.

Prerequisites & Preparation

You will install PathFinder software from the installation CD. You must also install helper 
applications, such as Adobe® Acrobat Reader® and Dialogic drivers.

Before you attempt to install the PathFinder software, ensure that you perform the 
following tasks:

� Install the software key and install and configure the voice cards. (Refer to “Install 
and Configure Hardware” on page C-7 for details.) 

� Install and configure Windows 2000.

Once you have performed these tasks, you are ready to install PathFinder software.

Dialogic Drivers

Any new PathFinder installation requires the Dialogic drivers installation.

If you are upgrading an existing PathFinder application, you must first disable and 
uninstall the existing drivers to install the new Dialogic drivers.

Sentinel Drivers

It is recommended that you always install or upgrade the Sentinel drivers. This ensures 
that the latest drivers are always loaded. Existing drivers do not need to be uninstalled 
prior to installation.

PBXpert

If you have a non-standard PBX, the PBXpert utility can train PathFinder for your phone 
system by learning tones such as busy, ringback, and disconnect.

For more information, refer to Appendix B , " PBXpert for Call Analysis".

Do not run other applications on the voice processing machine. Other applications 
may disable PathFinder features or functions.
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Install Software

All the required software, utilities, and drivers to install the PathFinder are located on the 
PathFinder CD provided.

» » » Make sure the software key is installed. Refer to “Software Security Key” on page C-7 
for more information.

Installation Setup Routine

1 - Starting the Installation Process

a. Insert the PathFinder CD into your CD-ROM drive.

b. From the Start menu, select Run . . . .

c. In the Open field, type <Your CD-ROM Drive Letter>:\setup.exe and click OK. 
(Example … If CD-ROM drive letter = d … type d:\setup.exe)

d. To start the Installation process, click Next when the Welcome Main Setup window 
displays.
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e. When the PathFinder Installation window displays the two installation package 
options, click Next.

f. Click Next when the Select Software System to Install window displays.The 
PathFinder Server Software is selected as it must be installed prior to the Client 
software (if purchased).
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g. Review the server software requirements when the new PathFinder Installation 
window displays, then click Next.

h. Click Next to install the necessary tools when the Drivers and Utilities Setup 
window displays.
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i. Click Next to continue when the Update Sentinel Drivers window displays.

j. If the software key has been installed, click OK when this Information window 
appears. (If current Dialogic drivers were previously installed, skip to Step 3.)
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k. Click Next to install Dialogic SR.5.1.1 Drivers, the installation setup will continue 
automatically.

l. Click OK when the Information window confirms that the Dialogic drivers have 
been installed.

m. Click Yes when the Question window displays: “Run Dialogic Configuration 
Manager?”.
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2 - Dialogic Configuration Manager Installation

For PathFinder to work properly, you must configure the Dialogic software to match 
the installed Dialogic hardware.

a. Click Connect when the Computer Name window displays to accept the default 
“Local” setting.

b. Select Action > Add Device when the Dialogic Configuration Manager window 
displays as shown.

c. From the Add Hardware Wizard window, select the “Family and Model” of the 
Dialogic board you want to install, then click Next.
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(The typical board selections are shown in this example.)

d. When the 2nd Add Hardware Wizard window displays, enter a name that will 
identify this board from other boards of the same model (i.e., serial number), 
then click Next.

e.
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f. When the Properties for “the selected card” window displays, click OK if the 
automatic values are acceptable (recommended).

g. The Dialogic Configuration Manager main window will return, showing the board 
settings selected. If you have multiple cards, repeat this procedure starting at 
Step 2.c. until all cards are configured.

h. Click the green “Start Service” button to make sure that the Dialogic cards have 
been set up properly.

i. When finished, select File/Exit to close this window.

The Drivers and Utilities Setup window will return.

Start Service
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3 - Acrobat Reader Installation

a. If you do not have Adobe Acrobat Reader 4.0 or higher, click Yes to install this 
program. (Reader will allow you to view the .PDF files included with the PathFinder 
software.)

b. Click Next when the Reader Setup window displays.

c. Click Next to select the default destination folder, then click OK to continue the 
installation process.

4 - RealSpeak & File Installation

a. Click Next to install the RealSpeak utility in the default “PathFinder” folder.

b. Click Next to finish installing the necessary program files.
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5 - PathFinder Voice Server Installation

a. Click Next when the PathFinder Server Setup window displays.

b. Review the information in the Software License Agreement window, then click Yes.
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c. Click Next when the Select PathFinder Installation Path window displays.

d. To create the default destination folder “PathFinder Voice Processing”, click Next 
when the Select Program Folder window displays.
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e. When the Setup routine has enough information to continue, the Start Copying 
Files window will display … click Next.

f. If ALL listed program options have been purchased, click Select All to place them 
in the “Startup Group” for easy access. Then click Next.

If all items have not been purchased, select only those program options that 
pertain or system errors may occur. Then click Next.
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g. The MAINT program option will be checked when the Select Components window 
displays … click Next to open the MAINT program and start the PBX Integration 
routine.

6 - Phone System Integration

a. When the First Time Questions window displays, select the “Don’t run wizard at 
startup” to prevent the wizard from reappearing each time you access the MAINT 
application.

b. Click Next to continue.

X
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c. In the next First Time Questions window, enter the required parameters in the 
Mailbox Length, Extension Length, and Password Length fields.

Important … The number of digits for mailboxes and extensions must match.

d. After completing this information, click Accept.

e. Select the phone system that PathFinder will be connected to, then click Select 
New.

Settings must match …

107 - VODAVI STARPLUS TRIAD 1
108 - VODAVI STARPLUS TRIAD 2
109 - VODAVI STARPLUS TRIAD 3
111 - VODAVI STARPLUS TRIAD-S
125 - VODAVI INFINITE DVX PLUS II
126 - VODAVI INFINITE DVX PLUS III
127 - VODAVI INFINITE DVX PLUS IV
128 - VODAVI INFINITE DVX PLUS Mach I

000 - DEFAULT PBX (3 DIGIT BLIND XFER)

135  VODAVI INFINITE DVX PLUS II (4 DIGIT EXT)
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f. Click Yes to accept the PBX shown in the Change PBX Integration window to 
confirm your selection.

g. When the next PBX Integration window displays, click Install to load the new 
parameters.

h. Click OK when the PBX Installed window displays to confirm that the phone system 
selected has been installed.

i. When the MAINT window returns, click File > Exit to close the application.

135 - VODAVI INFINITE DVX PLUS II (4 DIGIT EXT)
has  been  installed.
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7 - Exit Installation Routine

a. When the Setup Complete window displays, click Finish to end the software 
installation process.

b. The software program will close and your Desktop will appear.
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8 - Follow PathFinder Operating Guidelines

Is PathFinder running?

Once your computer reboots, the PathFinder system and all the programs placed 
in the startup group will open and appear in your PC taskbar.

You will be able to verify that PathFinder is working by checking the Viewport 
window to see call activity going to your CO lines.

What other application(s) should be running?

The following chart indicates which application(s) “need to be running” for 
PathFinder and the optional module programs to interface properly:

How should you close the PathFinder program?

To avoid possible system problems, use the following method to close the 
PathFinder application:

» First … stop the server (PathFinder window/Server/Stop Server Immediately)

» Second … exit PathFinder (ViewPort window/File/Exit)

(Shortcut Keys … Pressing ALT+F3 will stop the server AND close the window.)

If you try to close the PathFinder window using the  in the right-hand corner, 
the program will appear to be closed, but continue running in the background.
It will then be necessary to boot your computer in order to restart PathFinder.

What could cause the PathFinder program to appear stalled (not responding)?

If you happen to click inside the PathFinder program window with you mouse … 
this may cause the system to “Pause”.

To restart PathFinder … right-click in the program window and select “Resume”.

Data
Server

DCC
Swtchbrd

E-Mail
Sync Server

Networking
(VPIM)

PathFinder/
ViewPort

Unified Messg 
Server

DCC / DME / VVM � � �

Networking - VPIM � � �

PathFinder �

Text-to-Speech � �

Unified Messaging � � �
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Forms -- This appendix provides detailed Installation Forms that could be helpful when 
setting up the PathFinder application. These forms can be used to record current system 
settings, and referred to as needed in the case of multiple PathFinder systems and 
troubleshooting purposes. These forms contain the following types of information: 

Parts -- A list of PathFinder Part Numbers is located at the end of this section. It can be 
useful when placing an order to upgrade your system, purchasing an optional module, 
or if replacement parts are needed. Contact your Inside Sale Representative if you have 
any questions regarding any of the PathFinder parts.

BASIC INFORMATION (page 3)

Telephone System Information

Voice Mail Functions

Automated Attendant Functions

Voice Mail Equipment Considerations

SUBSCRIBER INFORMATION (page 5)

Mailbox Settings

Extension Settings

CLASS OF SERVICE (COS) INFORMATION (page 6)

General Settings

Message Settings

Maintenance Settings

Notification Settings

Auto Attendant Settings

MENU INFORMATION (page 8)

Day Settings

Night Settings

Time Control Settings

Voice Line Settings
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PathFinder Install Guidelines

BASIC INFORMATION

Job Name:  ______________________________________ Sales Rep: _________________________

End User Contact (Administrator): _________________ Phone: __________________________

End User Contact responsible for recording custom prompts: __________________________________

Installer: _______________________________________ User Trainer: _______________________

Installation Dates: Start: ______________________ Complete: _________________________

End User Training: _________________________________

Te lep h o n e S y s te m  I n fo r m at io n

Type of telephone system (brand & model): _________________________________________________

How many digits are there in the telephone system's station or extension numbers? ___________

Is the telephone system capable of supporting In-Band Integration? Yes �   No �

If YES, is the telephone system equipped to support In-Band Integration? Yes �   No �
(this includes both telephone system hardware and software)

What DTMF Digits does the telephone system use to turn on voice mail indicators: ___________

What DTMF Digits does the telephone system use to turn off voice mail indicators: ___________

Does the telephone system use a Hook Switch Transfer on Single Line Ports? Yes �   No �

Number of CO Lines or Trunks connected to the telephone system: ___________

Number of telephones (extensions) connected to the telephone system: ___________

List the single line port extension numbers that are to be used for Voice Mail Ports:

1 ______ 2 ______ 3 ______ 4 ______ 5 ______ 6 ______ 7 ______ 8 ______

Will the Single Line Ports be placed in a voice mail group (hunt group)? Yes �   No �

What is the telephone system's voice mail group number or numbers? ___________
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BASIC INFORMATION   (continued)

Voic e M ail  F un c ti ons

Number Of Voice Mailbox Users (Subscribers):  ___________

Number of Internal Subscribers (who have a phones in the telephone system):  ___________

Number of External Subscribers (who do not have a phones in the telephone system): ___________

Are internal subscribers going to forward their phones to their mailboxes? Yes �  No �

Will the telephone system provide Preset Call Forwarding to voice mail? Yes �  No �

Will Subscribers use Pager Notification? Yes �  No �

A u to m a te d  A tt e nd a n t Fu n ct io n s

When is Auto Attendant to be used? Daytime _____ Night _____ Both _____ Never _____

Will Auto Attendant be used as overflow answering point (to help live system operator)? Yes �  No �

Number of CO Lines to be directly answered by Auto Attendant:  ___________

FAX Detection  -  Will the system be set to automatically route Fax calls? Yes �  No �

Fax Transfer Prefix:__________________________________   ("&" = flash and a "," [comma] = pause)

Fax phone number or extension number: ______________________________

Operator  -  What do telephone system users normally dial to reach the system Operator? ___________

Voic e M ail  Eq u ip m en t  C o n s id era ti o n s

Where is the voice mail system to be located? ______________________________

Is this location environmentally stable (air conditioned & heated)? Yes �  No �

Will the systems be connected to a dedicated and grounded 120 volt, 60 Hz AC outlet? Yes �  No �

WARNING:  Questions on this page answered as NO represent less than ideal conditions, and may cause
immediate or delayed malfunctions, or may disrupt certain voice mail and telephone system capabilities.
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SUBSCRIBER INFORMATIO N

Complete one copy of this form for each Subscriber or group of Subscribers

Subscriber Name or Group Description: ____________________________________________________

Mailbox/Extension Number(s): Department: ________________________________________________

Class Of Service (COS)? _________________________________________________________________

Ma ilb ox  Se t ti ng s

Operator: __________ Cascade: __________ Mailbox Time Control (special use): __________

Mailbox Action Play Greeting: Yes �   No �

Action: Destination: ____________________________________________________________

Notification: ___________________________ Phone Number: __________________________

Pager Notification: Yes �   No � Time (if timed notification): ___________________________

E x te n s io n  S et t in g s

Extension Time Control (special use): ___________________________________________________

Action 1  -  when calls are first transferred to the extension

Action: ____________________________________  Destination: _____________________
(If Blind Transfer option will be used, skip Actions 2 and 3.)

Supervised Transfer Options (circle one) : Screen Caller  � Allow Holding  �

Action 2  - � Do Always � Only On Busy � Only On No Answer

Action: ____________________________________  Destination: _____________________

Supervised Transfer Options (circle one) : Screen Caller  � Allow Holding  �

Action 3  - � Do Always � Only On Busy � Only On No Answer

Action: ____________________________________  Destination: _____________________

Supervised Transfer Options (circle one) : Screen Caller  � Allow Holding  �
PathFinder - System Administration December, 2003 - Issue 4.5



D-6 PathFinder Install Guidelines

Chapter  - Installation Forms & Part Numbers
CLA SS OF SERV ICE (COS) INFO RMAT ION

Complete 1 copy of this form for each Class Of Service

COS Name (number): __________________________ Description: _____________________________

Ge n era l  Se tt in g s

Time Control (special use): ____________________ Restrict Outdial - Number of digits: _____________

User Type: ( 01 = normal, 99 = Administrators) Event Counter (circle one):   � Owners � Callers

Me s s ag e S et t i n g s

Message Type: � Voice � Page � E-Mail � Fax

Default Msg Type: � Voice � Page � Play Message Type Menu

Message Properties: Length: ______ (sec.)Count:______ (messages)Retention: _____ (days)

Record Key - Wait for key press before recording messages? Yes �   No �

Greeting Types: � Personal � System � Class Of Service � Voice Insert

� System Add On Greeting Length: _______ (sec.)

Callers: Stop Record Key: _________ Record Options On? Yes �   No �

Send Options: � No Options � Urgent � Confidential � Last Option On or Off:_________

Ma in t en a nc e S et t in gs

First Time Help (circle one)? Yes  �   No  � Say Date and Time type:________________________

Message Order: � First in - First Out � Last In - First Out

Owner Play Options: � Save Messages � Forward Messages � Dial Source

� Confirm Delete � Reply To Messages � Skip Messages

Owner Send Options:� Not Allowed does not allow the following: � Future Delivery � Urgent

� Confidential � Outside Number � Confirmation � System List
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CLA SS OF SERV ICE (COS) INFO RMAT ION  (continued)

COS Name (number): __________________________ Description: _____________________________

Owner Edit Options: � Password � Delete Message Sent � Auto Attendant

� Greeting � Mailbox State � Notepad

� Name/Signature � Personal Lists � Transfer Out

� Notification � Guest Mailboxes

N o t if ica ti o n  S et t in g s

When will the system set Message Waiting? _________________________

Message Wait Set Sequence: (special use) _________________________

Message Wait Clear Sequence: (special use)  _________________________

Event Handler Group: ___________________ (special use - default is set to 5)

Voice Notification Options: �  Password Required �  Message Pick-Up Allowed

Cascading: When will Cascade occur: ________________________ �  Urgent Only Option

Cascade Message Save & Delete Options: �  Save as New �  Delete Original �  Save Original

Notification Interval: ___________ (minutes) Notification Attempts: ____________ (number of tries)

Pager Retries? Yes �   No � Notification  Script: ____________________________________
(special use - default is Pager12.CF)

A u to  A t t en d an t  Se tt in g s

Call Options: � Blind Transfers � Supervised Transfer � Call Screening � Call Holding

� Extended Options � Desktop Call Control (enable)

Hold Type: __________________ Hold Interval: ______________________  (sec.)

Call Queueing? Yes �   No �

Screen Length:  _________ (sec.) Play Call Source?: Yes �   No �

Transfer Prefix: ______________________________

Transfer Postfix: ______________________________
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MENU INFO RMATION --  Day

Complete one copy of this form for each Menu

Description: ______________________________________________________________________

Number: __________ Password: __________ Time Control: _______________ (special use)

Instructions: __________________________________________________________________
(special use - This is the Menu's number .VOX file name for prompts.)

Time Out: _________ (sec.) Max Retries: ___________  (number of retries before hangup)

Keys Actions (including additional parameters: mailbox numbers, menu numbers, etc.)

* ___________________________________________________________________________

# ___________________________________________________________________________

0 ___________________________________________________________________________

1 ___________________________________________________________________________

2 ___________________________________________________________________________

3 ___________________________________________________________________________

4 ___________________________________________________________________________

5 ___________________________________________________________________________

6 ___________________________________________________________________________

7 ___________________________________________________________________________

8 ___________________________________________________________________________

9 ___________________________________________________________________________

Prompt script for this mailbox - to be recorded via Administrator

_____________________________________________________________________________________

_____________________________________________________________________________________

_____________________________________________________________________________________

_____________________________________________________________________________________

_____________________________________________________________________________________
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MENU INFO RMATION --  Nigh t

Complete one copy of this form for each Menu

Description: ______________________________________________________________________

Number: __________ Password: __________ Time Control: _______________ (special use)

Instructions: ______________________________________________________________________
(special use - This is the Menu's number .VOX file name for prompts.)

Time Out: _________ (sec.) Max Retries: ___________  (number of retries before hangup)

Keys Actions (including additional parameters (mailbox numbers, menu numbers, etc.)

* ___________________________________________________________________________

# ___________________________________________________________________________

0 ___________________________________________________________________________

1 ___________________________________________________________________________

2 ___________________________________________________________________________

3 ___________________________________________________________________________

4 ___________________________________________________________________________

5 ___________________________________________________________________________

6 ___________________________________________________________________________

7 ___________________________________________________________________________

8 ___________________________________________________________________________

9 ___________________________________________________________________________

Prompt script for this mailbox - to be recorded via Administrator

_____________________________________________________________________________________

_____________________________________________________________________________________

_____________________________________________________________________________________

_____________________________________________________________________________________

_____________________________________________________________________________________
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Tim e  C o n t rol  Se tt in g s

Complete one copy of this for each Time Control

Time Control Name (Number): ________________

Description: _________________________________________________________________________

System Searches for a match, sequentially starting at item 1 (use military format, i.e., 18:00 = 6pm)

Item Number:  ____________

Start Time: _____________ Mark active days for these hours:
MO TU WE TH FR SA SU

End Time: _____________ � � � � � � �

Action (the menu or mailbox calls are to go to): _____________

Time Period Number: _____________ (enter 1 to 9, for users to select time sensitive greetings)

Item Number:  ____________

Start Time: _____________ Mark active days for these hours:
MO TU WE TH FR SA SU

End Time: _____________ � � � � � � �

Action (the menu or mailbox calls are to go to): _____________

Time Period Number: _____________ (enter 1 to 9, for users to select time sensitive greetings)

Item Number:  ____________

Start Time: _____________ Mark active days for these hours:
MO TU WE TH FR SA SU

End Time: _____________ � � � � � � �

Action (the menu or mailbox calls are to go to): _____________

Time Period Number: _____________ (enter 1 to 9, for users to select time sensitive greetings)

Item Number:  ____________

Start Time: _____________ Mark active days for these hours:
MO TU WE TH FR SA SU

End Time: _____________ � � � � � � �

Action (the menu or mailbox calls are to go to): _____________

Time Period Number: _____________ (enter 1 to 9, for users to select time sensitive greetings)

* Up to 10 items can be assigned to a Time Control  -  use additional sheets for more items.
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Vo ic e L in e  S et t in g s

Action To Perform When Calls Ring In Additional Parameters

Line 1 _________________________________ ____________________

Line  2 _________________________________ ____________________

Line 3 _________________________________ ____________________

Line 4 _________________________________ ____________________

Line 5 _________________________________ ____________________

Line 6 _________________________________ ____________________

Line 7 _________________________________ ____________________

Line 8 _________________________________ ____________________
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List of Parts

Table 4-1: PathFinder Part Numbers

Part Number Hardware / Software

900-01 Turnkey Integration Windows 2000 PC

Voice / Fax Kits

912-04 4-Port Kit Voicemail with 1 D/4PCI Voice Card

912-08 8-Port Kit Voicemail with 1 D/4PCI Voice Card

913-04 4-Port Kit Voicemail with 1 D/41JCTLS Voice Card

913-08 8-Port Kit Voicemail/Fax with 1 D/120JCTLS Voice Card

913-12 12-Port Kit Voicemail/Fax with 1 D/120JCTLS Voice Card

913-24 24-Port Kit Voicemail/Fax with 2 D/120JCTLS Voice Cards

913-48 48-Port Kit Voicemail/Fax with 4 D/120JCTLS Voice Cards

914-04 4-Port Kit Voicemail with 1 VFX/41JCTLS Voice/Fax Card

914-08 8-Port Kit Voicemail with 2 VFX/41JCTLS Voice/Fax Cards

914-12 12-Port Kit Voicemail with 3 VFX/41JCTLS Voice/Fax Cards

914-24 24-Port Kit Voicemail with 6 VFX/41JCTLS Voice/Fax Cards

Voice / Fax Cards

940-04V 4-Port PCI Voice D/4PCI Voice Card

940-04 4-Port PCI Voice/Fax D/41JCTLS Voice/Fax Card

940-04F 4-Port PCI Voice/Fax VFX/41JCTLS Voice/Fax Card

940-12 12-Port PCI Voice/Fax D/120JCTLS Voice/Fax Card

Software & Upgrades

632-40 Chalk Talk Includes Call List Admin, Homework Hotline, & Q/A

632-05 Onelook Unified Messaging 5 seats - includes DCC & DME

632-25 Onelook Unified Messaging 25 seats - includes DCC & DME

632-20 Text-to-Speech True Voice - each port

632-100 Unified Messaging 100 seats - includes DCC & DME

632-199 Unified Messaging Site License Includes DCC & DME

632-30 VPIM (Networking) Per system

931-78 Upgrade from v7 to v9.5 Hardware upgrade required

931-89 Upgrade from v8 to v9.5 Hardware upgrade required

950-14 Pathfinder Documentation CD Includes manuals, user guides, and quick reference
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E FAQs

This appendix shows some of the Frequently Asked Questions that could be helpful 
when configuring the PathFinder system. 
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PathFinder Integration

How do I set up “One Touch Record” to work with PathFinder?

To operate this feature requires a change to a PathFinder menu key and to your system 
VM Outpulsing Table.

Programming a Vodavi XTS or STS System

Enter Admin Programming and go to FLASH 66 - Button 8. Change the “Suffix” to 6P (6 
+ Pause).

» One-Touch Record uses Table 7 from the Voice Mail Outpulsing Table.

(Table 7) 8P Pre=P7; Suf = 6P

» Voice Mail One Touch Recording (requires a flexible button) 649+[VVV].

» » » For more details on using “Voice Mail One-Touch Recording”, refer to the XTS or STS 
Programming and Operations manual.

Maximum Recording Length

The “Recording Time” allowed is too short, how do I change it?

The longest recording that PathFinder/Dialvox will make without modifying HELLONT.INI 
is 60 minutes (3600 seconds). This default parameter controls the recording length, 
regardless of the settings entered in MaintNT, a VoiceMail module, or any custom 
module. To extend the recording time, the maximum length setting in the HELLONT.INI 
system file must be changed to exceed 60 minutes. This is a practical protection 
scheme to prevent runaway recordings from filling the disk.

To allow for longer recordings, add the following parameter to the HELLONT.INI file.

1. Use Notepad to edit the .ini file.

2. Scroll down to the section called "[DIALVOX]".

3. After this line, add the following line (example: for 2 hours=7200 seconds):

RecordLongerAbsoluteMaxLength=7200

Recording Parameters -- The following parameters are allowed in HELLONT.INI to 
further control how the system extends the recording time.

 

Use of this feature when the One-Touch Recording Warning Tone is disabled may be
interpreted as a violation of federal, state or local laws, and an invasion of privacy.
Check applicable laws in your area before recording calls using this feature.

[DIALVOX] Parameter                  Default Max     Comments                                 

RecordLongerAbsoluteMaxLength 3600 715827 No recording will be longer than this.

RecordDialogicMaxSecs 3600 715827 No Dialogic recording will be longer than this.

RecordSciTelMaxSecs 3600 715827 No SciTel recording will be longer than this.

RecordLongerSubstituteLength 1800 715827 Substituted recordings will be this long.

RecordLongerTriggerLength 0 715827 Use SubstituteLength when recordings 
requested this long (Default=0=Disabled)
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Actions 3-51, 3-70
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Adobe® Acrobat Reader® C-13
ADPCM 5-3
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Ask for Mailbox 3-76, 3-82
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Menu Bar 5-4
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Busy 3-35
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File Functions (Boom Box) 5-7
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Holding 3-68
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Queue Interval 3-18
Queuing 3-68
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Caller
Record Options 3-60
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Send Options 3-60
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Cascade To 3-49
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Change Language 3-78
Channels C-8
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Button 3-5
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Settings 3-54, 4-16
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Codekey Manager 1-10
COM Ports 3-5
Combining Commands A-14
Command Descriptions A-3
Command Files 3-77, 3-82, 3-88, A-3
Company Directory 3-77, 3-83, 3-88
Confidential 3-60, 3-63
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Hardware C-7
Menu 3-5
Operating System C-11
Preparation 2-3

Confirm Deletes 3-62
Confirmation 3-63
Connect 3-34
Convert Menu (Boom Box) 5-5
COS

Postfix Prompt 3-57
Prefix Prompt 3-57
Template 3-54

Counters (Event) 1-7
Create Range 3-47
Creating

COSs 3-69
Menus 3-72
System Lists 3-89
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Template Time Controls 3-79
Time Controls 3-80
Users 3-46

Current Drivers C-8
Customizable (non-indexed) Prompts 5-9

D
Daily Log 4-23
Debugging 6-7
Defining Parameters 2-3
Delete

COS 3-70
Menu 3-73
Message 3-66
Range of Mailboxes 3-53
Registry Item 3-42
Single User 3-53
System List 3-91
Time Control 3-83
Unheard 3-64
User 3-53

Department 3-47
Description 3-55, 3-74, 3-89
Designing a Menu 3-71
Determining System Size C-5
Determining Tone Type 3-30
Device Status 5-7
Device Type 5-7
Dial Hold Sequence 3-68
Dial Source 3-62
Dialogic

Drivers C-13
Products C-8
Voice Ports 5-3

Dialogic-based Troubleshooting
 5-8

Dial-out C-10
Digit Lengths 3-5, 3-13
Digit Time 3-23
Direct Attachment to the Central Office C-10
Directories 3-5, 3-24
Directory 3-19, 3-21, 3-83
Directory Report 3-6, 4-22
Disabled Key 3-78
Distribution Lists 3-89
Do Always 3-52
Drive Size Formula C-5
DTMF

Keys 3-6
Pound 3-6

Star 3-6
Tones C-8

Dual Tones 3-33

E
Edge 3-32
Edit Options 5-6
Editing

Menus 3-73
System Lists 3-91
Time Controls 3-80
User Setups 3-47

Error Log 4-25
Error Messages 6-4
Essex Line C-10
Event Counters 3-56
Event Handler Group 3-65
Exit Button 3-4
expansion slot cover C-9
Extended Options 3-68
Extension Settings

Detail Report 4-15
Summary Report 4-14

Extension Usage Report 4-8
Extensions 3-46, 3-77, 3-82, 3-88

Length 3-13
Settings 3-51
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Fax 3-59

Documents Report 4-10
On Demand 3-77, 3-83, 3-88
Support 3-21

FF and REW Speed 3-16
File

Information 5-7
Type 5-7

File Format 5-7
File Menu

Boom Box 5-4
MAINT 3-4

First Time Help 3-61
First Time Questions 2-3
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Length 3-35
Transfer C-10

Forward
to another Mailbox 3-49
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to Menu 3-49, 3-52
to Module 3-49, 3-52
to Time Control 3-49, 3-52

Forward Msgs 3-62
Frequency settings 3-32, 3-33
Future Send 3-63

G
General Operator 3-14
General Settings 3-55
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Generation speed 4-5
Greeting 3-63

Length 3-57
Settings 3-56
Type 3-56

Guest Mailboxes 3-63

H
Hang Up 3-78
Hang Up Detection 3-5, 3-29
Hard Disk Storage Size C-5
Hardware Compatibility List (HCL) C-4
HCL C-4
Help Menu

Boom Box 5-5
MAINT 3-6

hold C-10
Hold Interval 3-68
Hold Type 3-68
Holding 3-68
Holding Allowed 3-52
Holidays 3-26
Homework Hotline Menu 3-77, 3-83
How Can I Be Certain I Configured My Dialogic 
Boards Correctly? 6-11

I
Immediate 3-65
Immediate notification 3-50
index file 5-3
Indexed Prompts 5-9
Indexed vs. Non-Indexed Prompts 5-9
infinite Systems

DVX I 2-5
INI File B-12
INI File Settings 3-44

INI Parameter 3-44
Install

Adapter C-12
Hardware C-7
Operating System C-11

Installation 5-3
Instructions prompts 3-74
Integration 3-21
Inter-Digit Time 3-23
Introduction prompts 3-74
Invalid Option 3-78

K
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L
Language 3-5, 3-20, 3-56, 3-78
Last Options 3-61
Last Options Menu 3-61
Leave as New 3-66
Level One Backup 6-3
Level Three Backup 6-3
Level Two Backup 6-3
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Levels 6 and 7 Access 3-8
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Limited Supervisor Access 3-8
Line Settings

Button 3-5
Line View (Status) 1-8
List Mode 3-19
Log Files 3-21, 6-4
Logging 3-5, 3-20
Logs Reports 4-23
Loop current disconnect C-10
Loop Current Drop 3-31
Loop Current Supervision 3-29
LPT / COM Ports 3-26
LPT/COM Ports 3-5

M
Mailbox 3-46, 3-76, 3-82, 3-88

Action 3-49
Caller Settings 3-60
is Full 3-50
is Off 3-50
Length 3-13
Owner Settings 3-61
Settings 3-48
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Single 3-46
State 3-63
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Mailbox Settings Detail Report 4-13
Mailbox Settings Summary Report 4-12
Mailbox Usage Report 4-7
MAINT 1-10

Logins 3-4
Maintenance Log 4-24
Making Changes 3-25
Manual Backup 6-3
Max Retries 3-78
Maximum Keys 3-19
Maximum Recording Length E-3
Maximum Wait 3-19
Menu Activity Report 4-9
Menu Logs 6-8
Menu Settings Report 4-17
Menus 3-21, 3-70, 3-77, 3-82, 3-88

Creating 3-72
Deleting 3-73
Design 3-71
Multi-Level 3-71
Settings 3-5, 3-70
Time Periods 3-26

Message Cascading 3-49
Message Detail Report 4-27
Message Manager 3-21, 3-25
Message Summary 4-26
Message Type 3-58

Menu 3-59
Settings 3-58

Message Waiting 3-28, 3-64
Indicator Strings 3-65

Messages
Cascading 3-65
Clean Up 3-16
Count 3-59
Date Time 3-62
Length 3-59
Retention 3-59

Messages Reports 3-6, 4-26
microphone 5-3
microphone gain 5-8
Minimum Password Length 3-13
Minimum Record Length 3-15
Minimum ring OFF 3-36
Minimum ring ON 3-36
minlcoff parameter 3-31
Modifying a COS 3-70
Modifying Command Files A-16

modular jacks C-9
Module Settings 3-12
Msg Pickup Allowed 3-65
multi-level menu 3-71
Multiple Lines 6-8
Multiple Mailboxes 3-47
MWI Refresh 3-16
MWI/Notification 3-5, 3-28
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Name 3-63
network adapter card (NIC) C-12
Network Backup 6-3
NIC C-12
No Answer 3-35
No Answer Log 6-9
No notification 3-50
Non-Indexed Prompts 5-9
Non-silence interval 3-31
Not Allowed 3-63
Note pad 3-63
Notification 3-5, 3-17, 3-21, 3-50, 3-63
Notification Activity 4-11
Notification Prefix 3-29
Notification Settings 3-64
Notify Interval 3-66
Notify Retries 3-66
Notify Script 3-66
Number Length to Edit 3-28, 3-34
Number of Ports C-5
Number of rings before No Answer detected 3-
36
Number of rings before system answers 3-36

O
Oldest Message First 3-62
On- Every Message 3-65
On- First Message 3-65
On Urgent Only 3-66
One Touch Record E-3
Only on busy 3-52
Only on no answer 3-52
Operators 3-5, 3-14, 3-48, 3-78
Original Message 3-66
Outside Numbers 3-63
Owner Call Back 3-43
Owners 3-56

Access 3-77, 3-82, 3-88
Edit Options 3-63
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Play Options 3-62
Retries 3-23
Send Options 3-62

P
Page 3-59
Paged Mode 3-19
Pager Files, samples A-16
Pager Mailbox Delay 3-16
Pager notification 3-50
Park and Page 3-58
Passwords 3-7, 3-47, 3-63, 3-74

Attempts 3-17
Length 3-13
Required 3-65

PathFinder View Port 1-6
PathFinder Won’t Start 6-11
Pause 3-6
PBX C-9

Attachment C-10
Integrations 3-5, 3-37

PBXpert C-13
Wizard B-4

PC Preparation C-9
PC System Placement C-6
PCI slot C-9
Perfect Call 3-5, 3-37
Perform a System Analysis C-5
Personal greeting 3-56
Personal Lists 3-63
Personal Mailbox Operator 3-15
phone cable C-9
Phone Line Assignments C-8
Phone number 3-50
Physical Board Installation C-9
Play Call Source 3-69
Play entire date 3-62
Play Hold Files 3-68
Play Instructions 3-78
Play Prompt 3-78
Postfix 3-34
postfix prompt 3-57
pound 3-6
Pre-Defined Command Files A-15
Prefix 3-34
prefix prompt 3-57
Prerequisites 3-3
Prerequisites & Preparation C-13
privileges 3-8
Problems

with PathFinder 6-11
with the PC Hardware and/or Operating 

System 6-10
with the Telephone System 6-10

Proprietary Connections C-10

Q
Q&A Admin 1-11
Q-A Menu 3-77, 3-83
Questions & Answers 6-12
Quick Command Descriptions A-13
Quick Commands A-13
Quick Jump Key 3-16

R
Recall Caller On 3-35
Re-connect C-10
Record Key 3-59
Record Prompts 3-78
Record Stop Key 3-60
Record Tone Length 3-16
Record/Playback 3-5, 3-15
Registry 3-5, 3-42

Item Fields 3-44
Maintenance 3-42

Registry Item, Add or Edit 3-42
Registry Settings Detail Report 4-20
Registry Settings Summary Report 4-19
Regulatory Information 3
Reject 3-35
Re-Order Tone 3-30, 3-31
Repeat Count 3-32
Replacement Prompts 5-9
Reply To Msgs 3-62
Reports

Data 4-6, 4-7, 4-8, 4-9, 4-10, 4-11, 4-12, 
4-13, 4-14, 4-15, 4-16, 4-17, 4-18, 
4-19, 4-20, 4-21, 4-22, 4-23, 4-24, 
4-25, 4-26, 4-27

Use 4-6, 4-7, 4-8, 4-9, 4-10, 4-11, 4-12, 4-
13, 4-14, 4-15, 4-16, 4-17, 4-18, 4-
19, 4-20, 4-21, 4-22, 4-23, 4-24, 4-
25, 4-26, 4-27

Reports Criteria 4-4
Reports Menu 3-6
Requirements 5-3
Restrict OutDial to 3-56
Retries 3-74
Retries/TimeOuts 3-5, 3-23
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Retry Pager 3-66
REW Speed 3-16
Ring count reset delay 3-36
Ring Detection 3-36
Ring edge to detect 3-36
Rings 3-5, 3-36
RJ-11 jack C-9
RJ-14 jack C-9
RS-232 C-6
Run ActiveVex 3-78, 3-83
Run Module 3-77, 3-82, 3-88

S
Save Message 3-66
Save Msgs 3-62
Screen Caller 3-52
Screen Length 3-69
Screening 3-68
sensitivity 5-8
Sentinel Drivers C-13
Server Requirements C-4
Set Hang-up 3-33
Set Up Phone System 2-5
Set Wait 3-33
Setting MAINT User Passwords 3-7
Setting Up Phone Lines 3-85
Setting Up Time Control Parameters 3-79
Settings Reports 3-6, 4-12
Silence 3-68
Silence Interval 3-31
Single Mailbox 3-46
Single tones 3-33
Skip Message 3-62
Software Security Key C-7
speakers 5-3
Special Characters & Strings 3-6
Specific Extension Number 3-77
Specific Mailbox Number 3-76
Star 3-6
Starplus Systems

Triad S 2-5
Start Key 3-76, 3-77
Start Up Mode B-3
Storage Size Factors C-5
Supervised Transfer 3-52, 3-68
System

Add-on 3-57
Partitioning 3-84

System (Distribution) Lists 3-5, 3-63
System Activity Log 6-5

System Components
PathFinder Software 1-5
Personal Computer (PC) 1-5

System Directory 3-19
System Distribution Lists Report 4-21
System Error Log 6-4
System greeting 3-57
System Maintenance Log 6-5
System Prompts 5-8
System Size C-5

T
Take a message 3-49
Tape Backup 6-3
Technique 6-10
Telephone Connection C-9
telephone system 2-5
Telephony Hardware

Compatibility C-6
Configuration C-8
Installation C-9

Telephony Settings 3-27
Template Class of Service 3-54
Templates 3-54
Temporary Introduction Active 3-75
Time Control 3-21, 3-48, 3-51, 3-55, 3-74, 3-
77, 3-82, 3-88

Button 3-5
Settings 3-79

Time Control Settings Report 4-18
Time Out 3-74
Time Periods 3-5, 3-26
Timed notification 3-50
Time-Out 3-78
Tone Events 3-33
Tone ID 3-32
Tone Interval 3-31
Tone or Silence Disconnect 3-29
Tone Template, Add or Edit 3-32
Tone Type 3-30
Track Messages

 3-21
Transfer Out 3-64
Transfer Settings 3-5, 3-34
Transfer Strings 3-69
Troubleshooting 5-8, 6-10
Truncate Recording 3-15
Trunk Access 4-7
Tutorial 3-48
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Un-interruptible Power Supply (UPS) C-6
Universal Dialogic Diagnostic Utility (UDDU) 6-
11
Unlimited Supervisor Access 3-8
UPS C-6
Urgent 3-60, 3-63
Urgent notification 3-50
Use Perfect Call 3-34
User (Subscriber) Settings 3-5
User Type 3-55
Users Settings 3-45

V
VDX 5-3
Voice 3-58
voice channel jack C-9
voice I/O channels C-8
Voice Insert 3-57
Voice Lines 3-5, 3-27
Voice Mail 3-5, 3-16, 3-21

Operator 3-14
Owner 3-21
Time Periods 3-26

Voice Menu Button 3-5
Voice Network Attachment C-10
Voice Notify Options 3-65
Voice Port Menu (Boom Box) 5-4
voice ports 5-3
voice prompt file 5-3
voice prompts 1-3

W
WAV device 5-3
WAV-based Troubleshooting

 5-8
What To Debug 3-22
What To Log 3-20
When Notify Fails 3-66
Windows Hardware Compatibility List (HCL) C-
4
Work Hours 3-26
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